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Introduction

Important

To the maximum extent permitted by applicable laws, in no event will the manufacturer be liable for any
damages whatsoever arising out of failures of this product, losses of documents or data, or the use or
non-use of this product and operation manuals provided with it.

Make sure that you always copy or have backups of important documents or data. Documents or data
might be erased due to your operational errors or malfunctions of the software. Also, you are
responsible for taking protective measures against computer viruses, worms, and other harmful software.

In no event will the manufacturer be responsible for any documents created by you using this product or
any results from the data executed by you.

Cautions regarding this guide

• Some illustrations or explanations in this guide could differ from your product due to improvement or
change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified, or
quoted without prior consent of the supplier.

• Throughout this publication, references to directory paths indicate the default paths only. If you
install InfoPrint Manager or any of its components in a different location, including a different drive,
you must adjust the paths accordingly.
For example, if you install InfoPrint Manager on the D: drive of a computer running a Windows
operating system, replace C: with D: in the directory paths.

Guides for this application

This publication provides information about RICOH InfoPrint Manager™ for AIX, Linux, and Windows,
Version 4.12 (Program Number 5648-F40).

This publication includes an overview of InfoPrint Manager and installation and configuration
information about the product.

Instruction manuals

These instruction manuals are included:

For information about InfoPrint Manager, see these documents:

• RICOH InfoPrint Manager for Windows: Planning Guide , G550-1071

• RICOH InfoPrint Manager for Windows: Getting Started , G550-1072

• RICOH InfoPrint Manager for Windows: Procedures , G550-1073

• RICOH InfoPrint Manager for Linux: Planning Guide, G550-20262

• RICOH InfoPrint Manager for Linux: Getting Started, G550-20263

• RICOH InfoPrint Manager for Linux: Procedures , G550-20264

• RICOH InfoPrint Manager for AIX and Linux: Configuring and Tuning Guide, S550-1062



• RICOH InfoPrint Manager for AIX: Planning Guide, G550-1060

• RICOH InfoPrint Manager for AIX: Getting Started, G550-1061

• RICOH InfoPrint Manager for AIX: Procedures, G550-1066

• RICOH InfoPrint Manager: High Availability Guidelines, G550-20261

• RICOH InfoPrint Manager: Reference, S550-1052

• RICOH InfoPrint Manager: PSF, Server, and Transform Messages, G550-1053

• RICOH InfoPrint Manager: Secure Print: Installing and Configuring, G550-20129

• RICOH InfoPrint Manager: SAP R/3 Planning and Configuring Guide, S550-1051

• RICOH InfoPrint Manager: Dictionary of Keywords, S550-1188

• AFP Conversion and Indexing Facility: User’s Guide, G550-1342

• Page Printer Formatting Aid for Windows: User’s Guide and Reference, S550-0801

• RICOH InfoPrint Manager AFP2PDF Transform Feature: Installing and Using , G550-1057

• RICOH InfoPrint Manager: Installing InfoPrint Manager Transform Feature, G550-20160

Help

Property help is available on many screens to provide information for specific tasks and settings.

In addition, the Help menu provides access to the HTML version of the instruction manual directly from
the user interface.

• A PDF reader, such as Adobe Reader, must be installed to view the PDF documentation.

For more information about RICOH printing products, see:

RICOH Commercial and Industrial Printing website at https://www.ricoh-usa.com/en/products/
commercial-industrial-printing.

RICOH Software Information Center at https://help.ricohsoftware.com/swinfocenter.

How to read the documentation

Displaying the instruction manual

Use this procedure to view the instruction manuals.

Displaying the instruction manual in PDF format

• InfoPrint Manager includes publications in PDF format on the DVD-ROM supplied with the product.

Displaying the instruction manual in HTML format

• The HTML version of the instruction manual is available directly from the user interface. Start the

application, and then click button at the right of the banner and select Help.
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Displaying property help

Click the button next to a property on the user interface to display the property help for that item.

Symbols

The following symbols are used in this manual to help you to identify content quickly.

• This symbol indicates points to pay attention to when using the product. Be sure to read these
explanations.

• This symbol indicates helpful supplementary information that is not essential to completing a task.

Bold
Bold type indicates the names of dialogs, menus, menu items, settings, field labels, buttons, and
keys.

IIttaalliicc
Italic type indicates the titles of manuals and variables that you must replace with your own
information.

MMoonnoossppaaccee

Monospace type indicates computer input and output.

Abbreviations

AFP
Advanced Function Presentation

IP
Internet Protocol

PDF
Portable Document Format

PCL
Printer Command Language

GIF
Graphical Interchange Format

JPEG
Joint Photographic Experts Group

TIFF
Tagged Image File Format
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Trademarks

RICOH InfoPrint Manager™ and RICOH ProcessDirector™ are trademarks of Ricoh Company, Ltd. in
the United States, other countries, or both.

These terms are trademarks or registered trademarks of International Business Machines Corporation in
the United States, other countries, or both:

• AIX

• DFS

• IBM

• MVS

• OS/390

• POWER

• Print Services Facility

• pSeries

• S/390

• z/OS

Adobe, the Adobe logo, PostScript, and the PostScript logo are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other countries.

CUPS and macOS are trademarks or registered trademarks of Apple, Inc. in the United States, other
countries, or both.

Linux is the registered trademark of Linus Torvalds in the U.S. and other countries.

Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United
States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Thales Group code: The license management portion of this Licensee Application is based upon one or
more of the following copyrights:

Sentinel RMS
Copyright 1989-2023 Thales Group
All rights reserved.

Sentinel EMS
Copyright 2008-2023 Thales Group
All rights reserved.

Sentinel is a registered trademark of Thales Group.

Other company, product, or service names may be trademarks or service marks of others.
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11.. Overview of the SAP R/3 print feature

•InfoPrint Manager and SAP R/3
•Reliable notification of job status to SAP users
•Adding electronic forms, logos, and electronic signatures to text documents
•Reliable management of the print environment
•Scalability of printing across an enterprise
•SAP clients and features
•SAP R/3 GUI keyboard shortcuts

This section describes the benefits derived by business enterprises that use SAP R/3 and InfoPrint
Manager for AIX, InfoPrint Manager for Linux, or InfoPrint Manager for Windows to manage their print
environments.

Ricoh is a valuable SAP software solution partner, and InfoPrint Manager is an SAP-certified integration
solution with the SAP NetWeaver technology platforms.

Figure 1 shows the SAP R/3 partner logo, and Figure 2 shows the SAP Certified Powered by SAP
NetWeaver technology logo.

SAP R/3 partner logo.

SAP Certified Powered by SAP NetWeaver technology logo.

IInnffooPPrriinntt MMaannaaggeerr aanndd SSAAPP RR//33
A large international corporation is committed to an SAP R/3 enterprise to manage their data
processing across all departments. They especially appreciate the SAP R/3 option provided by InfoPrint
Manager. InfoPrint Manager and SAP R/3 combine to provide a robust solution that manages all
printing the way SAP R/3 manages and keeps track of their entire business, from external documents
sent to customers, to reports created for internal distribution and printed at the desktop. Because
InfoPrint Manager can manage both the high-end production printers and the low-end desktop
(network) printers, it meets their needs like no other print application on the market today.
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An InfoPrint Manager SAP R/3 configuration

SAP R/3 has become a popular choice for medium to large-sized companies that require an integrated
software product to provide basic business automation. The R/3 client/server application provides
business a series of integrated modules that span the major functions of finance, manufacturing, sales
distribution, and human resources. InfoPrint's four decades of experience in printing and data
management translates into billions of pages printed annually in more that 130 countries, solidifying our
leadership position in the enterprise printing environment. Integrate InfoPrint's printing expertise with
SAP's leading business application software for a winning combination.

RReelliiaabbllee nnoottiiffiiccaattiioonn ooff jjoobb ssttaattuuss ttoo SSAAPP uusseerrss
SAP R/3 (Release 4 and later) provides support to closely integrate an external Output Management
System (OMS) with an SAP system. InfoPrint Manager for AIX, InfoPrint Manager for Linux, and
InfoPrint Manager for Windows provide SAP OMS support.

Using InfoPrint Manager SAP OMS support, your SAP users can receive notifications on the jobs that
they have submitted for printing. It also provides support to allow an SAP user to:

• Cancel one or more jobs
• Query the status of one or more jobs
• Query the status of an InfoPrint printer and its jobs

AAddddiinngg eelleeccttrroonniicc ffoorrmmss,, llooggooss,, aanndd eelleeccttrroonniicc ssiiggnnaattuurreess ttoo tteexxtt
ddooccuummeennttss
The Advanced Function Presentation (AFP) data stream that emerges from the InfoPrint SAP transform
contains text records that you can enhance through the addition of electronic forms, logos, and
electronic signatures. In addition to the AFP resources, the InfoPrint Manager SAP transform has been
enhanced to support both raw image data (bitmap images) and box shading. The expanded support
for different levels of box shading and the print images that SAP R/3 users have come to expect and
appreciate provides a strong, industry standard for printing from SAP R/3. Print SAP color images in

1 Overview of the SAP R/3 print feature
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black and white, using the native Output Text Format (OTF) data stream in either one-, four-, or eight-bit
pixel images: InfoPrint Manager can handle it all. And InfoPrint Manager's globalization enablement
supports the these scripts:

• Latin
• Japanese (Shift-JIS encoding)
• Korean
• Simplified Chinese
• Traditional Chinese
• Cyrillic

Even if you are printing on PCL and PPDS non-impact printers, the SAP Print Feature provides benefit by
allowing you to print bar codes without installing expensive bar code SIMMs on each printer. InfoPrint
Manager allows a world-class set of business application modules designed for a client-server
environment the ability to achieve world-class printing.

RReelliiaabbllee mmaannaaggeemmeenntt ooff tthhee pprriinntt eennvviirroonnmmeenntt
With InfoPrint Manager, you can manage printers and devices from a single point of control. You can
track and manage jobs across your enterprise from job submission to printed output. When output does
not print, operators no longer have to determine whether a spool request was generated. Instead of
having to walk over to the printer, they can use the InfoPrint Manager graphical user interface (GUI) to
pinpoint where in the process the job is delayed and determine the appropriate action to resolve the
problem. InfoPrint Manager provides automatic workload balancing among printers that you have
defined with the same characteristics. For more information about how to configure printers and monitor
printing across an installation, see RICOH InfoPrint Manager for AIX: Procedures, RICOH InfoPrint Manager for
Linux: Procedures, or RICOH InfoPrint Manager for Windows: Procedures.

The InfoPrint Manager SAP OMS support also lets you easily:

• Switch the InfoPrint Manager system to which you are sending jobs
• Send jobs to multiple InfoPrint Manager systems
• Failover to other InfoPrint Manager servers in the same InfoPrint Manager system

SSccaallaabbiilliittyy ooff pprriinnttiinngg aaccrroossss aann eenntteerrpprriissee
InfoPrint Manager allows SAP R/3 customers to access the full range of InfoPrint printers (low-speed to
high-speed, simplex or duplex, continuous forms, or cut sheet) as well as other printers, such as Hewlett-
Packard and Lexmark. You can leverage your investment in printers by sharing your InfoPrint-managed
printers with other host, and LAN-based applications. InfoPrint Manager provides the SAP R/3
enterprise with comprehensive print management across an enterprise of any size, providing print
integrity through built-in error recovery. InfoPrint Manager supports SAP router function for a better
control, security and performance of your SAP system environment.

SSAAPP cclliieennttss aanndd ffeeaattuurreess
InfoPrint Manager provides client support for SAP systems running on AIX, HP-UX, Linux, Sun Solaris,
and Windows. By installing an InfoPrint Manager SAP client, you can always print PCL and PostScript
jobs, but to gather the additional support cited in Table SAP Print Feature functions and operating
systems, p. 12, you must install the SAP Print Feature on your InfoPrint server. The InfoPrint Manager for
AIX, InfoPrint Manager for Linux, and the InfoPrint Manager for Windows SAP Print Features contain

Reliable management of the print environment
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both the SAP Output Management support and the SAP transform that allows SAPGOF device type
output to be transformed to AFP for printing on PCL and IPDS printers.

SSAAPP PPrriinntt FFeeaattuurree ffuunnccttiioonnss aanndd ooppeerraattiinngg ssyysstteemmss

InfoPrint Manager server
systems

OMS support SAPGOF device type (OTF and
ABAP) Support

AIX yes yes

Linux yes yes

Windows yes yes

SSAAPP RR//33 GGUUII kkeeyybbooaarrdd sshhoorrttccuuttss
Table SAP R/3 keyboard shortcuts, p. 12 provides a list of keyboard shortcuts that can be used while
doing some of the procedures described in this book. Because this is an InfoPrint Manager publication,
these shortcuts are not a complete list of all options available on the SAP R/3 GUI for all releases. The
SAP R/3 GUI Window or Windows column lists particular windows in the SAP R/3 GUI where these
shortcuts work, but does not imply that the shortcut is exclusive for a particular panel or task. In addition,
the SAP R/3 GUI might change keyboard shortcuts from release to release. We recommend that you
consult the SAP R/3 online documentation that comes with the product to verify keyboard shortcuts for
your particular SAP R/3 release.

SSAAPP RR//33 kkeeyybbooaarrdd sshhoorrttccuuttss

Shortcut key or combination Task SAP R/3 GUI window or
windows where applicable

F2 Choose (checkmark with a
clock) icon

Spool Administration windows

F5 Events icon Status Description window

F6 Extended Admin.: Spool Administration windows

F8 Change (red pencil) icon Spool Administration windows

F8 Query icon Status Description pop-up
window (derived from Spool
Output Requests for Spool
Request XXXXXX)

F8 Test RFC connection RFC Destination dest_name
window

F11 Save RFC Destination dest_name
window

Ctrl + S Save (open folder) icon SAP R/3 GUI

Ctrl + F1 Extended config. (photo film
with two cards superimposed on
top) icon

Spool Administration windows

1 Overview of the SAP R/3 print feature
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Shortcut key or combination Task SAP R/3 GUI window or
windows where applicable

shift + F2 Trash can icon Spool Output Requests for
Spool Request XXXXXX

shift + F5 Transport (truck) icon Spool Admin.: Real Output
Management System

shift + F6 Transport all (truck) icon Spool Admin.: Real Output
Management System

shift + F6 Spool Requests icon Spool Administration: List of
Output Devices window

SAP R/3 GUI keyboard shortcuts
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22.. Installing and configuring InfoPrint Manager's OMS

•InfoPrint Manager's OMS support
•Installing the SAP Print Feature on the InfoPrint Manager server
•Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris
•Installing the InfoPrint Manager OMS support when SAP runs on AIX
•Installing the InfoPrint Manager OMS support when SAP runs on Linux
•Installing the InfoPrint Manager OMS support when SAP runs on Windows
•Configuring and using the OMS

IInnffooPPrriinntt MMaannaaggeerr''ss OOMMSS ssuuppppoorrtt
SAP R/3 Release 4 and later provides support to closely integrate an external output management
system (OMS) with an SAP system. InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint
Manager for Windows are SAP OMSs that provide synchronous functions for submitting jobs, canceling
jobs, querying jobs, and querying devices, as well as asynchronous event information. InfoPrint
Manager SAP Callback daemon (on AIX and Linux) or process (on Windows) collects and delivers
these events to the R/3 system.

1. This support is not currently available on an SAP R/3 Release 3 system. If you are either using an
SAP R/3 Release 3 system or do not want to use the OMS support, see InfoPrint Manager non-
OMS support, p. 59.

2. Support for SAP R/3 Release 3.1h is still available. For more information, contact your service
representative.

An overview of SAP R/3 and OMS

The InfoPrint Manager SAP OMS support consists of a command-line interface and either an SAP
callback daemon (on AIX and Linux) or an SAP callback process (on Windows) that logs onto an SAP
system and delivers InfoPrint Manager notifications back to SAP R/3 by making RFCs (remote function
calls). As print, cancel job, query job, and device query requests are made by SAP users, the SAP
Spool Work Process (SWP) invokes the InfoPrint Manager commands. As the job progresses through
the InfoPrint Manager system, notifications are sent back to SAP through the InfoPrint Manager SAP
Callback daemon (sapcbd) or the SAP Callback process (sapcbd.exe). Only one SAP Callback
daemon or process needs to be started for each SAP system, regardless of how many application
servers make up that system. The SAP Callback daemon or process runs on the same server where
InfoPrint Manager is running.

In InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows, the
InfoPrint Manager SAP Print Feature contains:

• Command-line interface

• SAP Callback daemon (sapcbd) on AIX and Linux, and the SAP Callback process (sapcbd.exe) on
Windows

• SAP (sap2afp) transform

The InfoPrint Manager SAP Clients contain the command-line interface.

To allow either the sapcbd daemon or the sapcbd.exe process to deliver InfoPrint Manager notifications
to an SAP system, you must install the SAP Print Feature on at least one system where the InfoPrint
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Manager servers are running. To allow SAPGOF device type output (both OTF and ABAP data streams)
to be transformed and processed by InfoPrint Manager, you must install the SAP Print Feature on every
system where InfoPrint Manager actual destinations are going to transform SAP data.

To install the SAP Print Feature on an InfoPrint server, see Installing the SAP Print Feature on the InfoPrint
Manager server, p. 16.

To allow SAP to issue the InfoPrint Manager commands, you must install a InfoPrint Manager SAP Client
on every SAP server where an SAP application server will issue the commands. This includes every
application server with an SWP managing R/3 devices that have been configured to use the InfoPrint
Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must repeat
these installation tasks on the alternate servers as well.

To install and configure InfoPrint Manager as an SAP R/3 OMS when SAP:

• Runs on other HP-UX or Sun Solaris servers, follow the procedures described in Installing the
InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris, p. 20

• Runs on an AIX operating system, follow the procedures described in Installing the InfoPrint
Manager OMS support when SAP runs on AIX, p. 25

• Runs on a Linux operating system, follow the procedures described in Installing the InfoPrint
Manager OMS support when SAP runs on Linux, p. 26

• Runs on a Windows operating system, follow the procedures described in Installing the InfoPrint
Manager OMS support when SAP runs on Windows , p. 28

1. The SAP Print Feature is available on InfoPrint Manager for AIX, InfoPrint Manager for Linux, and
InfoPrint Manager for Windows as a separately-priced feature that can be installed from the
InfoPrint Manager: SAP Print Feature DVD-ROM, LCD4-5646.

2. The AIX, Linux, and Windows SAP clients are available to install from the InfoPrint Manager: Common
Clients DVD-ROM, LCD4-5642.
The SAP clients for HP-UX and Sun Solaris systems are available on the SAP Print Feature and are
specific to either InfoPrint Manager for AIX servers, InfoPrint Manager for Linux servers, or InfoPrint
Manager for Windows servers.

3. If you are using an InfoPrint Windows server, use FTP to send the files to the HP-UX or Sun Solaris
system before editing the files as described in Configuring the SAP system server, p. 23. If you edit
the files on a Windows system, the format will not be correct for the HP-UX or Sun Solaris systems.

4. These procedures presume that you have already installed and configured InfoPrint Manager on a
separate AIX, Linux, or Windows server.

5. An SAP OMS interface restriction requires that your InfoPrint server (pdserver) name be no longer
than nine characters.

IInnssttaalllliinngg tthhee SSAAPP PPrriinntt FFeeaattuurree oonn tthhee IInnffooPPrriinntt MMaannaaggeerr sseerrvveerr
To run an InfoPrint Manager for AIX SAP callback daemon, InfoPrint Manager for Linux SAP callback
daemon, or an InfoPrint Manager for Windows SAP callback process, you must install the SAP Print
Feature on at least one of your InfoPrint servers, if you have not already done so.

If you are printing either Output Text Format (OTF) or Advanced Business Application Programming
(ABAP) data, make sure that you have installed the sap2afp transform and the fonts necessary for
printing. To install the transform, you must install the SAP Print Feature on each InfoPrint Manager AIX

2 Installing and configuring InfoPrint Manager's OMS
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server, InfoPrint Manager for Linux server, or InfoPrint Manager Windows server with actual
destinations that will be transforming data.

• If your SAP Server runs in IPv6 mode, in order for the SAP Callback Daemon to work, you must set
the environment variable SAP_IPv6_ACTIVE with the value 1, both on the SAP Server machine and
also on the InfoPrint Manager server machine. In this case, the InfoPrint Manager server must also
run on a machine that is IPv6 enabled.

• At a minimum, on every AIX or Linux system on which you will be running the SAP (sap2afp)
transform (on your InfoPrint Manager servers), you must have the ICU (InfoPrint Manager UCONV)
fileset or package installed.

To install the InfoPrint Manager for AIX SAP Print Feature on your AIX server, see RICOH InfoPrint
Manager for AIX: Getting Started.

To install the InfoPrint Manager for Linux SAP Print Feature on your Linux server, see RICOH InfoPrint
Manager for Linux: Getting Started.

To install the SAP Print Feature on your InfoPrint Manager Windows server, follow the directions under
the Installing InfoPrint Manager server software topic in RICOH InfoPrint Manager for Windows: Getting
Started.

To install the necessary fonts and configure the SAP transform on the InfoPrint Manager AIX server,
InfoPrint Manager for Linux server, and the InfoPrint Manager Windows server, see the rest of this
chapter.

Installing InfoPrint fonts for printing with the SAP transform

The InfoPrint Font Collection consists of character sets and Advanced Function Presentation (AFP) code
pages that let you print standard documents using familiar typefaces such as Helvetica, Times New
Roman, and Courier. The code pages allow you to print in more than 50 languages. To support certain
applications or low-resolution AFP/Intelligent Print Data Stream (IPDS) printers that use raster fonts, the
InfoPrint Font Collection also includes AFP raster fonts. AFP outline fonts, which are delivered as part of the
InfoPrint Font Collection, can be substituted for raster fonts in certain situations to enable higher resolution
output. In addition, the InfoPrint Font Collection provides WorldType fonts, which are TrueType/
OpenType fonts that deliver the greatest flexibility for designing documents with exactly the appearance
you want.

You can obtain these resources by ordering the AFP Asian Classic TrueType Collection and OpenType
and the InfoPrint Font Collection, Version 3.6.0, from your sales representative. For your convenience, the
InfoPrint Font Collection and AFP Asian Classic TrueType Collection and OpenType are shipped with
InfoPrint Manager for AIX, InfoPrint Manager for Linux, and InfoPrint Manager for Windows:

• InfoPrint Font Collection: AFP Outline Fonts, LCD4-5683 (DVD). This DVD includes AFP Outline fonts,
CID fonts, and Type1 fonts.

• InfoPrint Font Collection: AFP Classic Fonts, LCD2-20029 (DVD). This DVD includes AFP Classic with
Courier, Helvetica and Times New Roman typefaces in a True-Type/OpenType font format fonts.

• InfoPrint Font Collection: WorldType Fonts, LCD4-5684-06 (DVD). This DVD includes TrueType/
OpenType fonts.

• Infoprint Font Collection: AFP Raster Fonts, LCD4-5700-02 (DVD). This DVD includes AFP Raster fonts.

Installing the SAP Print Feature on the InfoPrint Manager server
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• AFP Asian Classic TrueType Collection and OpenType fonts, LCD2-20055-01 (DVD). This DVD includes
AFP Asian Classic TrueType Collection and OpenType fonts.

For more information about obtaining additional InfoPrint Font Collection media access the RICOH
InfoPrint Font Collection home page.

To install the fonts that are required to transform OTF or ABAP data from SAP R/3 on an InfoPrint
Manager system, use the installation procedure that comes with the InfoPrint Font Collection
documentation (Readme.pdf).

Configuring the SAP R/3 transform

Depending upon the types of data you are printing, you might need to configure some of the files that
are provided with the SAP transform. For example:

• To use form definitions that are mapped to SAP Formats (Paper Types), you must configure the
pagedef.tab file as described in Changing document print orientation, p. 72.

• If you have created a new font in an SAP R/3 document, you must configure the fonts.tab file as
described in Setting up your SAP R/3 system to support new OTF user fonts, p. 89.

• To expand or shorten the width of a barcode for printing, you must configure the barcode.tab file as
described in Bar codes and printing from SAP R/3 through InfoPrint Manager, p. 97.

The SAP transform includes two types of files:

• An executable named sap2afp, which converts Output Text Format (OTF) data into MO:DCA-P
output data and Advanced Business Application Programming (ABAP) list format data into line data.
On an InfoPrint Manager AIX server or InfoPrint Manager Linux server, this file is installed in the
/usr/lpp/psf/bin directory. On an InfoPrint Manager Windows server, this file is installed in the
install_path\bin path.

• SAP (sap2afp) transform configuration files for AIX or Linux, p. 18 shows the configuration files that
are installed in either the /usr/lpp/psf/sap2afp directory on an InfoPrint Manager AIX server and
InfoPrint Manager Linux server, or the install_path\sap2afp path on an InfoPrint Manager Windows
server.

SSAAPP ((ssaapp22aaffpp)) ttrraannssffoorrmm ccoonnffiigguurraattiioonn ffiilleess ffoorr AAIIXX oorr LLiinnuuxx

Configuration file Purpose Use

barcode.tab Provides list of valid SAP bar
codes.

OTF data only

xxxxyyyy.tab Maps ASCII code pages to
EBCDIC code pages.

OTF data only

fonts.tab Provides a list of raster fonts with
the appropriate character set
and code page.

OTF data only

6400fonts.tab Provides a list of raster fonts that
apply exclusively to the 6400

OTF data only

2 Installing and configuring InfoPrint Manager's OMS
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Configuration file Purpose Use

printer, with the appropriate
character set and code page.

image.tab Defines the dither matrix for
half-tone color print jobs.

OTF data only

pagedef.tab Defines the form definition (SAP
PAPER TYPE) used, as well as
the page definition and fonts for
jobs that go through ACIF.

ABAP/OTF

pagedef.tab.unicode Processes ABAP files in Unicode
environment.

ABAP data only

pagedef.tab.japan Processes ASCII-encoded ABAP
files containing Japanese
characters in a non-Unicode
environment.

ABAP data only

pagedef.tab.korea Processes ASCII-encoded ABAP
files containing Korean
characters in a non-Unicode
environment.

ABAP data only

pagedef.tab.spchinese Processes ASCII-encoded ABAP
files containing Simplified
Chinese characters in a non-
Unicode environment.

ABAP data only

pagedef.tab.tdchinese Processes ASCII-encoded ABAP
files containing Traditional
Chinese characters in a non-
Unicode environment.

ABAP data only

pagedef.tab.cyr Processes ASCII-encoded ABAP
files containing Cyrillic
characters in a non-Unicode
environment.

ABAP data only

defcp.tab Converts ASCII into EBCDIC
characters.

ABAP data only

defcp.tab.unicode Processes ABAP files in Unicode
environment.

ABAP data only

defcp.tab.japan Processes ASCII-encoded ABAP
files containing Japanese
characters in a non-Unicode
environment.

ABAP data only

defcp.tab.korea Processes ASCII-encoded ABAP
files containing Korean
characters in a non-Unicode
environment.

ABAP data only

Installing the SAP Print Feature on the InfoPrint Manager server
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Configuration file Purpose Use

defcp.tab.spchinese Processes ASCII-encoded ABAP
files containing Simplified
Chinese characters in a non-
Unicode environment.

ABAP data only

defcp.tab.tdchinese Processes ASCII-encoded ABAP
files containing Traditional
Chinese characters in a non-
Unicode environment.

ABAP data only

defcp.tab.cyr Processes ASCII-encoded ABAP
files containing Cyrillic
characters in a non-Unicode
environment.

ABAP data only

userenv Specifies the environment for the
ASCII-encoded ABAP files

ABAP

IInnssttaalllliinngg tthhee IInnffooPPrriinntt MMaannaaggeerr OOMMSS ssuuppppoorrtt wwhheenn SSAAPP rruunnss oonn
HHPP--UUXX oorr SSuunn SSoollaarriiss
SAP R/3 installations that run on HP-UX or Sun Solaris systems work with InfoPrint Manager when these
installations are configured to invoke commands remotely on the InfoPrint server.

To use the OMS support of the SAP Print Feature with an SAP R/3 system running on a non-AIX UNIX
system, you must install the SAP feature on the InfoPrint server and do these tasks:

1. Configuring the InfoPrint Manager Server, p. 20

2. Configuring the SAP system server, p. 23

Configuring the InfoPrint Manager Server

Follow the appropriate procedure depending on which version of InfoPrint Manager you are using:

• Configuring the InfoPrint Manager AIX server, p. 20

• Configuring the InfoPrint Manager Linux server, p. 21

• Configuring the InfoPrint Manager Windows server, p. 22

Configuring the InfoPrint Manager AIX server

To configure the AIX server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Add a user called sapuser. This user does not have to be part of any special groups.

2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.
equiv file:

+ sapuser

2 Installing and configuring InfoPrint Manager's OMS
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3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the
InfoPrint Manager AIX server as sapuser:

1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.

2. Edit the .rhosts file and add a line for each non-AIX server running an SAP R/3 application
with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate AIX users for
each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to create
additional users (like sapuser) that are mapped to each application server from which you will be using
InfoPrint Manager to print.
For more information about using the rsh and rcp commands to connect to the InfoPrint Manager AIX
server and send files between servers, see your AIX Operating System documentation.

Turning off GOCA support on an AIX server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an
AFP data architecture used to represent pictures generated by computer. If your installation uses older
printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features,
such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager AIX server, go to the AIX server
and use this procedure:

1. Access the ipm_submit file that reside in the /usr/lpp/pd/bin directory.

2. Using your AIX editor of choice, comment out the othertoptions="other-transform-options=
'-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed
output, p. 92.

Configuring the InfoPrint Manager Linux server

To configure the Linux server that has already installed InfoPrint Manager with the SAP Print Feature:

1. Add a user called sapuser. This user does not have to be part of any special groups.

2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.
equiv file:

+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the
InfoPrint Manager Linux server as sapuser:

1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.

2. Edit the .rhosts file and add a line for each non-Linux server running an SAP R/3 application
with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate Linux users for
each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to create
additional users (like sapuser) that are mapped to each application server from which you will be using
InfoPrint Manager to print.

Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris
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For more information about using the rsh and rcp commands to connect to the InfoPrint Manager Linux
server and send files between servers, see your Linux Operating System documentation.

Turning off GOCA support on an Linux server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an
AFP data architecture used to represent pictures generated by computer. If your installation uses older
printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features,
such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager Linux server, go to the Linux
server and use this procedure:

1. Access the ipm_submit file that reside in the /usr/lpp/pd/bin directory.

2. Using your Linux editor of choice, comment out the othertoptions="other-transform-
options='-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed
output, p. 92.

Configuring the InfoPrint Manager Windows server

The rshd and rexecd services are prerequisites for HP-UX and Sun Solaris SAP client support.

Use this procedure to configure the Windows server that has already installed InfoPrint Manager with
the SAP Print Feature:

1. Install both an rshd and rexecd service on your InfoPrint Manager Windows server.

During the installation of these services, make sure that remote users are defined users on the
InfoPrint Manager for Windows system so that it is possible to write to this server from the
Windows SAP client system.

2. From the Start menu, access the Programs→ Administrative Tools→ User Manager path.

3. Create a new user named sapuser.

This user does not have to be part of any special groups.

4. Authorize the sapuser userid to issue remote commands by adding this entry to the .rhosts or
equivalent file: +sapuser.

5. Authorize all remote servers running the SAP R/3 applications to specify remote commands on
the InfoPrint Manager Windows server by specifying:

fully_qualified_server_name +

where fully_qualified_server_name is either the IP address (in dotted decimal format) or the host
name of the server.
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1. If you use a host name, TCP/IP must be able to resolve that name through either the security
file or through a Domain Name Server (DNS).

2. If a DNS is not being used, but the host name is specified in the hosts file, specify the fully
qualified name in the .rhosts or equivalent file.

3. If a DNS is not being used, and the host name is not specified in the hosts file, you must
specify an IP address in the .rhosts or equivalent file (for example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create separate users for each
SAP system or SAP R/3 application server. Repeat steps two through five below to create new user IDs
that you can map to each SAP application server from which you plan to use InfoPrint Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an
AFP data architecture used to represent pictures generated by computer. If your installation uses older
printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features,
such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager Windows server, access the
ipmcfg file from the directory where you installed InfoPrint Manager. When you click this file, it displays
the IPM Server Settings dialog. From here, you can click IPM GOCA Support to remove the check.

You can also turn off this support at a later date, as described in Adding box shading values to printed
output, p. 92.

Configuring the SAP system server

To allow SAP on HP-UX or Sun Solaris to issue the InfoPrint Manager commands, you must install the
InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the
commands. This includes every application server with a spool work process (SWP) managing R/3
devices that have been configured to use the InfoPrint Manager OMS. If you have configured your SAP
R/3 system to use alternate servers, you must repeat these installation tasks on the alternate servers as
well.

Use this procedure to configure remote servers (HP-UX, Sun) running the SAP R/3 application so you
can print with InfoPrint Manager:

1. Obtain access to each HP-UX or Sun Solaris server running SAP R/3 and log on.

2. Verify that you can ping the InfoPrint Manager server by host name:

ping -c 3 hostname

where hostname is the unqualified name for the InfoPrint Manager server, such as nwser.

If the response shows that a good communication path exists, you will see this:

----tcpip_addr PING Statistics----
packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 7/7/7 ms

Installing the InfoPrint Manager OMS support when SAP runs on HP-UX or Sun Solaris
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3. If you cannot ping the InfoPrint Manager server by host name, edit the /etc/hosts file and add
the host name and IP address of the InfoPrint Manager server:

For IPv4:

/etc/hosts: 9.99.11.109 nwser

For IPv6:

[2001:0ce8:58a3:0000:0000:6a2e:0370:3734]

4. Create a directory named /usr/lpp/pd/bin:

mkdir /usr/lpp/pd/bin

5. Use the file transfer protocol (FTP) client of your choice to copy either the /usr/lpp/pd/bin/
ipm.omsdesc file from the InfoPrint Manager AIX server and InfoPrint Manager Linux server, or
the install_path\bin\ipm.omsdesc from the InfoPrint Manager Windows server to at least
one of the SAP R/3 servers running the SAP R/3 application.

This file contains the InfoPrint Manager OMS definition that is loaded into the SAP R/3 System.
Make sure that the file is readable by the sysadmin (where sys is the three-character SAP system
name) on the SAP R/3 application system.

6. Use the FTP client of your choice to copy these files from the InfoPrint Manager server to an SAP
R/3 application server in your configuration. If you are using an InfoPrint Manager AIX server or
InfoPrint Manager Linux server, these files reside in the /usr/lpp/pd/bin directory. If you are
using an InfoPrint Manager for Windows server, these files reside in the install_path\bin
folder:

• ipm_submit.sys
• ipm_job_cancel.sys
• ipm_job_query.sys
• ipm_dev_query.sys

For the secondary qualifier (sys), specify the name of the system where your SAP applications are
running: hp for HP-UX or sun for Sun Solaris.

7. Make sure that each file copied in Step 6 is executable.

8. On the SAP application server in your installation, edit both files so they specify the name of the
user (sapuser) and host name where InfoPrint Manager is running. If you want the SAP Client for
HP-UX or Sun Solaris to use the secure shell (SSH) and secure copy (SCP) commands, you must
edit these files so that they specify the secure shell commands. The default behavior of the SAP
Clients is to use the remote shell commands (RSH).

To use the secure shell commands, you must change the value rsh to ssh:

# change the line below from "rsh" to "ssh" for secure shell
remote_shell="rsh"

9. Copy the four edited SAP command files to any other SAP application servers in your installation
that use the InfoPrint Manager server.

10. To complete the configuration, complete the procedures in Configuring and using the OMS, p.
29.

2 Installing and configuring InfoPrint Manager's OMS
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IInnssttaalllliinngg tthhee IInnffooPPrriinntt MMaannaaggeerr OOMMSS ssuuppppoorrtt wwhheenn SSAAPP rruunnss oonn
AAIIXX
To allow SAP on AIX to issue the InfoPrint Manager commands, you must install the InfoPrint Manager
SAP Client on every SAP server where an SAP application server will issue the commands. This includes
every application server with an SWP managing R/3 devices that have been configured to use the
InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must
repeat these installation tasks on the alternate servers as well.

To install the SAP Client for AIX on your SAP application servers, use this procedure:

1. Log into the AIX system as root.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into the DVD-ROM reader.

3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you can open a terminal window by
clicking on the terminal icon contained in the front panel. (The front panel is the task bar that
appears at the bottom of the screen.) By default, the terminal icon is contained in a pop-up menu
above the text editor icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:

1. Type this on the command line:

smit cdrfs

2. Select Add a CDROM File System from the list of choices presented.

3. Click the List button and select your DVD-ROM device name (cd0, for example).

4. Type this in theMOUNT POINT field:

/cdrom

5. Click OK. The running person will raise his arms to indicate success. If he instead falls down
and you see crfs: 0506-909 /cdrom file system already exists, do not interpret this
as a failure. (The existing /cdrom file system should be usable.)

6. Press the F12 key to exit SMIT.

5. Type this on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by specifying setup —x.

During the course of the install, you are prompted to specify values for both PDHOST and PD_
SOCKET.

These environment variables become effective the next time you reboot the system. To start using
the OMS support without rebooting, edit these four files that are found in the /usr/lpp/pd/bin
directory:

• ipm_submit
• ipm_job_query
• ipm_job_cancel
• ipm_dev_query
Locate and uncomment the lines:

Installing the InfoPrint Manager OMS support when SAP runs on AIX
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#export PDHOST
#export PD_SOCKET

Specify the same values that you specified during the install.

For another way to specify or change the InfoPrint Manager host and socket information to point to
another InfoPrint Manager system or server, see Switching InfoPrint Manager servers, p. 49. You can
also provide a failover connection to another InfoPrint Manager server in the same InfoPrint Manager
system (see Failing over to other servers in the same InfoPrint Manager system, p. 51 ) and how to send
jobs to more than one InfoPrint Manager system at the same time (see Supporting multiple InfoPrint
Manager systems, p. 46).

1. The SAP Client package cannot be installed if other ipr* filesets reside on an SAP application
server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications do
not require GOCA support features, such as box shading, you might want to improve performance
by turning off the GOCA support. For instructions on turning off this support after installing the SAP
Client, see Adding box shading values to printed output, p. 92.

To complete the configuration, complete the procedures described in Configuring and using the OMS,
p. 29.

• If you are upgrading your SAP client, make sure that you follow these steps:

1. Use the /etc/rc.iprsap command to start all sap-daemons contained in the /etc/rc.
iprsap.daemons file.

2. Update the /etc/rc.iprsap.daemons file containing the startcbd commands incl. parameters:

– Access the rc.iprsap.daemons file in the /etc directory.

– Edit the file and add this command: "/usr/lpp/pd/bin/startcbd SystemName HostName
InstanceID User Client Password Language".

3. Edit the /etc/hosts file and add the host name and the IP address of the SAP server (for
example, 192.168.11.109 sapsrv).

4. Update the inittab file to remove custom startcbd references.

IInnssttaalllliinngg tthhee IInnffooPPrriinntt MMaannaaggeerr OOMMSS ssuuppppoorrtt wwhheenn SSAAPP rruunnss oonn
LLiinnuuxx
To allow SAP on Linux to issue the InfoPrint Manager commands, you must install the InfoPrint Manager
SAP Client on every SAP server where an SAP application server will issue the commands. This includes
every application server with an SWP managing R/3 devices that have been configured to use the
InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate servers, you must
repeat these installation tasks on the alternate servers as well.

To install the SAP Client for Linux on your SAP application servers, use this procedure:

1. Log into the Linux system as root.
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2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive.

3. Open a terminal window.

4. The first time you run the Installer, follow this procedure:

1. If you are installing from the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642:

1) Insert the DVD-ROM into the drive.

2) Mount the file system by typing:

mount /dev/cdrom <mount_point>

3) Type:

cd <mount_point>/linux

4) Install the Linux SAP Client package (64–bit) by typing:

rpm -i ipr-client-sap.4.12.m-n.x86_64.rpm

where m and n represent the service update level.

5) If you are upgrading the InfoPrint Manager: Linux SAP Client from a previous version,
you need to run:

rpm -U ipr-client-sap.4.12.m-n.x86_64.rpm

where m and n represent the service update level.

After the upgrade is complete, you must log off and then log in again.

6) Unmount <mount_point> file system.

7) Remove the Common Client DVD-ROM.

2. Test the system:

1) Log off and log back on to pickup the changes.

2) Issue one of the commands, followed by the -h flag to display the syntax of that
command and verify the installation.

For example:

pdls -h

These environment variables become effective the next time you reboot the system. To start
using the OMS support without rebooting, edit these four files that are found in the /usr/lpp/
pd/bin directory:

• ipm_submit
• ipm_job_query
• ipm_job_cancel
• ipm_dev_query
Locate and uncomment the lines:

#export PDHOST
#export PD_SOCKET

Specify the same values that you specified during the install.
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For another way to specify or change the InfoPrint Manager host and socket information to point to
another InfoPrint Manager system or server, see Switching InfoPrint Manager servers, p. 49. You can
also provide a failover connection to another InfoPrint Manager server in the same InfoPrint Manager
system (see Failing over to other servers in the same InfoPrint Manager system, p. 51) and how to send
jobs to more than one InfoPrint Manager system at the same time (see Supporting multiple InfoPrint
Manager systems, p. 46).

1. The SAP Client package cannot be installed if other ipr-client-sap.* rpm package reside on an
SAP application server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications do
not require GOCA support features, such as box shading, you might want to improve performance
by turning off the GOCA support. For instructions on turning off this support after installing the SAP
Client, see Adding box shading values to printed output, p. 92.

To complete the configuration, complete the procedures described in Configuring and using the OMS,
p. 29.

• If you are upgrading your SAP client, make sure that you follow these steps:

1. Use the /etc/rc.iprsap command to start all sap-daemons contained in the /etc/rc.
iprsap.daemons file.

2. Update the /etc/rc.iprsap.daemons file containing the startcbd commands incl. parameters:

– Access the rc.iprsap.daemons file in the /etc directory.

– Edit the file and add this command: "/usr/lpp/pd/bin/startcbd SystemName HostName
InstanceID User Client Password Language".

3. Edit the /etc/hosts file and add the host name and the IP address of the SAP server (for
example, 192.168.11.109 sapsrv).

IInnssttaalllliinngg tthhee IInnffooPPrriinntt MMaannaaggeerr OOMMSS ssuuppppoorrtt wwhheenn SSAAPP rruunnss oonn
WWiinnddoowwss
To allow SAP on Windows to issue the InfoPrint Manager commands, you must install the InfoPrint
Manager SAP Client on every SAP server where an SAP application server will issue the commands.
This includes every application server with an SWP managing R/3 devices that have been configured
to use the InfoPrint Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install the InfoPrint Manager SAP Client for Windows on your Windows SAP system, use this
procedure:

1. Log in as the Administrator user.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into your DVD-ROM drive.

3. From the InfoPrint Manager: Common Clients window, click Install InfoPrint Manager Products.

4. Click InfoPrint Manager SAP Clients.
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5. Select a location for installing the clients (the default is install_path \Infoprint Manager SAP Clients\).

6. From the IPM Server Settings pop-up dialog, specify either the fully qualified host name or the IP
address of the InfoPrint Manager server to which you will be sending jobs. The IPM Hostname field
defaults to showing the loop back address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to change.

For another way to specify or change the InfoPrint Manager host and socket information to point to
another InfoPrint Manager system or server, see . You can also provide a failover connection to
another InfoPrint Manager server in the same InfoPrint Manager system (see Failing over to other
servers in the same InfoPrint Manager system, p. 51 ) and how to send jobs to more than one
InfoPrint Manager system at the same time (see Supporting multiple InfoPrint Manager systems, p.
46).

• When the User Account Control (UAC) Windows system setting is active, you can change the
SAP Client configuration settings only when running as Admnistrator. To use this option, start the
InfoPrint Select SAP Clients application by right clicking on the icon and selecting "Run as
Administrator". The Local Security Policy settings could influence the permission to update the
configuration settings. For more information consult the UAC and Local Security Policy Windows
documentation.

• Enable the IPM LDAP Mode if you are using the InfoPrint Manager Pull Print feature with your
InfoPrint Manager server. For more information, see Enabling LDAP mode, p. 89.

• Do not check the IPM Debug Mode checkbox unless instructed to do so by technical support.

• Remove the check in the IPM GOCA Support checkbox only if you want to turn off GOCA
support in the SAP transform.
By default, the SAP client requests Graphics Object Content Architecture (GOCA) support.
GOCA is an AFP data architecture used to represent pictures generated by computer. If your
installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications
do not require GOCA support features, such as box shading, you might want to improve
performance by turning off the GOCA support. For instructions on turning off this support after
installing the SAP Client, see Adding box shading values to printed output, p. 92.

Once you have set the appropriate values, click OK to close this dialog.

7. When the SAP client has been installed, click Finish.

8. To exit the install process, click Back, and then click Exiton the next screen.

9. To complete the OMS configuration, complete the tasks in Configuring and using the OMS, p. 29.

CCoonnffiigguurriinngg aanndd uussiinngg tthhee OOMMSS
These sections describe how you can configure, customize, and use your SAP R/3 InfoPrint Manager
environment to report enhanced job status that meet the particular criteria of your installation.

The first set of topics (Required configuration tasks, p. 30 ) must be done on both the SAP application
servers and the InfoPrint Manager servers for enhanced status reporting to work correctly. The second
set of topics (Using OMS support tasks, p. 42 ) describes how to use the OMS to get more information
about your print jobs, including obtaining job status, device status, and the capability to cancel jobs.
The third set of topics (Optional OMS configuration tasks, p. 43 ) cover a variety of useful
administration functions, including:

Configuring and using the OMS
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• Activating end-user pop-ups, p. 43
• Selecting event report levels, p. 44
• Organizing OMS output devices into LOMSs, p. 45
• Moving OMS definitions among SAP systems, p. 48
• Switching InfoPrint Manager servers, p. 49
• Failing over to other servers in the same InfoPrint Manager system, p. 51
• Customizing an SAP daemon error log on AIX or Linux, p. 53
• Customizing an SAP callback process error log on Windows, p. 54
• Shutting down the callback daemon on AIX, p. 56
• Shutting down the callback daemon on Linux, p. 56
• Shutting down the callback process on Windows, p. 57
• Deleting an SAP callback process on Windows, p. 57

Use these topics with relevant SAP R/3 online product documentation.

Required configuration tasks

This section consists of the required configuration tasks that you must do to receive OMS callback
reports.

When you finish defining the InfoPrint Manager OMS to your SAP R/3 system, you can define devices
so you can print with InfoPrint Manager as described in Defining devices for InfoPrint Manager that use
the InfoPrint OMS, p. 40.

Defining the InfoPrint Manager OMS to SAP R/3 on the SAP system server

InfoPrint Manager provides a configuration file (ipm.omsdesc) to assist in defining InfoPrint Manager as
an OMS on your R/3 system. These two procedures are performed on your SAP application server to:

• Define InfoPrint Manager as a real output management system (ROMS) for your SAP R/3
installation

• Define your first logical output management system (LOMS) so you can define access method E
devices in SAP R/3

Defining a real output management system

Use this procedure to define a real output management system (ROMS) for SAP R/3:

1. Log onto your SAP R/3 Release 4 or later system.

2. Import the InfoPrint Manager OMS configuration file by entering transaction SA38.

3. From the ABAP: Execute Program window, specify RSPOXOMS in the Program field and click
Execute (checkmark with a clock).

4. From the Spool: Saving and Loading of Definitions window, do one of these tasks:

• If configuring for SAP on UNIX, make these changes to the Spool: Saving and Loading of
Definitions window:
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– Specify /usr/lpp/pd/bin/ipm.omsdesc in the Export/Import file name field.

– Set the File system info pane to Server.

– Set the Operation pane to Import.

– Check both the Execute import and Generate log options in the Options pane.

Once you have set these options, click Execute (checkmark with a clock).

• If configuring for SAP on Windows, make these changes to the Spool: Saving and Loading of
Definitions window:

– Make sure that the Operation pane is set to Import.

– Specify C:\Program Files\RICOH\InfoPrint Manager SAP Clients\ipm.omsdesc
in the Export/import file name field.

– Make sure that the File system info pane is set to Frontend computer.

– Check both the Execute import and Generate log options in the Options pane.

Once you have set these options, click Execute (checkmark with a clock).

5. Running the report displays a list of the ROMS and LOMS that have been imported into the
system.

Defining a logical output management system

Use this procedure to define a logical output management system (LOMS) for SAP R/3:

1. From the SAP R/3 graphical user interface, complete the logical output management system
definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical
OMS from the Output management systems pane to obtain a list of the logical output
management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the
IPM001 LOMS and click Choose (checkmark with a clock).

4. From the Spool Administration: Logical Output Management (Display) window, click Change
(red pencil).

5. From the Spool Administration: Logical Output Management (Change) window on the SAP
Configuration tab:

• Select a value from the pulldown list of all SAP application servers for both the Tasking
target field and the Callback target field in the format: hostname_systemname_
instanceID, such as sap12_MBS_00.
The Tasking target field, specifies where the commands are invoked, while the Callback
target field specifies where the asynchronous callbacks are delivered.

• Click Extended config. (photo film with two cards superimposed on top) icon and specify a
value for the Event report level field in the SAP configuration pane

Once you click Extended config., it disappears from the view and the Event report level field
is always displayed.
You must select one of these values:
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– Final messages
– Also problems
– Also warnings
– Also status changes
– Also information
– All information options

In earlier versions of the SAP GUI, the Event report level field consists of numeric message
levels. For the earlier SAP GUI, use the down arrow to determine the message level you want (1
is the least and 5 is the most).

6. To make sure that users on your SAP R/3 system receive pop-up windows for both problem and
completion notification messages about a job's status, check the Status dialog box field in the
Jobs pane.

Until SAP R/3 Release 4.5B, the pop-up message is always reported only to users in the client
where the OMS callback daemon has logged on. You defined this client when Defining an SAP
user for the OMS callback daemon or process, p. 32. Beginning with SAP R/3 Release 4.5B,
SAP delivers asynchronous pop-ups to users who are logged onto any SAP client.

7. From the OMS Configuration tab, you can specify how often (Send period field) in seconds or
how many (Number of events field) notification events the InfoPrint Manager callback daemon
should collect before delivery to the SAP R/3 system. In other words, the callback daemon will
only deliver events for jobs on printers associated with this LOMS if it has collected x number or x
seconds have passed since the last delivery.

8. Save this information by clicking Save (diskette) icon.

9. Now you can use the SAP GUI for Defining an SAP user for the OMS callback daemon or
process, p. 32.

Defining an SAP user for the OMS callback daemon or process

Because the OMS callback daemon must logon to the SAP system and its external management
interface (XMI) to make RFC requests, you must define a user for it. You will need this user information
when Starting the SAP callback daemon or process, p. 34.

The user should be a CPIC (or System) type and requires XOMI permissions to log into the CCMS
system management XOM application programming interface. These authorizations can be provided in
the S_XMI_XOM_A profile.

This profile has the S_RFC and S_XMI_PROD authorization objects. To make the profile compatible with
the SAP NWRFC protocols, add these values for the authorization object : S_RFC.

ACTVT : 16

RFC_NAME : RFC1, SDIFRUNTIME

RFC_TYPE : FUGR
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If you ever change or modify this SAP user, remember to make the changes where the SAP callback
daemon is running:

• If on InfoPrint Manager for AIX, edit the rc.iprsap.daemon file in the /etc directory.

• If on InfoPrint Manager for Linux, edit the rc.iprsap file in the /etc directory. Also, you can use the
Management Interface (IPMMI) to left-click SAP Callback Processes from the Objects view, which
lets you access the SAP Callback Processes in the main view. From the main view, you can right-
click and select Open.

• If on InfoPrint Manager for Windows, use the InfoPrint Manager Management Console to left-click
SAP Callback Processes from the Objects view, which lets you access the SAP Callback Processes
in the main view. From the main view, you can right-click and select Open.

Collecting information necessary to start an SAP callback daemon or process

These tables display the variables needed to start an SAP callback daemon or process. All the variables
in the tables are examples and will differ from the values that you specify, unless otherwise noted. These
variables are grouped into two categories:

1. SAP R/3 instance where the callback daemon logs on

SSAAPP RR//33 iinnssttaannccee wwhheerree tthhee ccaallllbbaacckk ddaaeemmoonn oorr pprroocceessss ((ssaappccbbdd)) llooggss oonn

Variable Explanation

MBS The three-character system name

sap12 or /H/host/S/service/W/pass The host name or the SAProuter route string

00 The instance ID

If you are starting multiple SAP callback daemons and SAP callback processes to run on different
SAP application servers, you must make sure that there is a unique SAP R/3 instance (system name,
host name, and instance ID) for each SAP callback userid as shown in Callback daemon or process
user ID information, p. 34.
If you don't know what values you can specify for these variables, you can refer to the drop-down
list for the Callback target field from the Spool Administration: Change Logical Output
Management System window (for an example, see step 5 of Defining a logical output management
system, p. 31).

A standard example of an SAProuter route string is /H/host/S/service/W/pass, where:

• /H/host indicates the host name.

• /S/service is used for specifying the service (port). It is an optional entry, the default value is
3299.

• /W/password indicates the password for the connection between the predecessor and
successor on the route; this is optional. The default value is “”, no password)

To use the SAProuter, you need to install and configure SAProuter on your SAP system.

The standard entries in a route permission table are P/S/D <source host> <dest host> <dest
serv> <password>. The <source-host> and <dest-host> entries could be SAProuters.
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For more information about installing and configuring the SAProuter, go to the SAP Help Portal.

2. Callback daemon or process user ID information
You defined the information for Callback daemon or process user ID information, p. 34 when you
did the step described in Defining an SAP user for the OMS callback daemon or process, p. 32.

CCaallllbbaacckk ddaaeemmoonn oorr pprroocceessss uusseerr IIDD iinnffoorrmmaattiioonn

Variable Explanation

infoprint The User value. This value and the two that
follow were originally defined when you
created an SAP userid for the OMS callback
daemon.

030 The Client value
newname The Password value
En The Language value: in this example, English

If you are creating an SAP callback process on
Windows, this value is not required.

Starting the SAP callback daemon or process

Each SAP R/3 system using the InfoPrint Manager callback support needs to have one callback
daemon running. If your callback support runs on an InfoPrint Manager for AIX server or InfoPrint
Manager for Linux server, you must do both of these procedures:

• Starting the SAP callback daemon on AIX, p. 35
• Starting the SAP callback daemon from command line, p. 35
• Configuring to start callback daemons at system reboot on AIX, p. 37
• Configuring to start callback daemons at system reboot on Linux, p. 37

If your callback support runs on an InfoPrint Manager for Windows server, you must complete the
Starting the SAP callback process on Windows, p. 39 procedure.

• If your logical destination does not receive a job sent from your SAP device, delete and recreate the
SAP callback daemon with the same settings on the InfoPrint Manager server.

• When using SAP 4.x kernel and you start the sapcbd daemon, you might get a connection failure
and the error message "CALL_FUNCTION_SIGNON_REJECTED", even if the login credentials are
correct. To avoid this error, you must install the latest patch for the corresponding kernel. For more
information, consult the SAP notes 171805 (http://search.sap.com/notes?id=0000171805) and
19466 (http://service.sap.com/sap/support/notes/19466).

• For more information on general authorization rights needed to start SAP callback daemon or
process, see: http://search.sap.com/notes?id=0000171805.
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Starting the SAP callback daemon on AIX

To start the SAP callback daemon, run these commands as an authorized user or as root.

1. From the AIX command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host
name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Run the SAP callback daemon.

/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \
Client Password Language

For more information, see Defining an SAP user for the OMS callback daemon or process, p. 32.

Specify the same values you used in Collecting information necessary to start an SAP callback
daemon or process, p. 33.

If the callback daemon has started correctly, you should see this response:

5010-428 Successfully started SAPCBD

If you receive any other message, the daemon has not started correctly. To solve the problem,
refer any messages displayed in either the message column or by selecting the Server Log
object from the left pane of the InfoPrint Manager Management Console to access the Server
Log view. Correct the problems cited, and try to start the callback daemon again. If it still does
not start correctly, contact your service representative.

• The Host Name Resolution must be enabled and functional for the sapcbd daemon to
communicate correctly with the SAP systems.

• If the SAP callback daemon has been configured to start at system startup, but it is not
running, you can start it by running /etc/rc.iprsap command. This command starts all
configured SAP callback daemons.

Starting the SAP callback daemon on Linux

The SAP callback daemon can be started from the Linux command line or using the Management
Interface application.

Starting the SAP callback daemon from command line

To start the SAP callback daemon, run these commands as an authorized user or as root.

1. From the Linux command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host
name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).
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2. Run the SAP callback daemon.

/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \
Client Password Language

For more information, see Defining an SAP user for the OMS callback daemon or process, p. 32.

Specify the same values you used in Collecting information necessary to start an SAP callback
daemon or process, p. 33.

If the callback daemon has started correctly, you should see this response:

5010-428 Successfully started SAPCBD

If you receive any other message, the daemon has not started correctly. To solve the problem,
refer any messages displayed in either the message column or by selecting the Server Log
object from the left pane of the InfoPrint Manager Management Console to access the Server
Log view. Correct the problems cited, and try to start the callback daemon again. If it still does
not start correctly, contact your service representative.

• The Host Name Resolution must be enabled and functional for the sapcbd daemon to
communicate correctly with the SAP systems.

• If the SAP callback daemon has been configured to start at system startup, but it is not
running, you can start it by running /etc/rc.iprsap command. This command starts all
configured SAP callback daemons.

Starting the SAP callback daemon using the Management Interface application

1. From the Linux command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host
name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Start the SAP callback daemon using the Management Interface from Applications-
>InfoPrintManager->Management Interface->SAP Callback Daemons. Right-click New.

Enter the appropriate SAP System and user information for the SAP Callback daemon:

• System Name: The three character SAP system name

• Host Name: The SAP HostName

• Instance ID: The two digit SAP Instance ID

• User: The SAP CPIC (System) User

• Client: The three digit SAP Client

• Password: The User password

• Language: The Language the SAP Callback daemon will run

• Startup Options: Start Now
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If you receive any message, the daemon has not started correctly. To solve the problem, refer
any messages displayed in either the message column or by selecting the Server Log object from
the left pane of the InfoPrint Manager Management Interface to access the Server Log view.
Correct the problems cited, and try to start the callback daemon again. If it still does not start
correctly, contact your service representative.

The Host Name Resolution must be enabled and functional for the sapcbd daemon to
communicate correctly with the SAP systems.

Configuring to start callback daemons at system reboot on AIX

The SAP callback daemon needs to run all the time. A monitor makes sure that it is restarted if it ever
stops after it is started.

To start the SAP callback daemon at system startup, you must edit the /etc/rc.iprsap.daemons file
from the AIX command line from the InfoPrint Manager AIX server as an authorized user or as root.

1. From the AIX command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host
name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Access the rc.iprsap.daemons file in the /etc directory. Edit the file and add this command:

/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \
Client Password Language

For more information, see Defining an SAP user for the OMS callback daemon or process, p. 32.

Specify the same values you used in Collecting information necessary to start an SAP callback
daemon or process, p. 33.

To start the SAP callback daemon see Starting the SAP callback daemon on AIX, p. 35.

Configuring to start callback daemons at system reboot on Linux

The SAP callback daemon needs to run all the time. A monitor makes sure that it is restarted if it ever
stops after it is started.

You have two options for configuring the SAP callback daemon at system startup:

• Configuring the SAP callback daemon to start at system statup from Linux command line interface, p.
37

• Configuring the SAP callback daemon to start at system statup from Management Interface
application, p. 38

Configuring the SAP callback daemon to start at system statup from Linux command line interface

1. From the Linux command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

Configuring and using the OMS



2

38

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the host
name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Start the SAP callback daemon. See Starting the SAP callback daemon on Linux, p. 35.

3. Create new startup script /var/pd/sapcb.SystemName/startup.sh for this callback daemon
where SystemName is the three character SAP system name. Make sure that the /var/pd/sapcb.
SystemName/startup.sh is an executable and that it is owned by the authorized user and
by the group sys. The script should contain:

#!/bin/bash

/usr/lpp/pd/bin/startcbd SystemName HostName InstanceID User \
Client Password Language
if [ $? -eq 0 ]
then

exit 0
else

exit 1
fi

For more information, see Defining an SAP user for the OMS callback daemon or process, p. 32.

Specify the same values you used in Collecting information necessary to start an SAP callback
daemon or process, p. 33.

4. Add the /var/pd/sapcb.SystemName/startup.sh command to the /etc/rc.iprsap.
daemons file.

5. To start the SAP callback daemon, see Starting the SAP callback daemon on Linux, p. 35.

Configuring the SAP callback daemon to start at system statup from Management Interface application

1. If the SAP callback daemon has been configured but not set to start at system startup, start the
Management Interface from Applications->InfoPrintManager->Management Interface-
>SAP Callback Daemons. Right-click the SAP callback daemon, choose Start. If the Start
option is disabled, stop the SAP callback daemon first using Stop option. Choose Start at
reboot.

2. If the SAP callback daemon has not been configured:

1. From the Linux command line, verify that you can ping the SAP server by host name:

ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as sapsrv.

If you cannot ping the SAP server by the host name, edit the /etc/hosts file and add the
host name and the IP address of the SAP server (for example, 192.168.11.109 sapsrv).

2. Start the SAP callback daemon using the Management Interface from Applications-
>InfoPrintManager->Management Interface->SAP Callback Daemons. Right-click
New.

Enter the appropriate SAP System and user information for the SAP Callback daemon:

• System Name: The three character SAP system name

• Host Name: The SAP HostName
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• Instance ID: The two digit SAP Instance ID

• User: The SAP CPIC (System) User

• Client: The three digit SAP Client

• Password: The User password

• Language: The Language the SAP Callback daemon will run

• Startup Options: Start both or Start at reboot

• The Host Name Resolution must be enabled and functional for the sapcbd daemon to
communicate correctly with the SAP systems.

• If the Startup Option is Start at reboot and you want to start the SAP callback daemon, see
Starting the SAP callback daemon on Linux, p. 35.

Starting the SAP callback process on Windows

Each SAP R/3 system using the InfoPrint Manager callback support needs to have one callback process
running. To start the SAP callback process on an InfoPrint Manager Windows server, you must access
the SAP Callback Processes from the InfoPrint Manager Management Console.

The SAP Callback Processes object is only visible if you have installed the optional InfoPrint Manager:
SAP Print Feature, LCD4-5646.

1. Verify that you can ping the SAP server by host name:

1. From a either a Command or a Command Prompt window, specify ping hostname, where
hostname is the unqualified name for the SAP server, such as sapsrv.

2. If you cannot ping the SAP server by host name, edit the hosts file in the C:\Windows
\system32\drivers\etc folder and add both the host name and the IP address of the SAP
server (for example, 192.168.11.109 sapsrv).

2. From the Start menu, select Programs→ InfoPrint Manager→Management Console.

3. Right-click SAP Callback Processes in the Objects view in the left pane of this window and click
New.

4. Specify the values that you gathered in Collecting information necessary to start an SAP callback
daemon or process, p. 33, click OK, and wait.

5. If the callback process has started correctly, the main panel should show a state of RUNNING.

• If the state shows Failed To Start, the process has not started correctly. To resolve the
problem, if the message displayed does not provide enough information to correct the
problem, you can switch to the Server Log view for additional messages.

• See Expanding server ports for SAP callback processes, p. 40 if you receive this message:

5010-760: There are no available port numbers

• For all other messages, correct the problems cited, and try to start the callback process again.
If it still does not start correctly, contact your service representative.
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• If you are running the callback process on InfoPrint Manager for Windows, you do not need to
configure to start SAP Callback Processes on a system reboot because at reboot the InfoPrint
Manager SAP service is always started and the service will restart any SAP callback process that
was not manually stopped.

• The Host Name Resolution must be enabled and functional for the sapcbd daemon to
communicate correctly with the SAP systems.

Expanding server ports for SAP callback processes

Creating and managing SAP callback processes on your InfoPrint Manager for Windows server might
require that you increase the number of server communication ports available on your system. This
procedure shows how to do this task.

Use this procedure to increase the number of server ports available on your InfoPrint Manager for
Windows server.

1. From the InfoPrint Manager Management Console, stop the InfoPrint Manager server by selecting
File→ Stop Server from the main menu.

2. Select Edit→ Service Configuration→ Communication Ports.

3. In the Server Interface Ports field, increase the range to include twenty ports and save your
results.
The server interface ports default values range from 6880 to 6889. To make sure that you have
enough server communication ports for all SAP callback processes, you should increase the final
number in the range to 6899.

4. Use the InfoPrint Manager Management Console to start the InfoPrint Manager server by selecting
File→ Start Server from the main menu.

Defining devices for InfoPrint Manager that use the InfoPrint OMS

Use this procedure to define devices to SAP R/3. For more information, consult the “Connecting a
Printer to an External Output Management System” topic in the SAP R/3 online documentation.

1. Make sure that you have a logical destination defined in InfoPrint Manager that sends jobs to
your actual destination device.

2. From the SAP R/3 graphical user interface, specify the spad transaction.

3. From the Spool Administration: Initial screen (Change) window:

• Click Devices/servers

• Click Output devices

• Click Create next to the trash can icon

4. From the Spool Administration: Create Output Device window, fill in these pieces of information
for device attributes and access method:

2 Installing and configuring InfoPrint Manager's OMS



2

41

Field Explanation Example value

Output device Specify a long name for the
device.

Device Number 1

Short name Specify a short name.

Optionally, you can allow the
system to generate a short
name.

DEV1

Device type Specifies the driver that
generates the output data
stream.

SAPGOF

Host printer Specify the InfoPrint Manager
logical destination.

printer-ld

Access method to host
spool

Make sure you specify this
Access Method.

E

LOMS Specify the LOMS to which
this device should be
assigned. You specified this
value on the Spool
Administration: Logical Output
Management System window
under Define the InfoPrint
Manager OMS to SAP R/3.

IPM001

Spool server Select an applicable spool
server from the entries list on
the field.

sap12_MBS_00

5. Save this information by clicking on the Save (diskette) icon, then exit the interface.

Once you have saved these changes, you have a device that will print to InfoPrint Manager using
Access Method E.

If your logical destination does not receive a job sent from your SAP device, delete and recreate the
SAP callback daemon with the same settings on the InfoPrint Manager server.

Once you have defined this device to send jobs to InfoPrint Manager, you can do these tasks:

• Viewing enhanced job status, job events, and querying jobs, p. 42
• Displaying device status, p. 42
• Canceling jobs, p. 43
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Using OMS support tasks

This section contains the procedures that are available once you have configured your SAP OMS to
obtain job status about your print environment.

Viewing enhanced job status, job events, and querying jobs

This procedure describes OMS support for obtaining information about a print job sent to InfoPrint
Manager. By using this feature, you can see asynchronous events and synchronous queries about jobs
reported to your SAP R/3 system.

To view the status of an output request, use this procedure from the SAP R/3 graphical user interface:

1. From the Output Requests for Spool Request xxxxxx window (where xxxxxx refers to the SAP spool
ID), double-click the output request you want to view in the Status column on the far right.

2. From the Status Description pop-up window, you can see current information about the job,
including the last event received.

3. Click Events on the Status Description window to get the Events for Output Requests window.
From the Events for Output Requests pop-up window and, you can view all the events concerning
this job.

This Events for Output Requests pop-up window is displayed twice to show (1) the right side of
the window with the date, time, and current status of the job, and (2) the left-side of the window
with its message text.

4. From the Status Description pop-up window, you can also click Query and issue a query to
return the current information for a job, including its position in the queue. For example, the Status
Description window displays the result of a query for a job that has been successfully submitted
for printing. Notice that the first line shows the job's position in the print queue.

When you close this query Status Description window, the system updates the latest status for that
job in other displays.

Displaying device status

To display the status of InfoPrint Manager printers and the queue of jobs that have been sent to an
InfoPrint printer, use this procedure from the SAP R/3 graphical user interface:

1. From the R/3 main menu, access the Spool Administration: Initial Screen window by selecting the
Tools main menu and then selecting the Tools→ Administration→ Spool→ Spool
Administration path or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click Output devices from the
Configuration area.

3. From the Spool Administration: List of Output Devices window, do this:

1. Highlight your InfoPrint printer from the Devices column.

2. Click the Output device pull-down menu and select Choose.

4. From the Spool Administration: Change Output Device (Display) window, click External jobs.
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5. The Device Information of Host Spool pop-up window displays the status of this device.

The Device Information of Host Spool pop-up window is displayed twice to capture both the right
and the left sides. (1) This section indicates that there are six jobs in the InfoPrint Manager queue,
two of which are being processed by printers. (2) This section shows information about each job,
including its current status in InfoPrint Manager.

Canceling jobs

This procedure describes how you can cancel SAP print jobs that you have sent to the InfoPrint
Manager server. Use this procedure from the SAP R/3 graphical user interface. This procedure
provides only one of many methods for accessing the Spool Output Requests for Spool Request
XXXXXXXXXX window, where XXXXXXXXXX is the number of your SAP spool request.

1. From the R/3 main menu, access the Spool Administration: Initial Screen window by typing
/nspad in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click Output devices from the
Configuration area.

3. From the Spool Administration: List of Output Devices window, do this:

1. From the Devices column, use the mouse to highlight the SAP device that you used to send
your job to InfoPrint Manager.

2. Click Spool Requests .

4. From the Spool Requests for Device XXX window (where XXX is the name of the device that you
selected), double-click the spool request of the output request that you want to cancel.

5. From the Spool: Attributes window, click Output requests.

6. From the Spool Output Requests for Spool Request XXXXXXXXXX window (where XXXXXXXXXX is the
number of your SAP spool request), click the output request you want to cancel to highlight it and
then click the trash can icon to delete the output request from InfoPrint Manager.

This step invokes the InfoPrint Manager command for canceling a job (pdrm).

Optional OMS configuration tasks

These sections describe useful administrative functions, including ways of configuring your OMS to
improve performance. Be sure to consult your SAP R/3 Release 4 documentation with any procedures
described in this section.

Activating end-user pop-ups

InfoPrint Manager delivers information to SAP R/3 about output requests (print jobs) as they process.
SAP will alert job owners about problem and job completion information delivered from InfoPrint
Manager through end-user pop-up messages.
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Until SAP R/3 Release 4.5B, the pop-up message is always reported only to users in the client where
the OMS callback daemon has logged on. You defined this client when you Defining an SAP user for
the OMS callback daemon or process, p. 32. In SAP R/3 Release 4.5B, SAP delivers asynchronous
pop-ups to users who are logged onto any SAP client.

To activate this support, make sure that you have done these steps while installing and configuring
InfoPrint Manager with SAP R/3:

1. From the SAP R/3 graphical user interface, modify the logical output management system
(LOMS) definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical
OMS from the Output management systems pane to obtain a list of the logical output
management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select
IPM001 LOMS or another appropriate LOMS and click Choose.

4. From the Spool Administration: Logical Output Management (Display) window, click Change.

5. From the Spool Administration: Logical Output Management System window that is displayed
below, check the Status dialog box field in the Jobs pane and save the changes.

6. Once you have specified this setting, information from the InfoPrint Manager sent back to your
SAP R/3 application server will be delivered in the form of a pop-up window. For example, if an
output request was canceled, a pop-up Info window should appear on the output requesters'
SAPGUI.

All pop-up window text is scrollable, however an SAP R/3 limitation limits the text of the InfoPrint
Manager messages (as well as those received from any OMS) to 50 characters.

Selecting event report levels

This procedure describes how you can specify the level of events that the callback daemon reports for
jobs submitted through InfoPrint Manager:

1. From the SAP R/3 graphical user interface, modify the logical output management system
(LOMS) definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical
OMS from the Output Management Systems pane to obtain a list of the logical output
management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select
IPM001 LOMS and click Choose (checkmark with a clock).

4. From the Spool Administration: Logical Output Management (Display) window, click Change
(red pencil).

5. From the Spool Administration: Logical Output Management (Change) window displayed below,
specify a value for the Event report level field in the SAP configuration tab. Use the menu field
to select the most appropriate value for your installation.

When you have finished, be sure to save your changed LOMS definition by clicking the Save
folder icon.

2 Installing and configuring InfoPrint Manager's OMS



2

45

Organizing OMS output devices into LOMSs

While you can assign all of your R/3 OMS output devices to a single logical output management
system (LOMS), it might be useful to group output devices into separate LOMS, each with different SAP
devices assigned to them. After you define one or more LOMS on your system (see Defining another
logical output management system, p. 45), you can assign different SAP devices to each one,
depending on the functions they perform, such as:

• Using different report levels or event delivery criteria, p. 45
• Using different OMS services, p. 45
• Distributing the callback workload, p. 46
• Supporting multiple InfoPrint Manager systems, p. 46

Defining another logical output management system

Use this procedure to define another logical output management system for SAP R/3:

1. From the SAP R/3 graphical user interface, copy a logical output management system (LOMS)
definition by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and click Logical
OMS from the Output Management Systems pane to obtain a list of the logical output
management systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, click
Change (red pencil).

4. From the Spool Administration: List of Logical Output Management Systems (Change) window:

1. Highlight the Name field of the LOMS from which you want to copy.

2. Specify the Logical OMS→ Create using template path.

3. From the Spool Administration: Copy Logical OMS from OMS_Name window, specify the
name for your new LOMS in the Logical OMS field and click the Save (Diskette) icon.

5. By returning to the Spool Administration: List of Logical Output Management Systems window,
you can see your new LOMS displayed.

Using different report levels or event delivery criteria

You can define LOMSs to specify different report levels on the Spool Administration: List of Logical
Output Management Systems (Change) window, as described in Selecting event report levels, p. 44.
On the second screen of this same window, you can also define LOMSs to specify different Event
Delivery Criteria. This allows you to determine how often and how many events are delivered together
by the callback daemon to your SAP system. Before implementing this feature, consult both Defining
another logical output management system, p. 45 and the online documentation about LOMS that is
provided with your SAP R/3 system.

Using different OMS services

You can define LOMSs to allow for the use of different OMS services by a group of printers. For
example, you can restrict access to a particular ROMS feature like job cancellation. By creating a
LOMS and turning off job cancellation, you can prevent SAP R/3 users from deleting output requests
that are sent to the devices of the LOMS. Before implementing this feature, consult both Defining another
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logical output management system, p. 45 and the online documentation about LOMS that is provided
with your SAP R/3 system.

Distributing the callback workload

You can define separate LOMSs to distribute the workload of processing status reports from the InfoPrint
callback daemon. For each LOMS, specify a different R/3 server as the callback target. Before
implementing this feature, consult both Defining another logical output management system, p. 45 and
the online documentation about LOMS that is provided with your SAP R/3 system.

Supporting multiple InfoPrint Manager systems

InfoPrint Manager provides you with the ability to send jobs to multiple InfoPrint systems from the same
SAP system. An InfoPrint Manager system consists of one or more InfoPrint Manager servers residing on
either the same or different machines that are set up to interoperate by sharing the same namespace. If
your print installation is large, with many printers distributed across a wide area and managed by
different InfoPrint Manager systems, this function can help you to manage your installation more
efficiently by defining separate LOMS to send jobs to separate systems.

You can implement this support by using the SAP GUI to add an optional flag with values in the form
host:socket to your InfoPrint Manager OMS commands: ipm_submit, ipm_dev_query, ipm_job_query,
and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the socket for the InfoPrint
server on that host.

Using the procedure described in Defining another logical output management system, p. 45, you can
define a new LOMS for every InfoPrint Manager system to which you want to send jobs. For example,
in the procedure below, you might want to create an LOMS1 and an LOMS2, one for each InfoPrint
Manager system to which you want to send jobs. In Sending jobs to multiple InfoPrint Manager
instances, p. 47, LOMS1 points to the New York system, while LOMS2 points to the London system.
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Sending jobs to multiple InfoPrint Manager instances

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS)
definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Logical
OMS from the Output Management Systems pane to obtain a list of the logical output management
systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the
appropriate LOMS (for example, the LOMS1) and click Commands.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is
running to access the OMS commands.
From the Spool Administration: Operating System Commands (Change) window, you can modify
the OMS commands to switch from one InfoPrint system to another. For example, to change the
ipm_submit command to send jobs to an InfoPrint system that is located in New York (ny1 at socket
6874), you can change the ipm_submit command field as follows:
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Original ipm_submit command

ipm_submit &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' "&T"
"&D" '&t'

Modified ipm_submit command

ipm_submit --cc nnyy11::66887744 &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y'
'&E1' "&T" "&D" '&t'

1) Even though this example shows only changes to the ipm_submit command, make sure that you
make the same change to all InfoPrint Manager OMS commands.

2) Do not make changes to any other part of the commands; these parameters are positional and
must not be modified.

5. Save your changes by clicking the Save (diskette) icon.

If you wanted another set of devices from this same SAP system to send jobs to another InfoPrint system
that is located in London, (lon at socket 6874), you can return to Step 3, access another LOMS on this
SAP system, and proceed to change the ipm_submit command fields for this LOMS as follows:

Original ipm_submit command

ipm_submit &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' "&T"
"&D" '&t'

Modified ipm_submit command

ipm_submit --cc lloonn::66887744 &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y'
'&E1' "&T" "&D" '&t'

As before, remember to save your changes before exiting the Spool Administration: Operating System
Commands (Change) window by clicking on the Save (diskette) icon.

Moving OMS definitions among SAP systems

You can maintain OMS definitions on a single application by replicating your InfoPrint Manager OMS
definitions in other SAP R/3 systems. To make changes to OMS definitions, you can transport the OMS
objects from the maintenance system to your other systems.

If you decide to transport the OMS objects from this maintenance system, you must use only logical
spool servers in these:

• OMS ROMS and LOMS definitions
• InfoPrint Manager Output device definitions

Logical servers allow you to organize your printing architecture and manage printers. By using only
logical spool servers, you will not have to change server names in the OMS definitions after you have
transported them. For more information about Logical servers, see the “Spool Server Definitions:
Classifying Servers, Using Logical Servers, and Using Alternate Servers” topic in your SAP R/3
documentation.

This procedure describes how you can use the R/3 logistics (transport) system to move OMS definitions
between SAP R/3 systems:
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1. From the R/3 main menu, access the Real OMS window by using this path Tools→ CCMS→
and Spool→ Spool Administration or type spad in the ok-Code field.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Real
OMS from the Output Management Systems pane to obtain a list of the real output management
systems (ROMS) available on your installation.

3. From the Spool Administration: List of Real Output Management Systems window, select Change
mode from the ROMS list and double-click ROMS definition that you want to transport.

4. From the Spool Administration: Real Output Management System window, select the appropriate
transport function:

• To transport only the ROMS definition, push the Transport (truck) icon.

• To transport both the ROMS definition and all LOMS definitions that reference it, push the
Transport all (truck) icon to the right.

In either case, a transport request is created for transporting the OMS definition objects to other
R/3 systems.

5. To transport your OMS definitions, type /SE09 in the ok-Code field so you can complete this
task from the R/3 software logistics transport system.

Switching InfoPrint Manager servers

InfoPrint Manager provides you with the ability to switch the InfoPrint server to which your SAP system is
sending commands. This can be a valuable feature to use if a particular InfoPrint command processor
fails and you want to switch to one that is still active, or when switching from an InfoPrint test system to
an InfoPrint production system (as shown in Figure Switching from one InfoPrint Manager server to
another, p. 50). An InfoPrint Manager system consists of one or more InfoPrint Manager servers
residing on either the same or different machines that are set up to interoperate by sharing the same
namespace.

If switching from one InfoPrint Manager system to another, you must make sure that the same logical
destination names have been defined on both systems.

You can implement this support by using the SAP GUI to add an optional flag with values in the form
host:socket to your InfoPrint Manager OMS commands: ipm_submit, ipm_dev_query, ipm_job_query,
and ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the socket for the InfoPrint
server on that host.

Configuring and using the OMS



2

50

Switching from one InfoPrint Manager server to another

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS)
definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Logical
OMS from the Output Management Systems pane to obtain a list of the logical output management
systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the
appropriate LOMS (for example, the IPM001 LOMS) and specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is
running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one InfoPrint server to another.
For example, to change the ipm_submit command to send jobs to the InfoPrint server info1 at
socket 6874, you can change the ipm_submit command field as follows:

Original ipm_submit command
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ipm_submit &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' "&T"
"&D" '&t'

Modified ipm_submit command

ipm_submit --cc iinnffoo11::66887744 &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y'
'&E1' "&T" "&D" '&t'

1) Even though this example only shows changes to the ipm_submit. command, make sure that you
make the same change to all InfoPrint Manager OMS commands.

2) Do not make changes to any other part of the commands; these parameters are positional and
must not be modified.

Failing over to other servers in the same InfoPrint Manager system

InfoPrint Manager provides you with the ability to send jobs to destinations in multiple InfoPrint servers
through any InfoPrint Manager server in that InfoPrint Manager system. An InfoPrint Manager system
consists of one or more InfoPrint Manager servers residing on either the same or different machines that
are set up to interoperate by sharing the same namespace. A distributed installation that uses an
InfoPrint server (pdserver) as a command processor might want to define another pdserver as a backup
command processor to fail over to if the primary command processor goes down so you can continue
to send jobs to the destinations. As shown in Figure Failing over from one InfoPrint Manager server to
another on the same system, p. 52, you might want to specify either the InfoPrint Manager server with
the actual destination or the InfoPrint Manager server with the logical destination as the backup server.

You can implement this support by using the SAP GUI to add an optional flag with values in the form
host:socket to your InfoPrint Manager OMS commands: ipm_submit, ipm_query, ipm_job_query, and
ipm_job_cancel.

host represents the host name where the InfoPrint server is running and socket the socket for the InfoPrint
server on that host.

Before using this function, make sure that you understand that:

• Even though this example only shows changes to the ipm_submit. command, make sure that you
make the same change to all InfoPrint Manager OMS commands.

• Do not make changes to any other part of the commands; these parameters are positional and must
not be modified.

Configuring and using the OMS



2

52

Failing over from one InfoPrint Manager server to another on the same system

To modify the OMS commands from your SAP GUI, use this procedure:

1. From the SAP R/3 graphical user interface, modify the logical output management system (LOMS)
definitions by specifying the spad transaction.

2. From the Spool Administration: Initial Screen window, click Extended admin and select Logical
OMS from the Output Management Systems pane to obtain a list of the logical output management
systems (LOMS) available on your installation.

3. From the Spool Administration: List of Logical Output Management Systems window, select the
appropriate LOMS (for example, the IPM001 LOMS) and specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click the operating system where your SAP system is
running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one InfoPrint server to another.
For example, to change the ipm_submit command to failover to another InfoPrint (pdserver) that is
located in the same InfoPrint Manager system, you can change the ipm_submit command field as
follows:

Original ipm_submit command

ipm_submit &P &F &EI &EG &Es '&O' '&o' '&R' '&f' '&C' '&Y' '&E1' "&T"
"&D" '&t'

Modified ipm_submit command for InfoPrint server failover

ipm_submit --cc ''iinnffoo11::66887744 iinnffoo11::55115577'' &P &F &EI &EG &Es '&O' '&o' '&R'
'&f' '&C' '&Y' '&E1' "&T" "&D" '&t'
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1) Even though this example only shows changes to the ipm_submit command, make sure that you
make the same change to all InfoPrint Manager OMS commands.

2) Do not make changes to any other part of the commands; these parameters are positional and
must not be modified.

Customizing an SAP daemon error log on AIX or Linux

By default, the SAP daemon error logs (SAP Callback) start when you create them. When you create an
SAP Callback daemon, InfoPrint Manager creates an SAP directory (sapcbd.sysname, where sysname
is the SAP application server) under /var/pd for each daemon. Use this procedure to customize the
SAP error log:

Any SAP daemons running on this AIX or Linux server are changed by this customization.

1. Find the sap_error.cfg file from the /usr/lpp/pd/bin directory where the file is installed and
copy it into the /var/pd directory:

cp /usr/lpp/pd/bin/sap_error.cfg /var/pd/sap_error.cfg

If you already customize your SAP daemon error logs, remember to change the name or move
the current sap_error.cfg file in /var/pd so that your customization values can be copied over
into the newer version of the file.

2. Open the copy of the sap_error.cfg file that you created and specify the settings for the log
attributes that you want (as shown in Figure Sample sap_error.cfg file provided by InfoPrint
Manager, p. 53). For example, you can modify the log-backup-number attribute, which allows
you to specify the number of backup logs that InfoPrint saves, including the initial error.log.BAK
file.

Sample sap_error.cfg file provided by InfoPrint Manager

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

When you start an SAP Callback daemon after a shutdown, it backs up the first error log by
creating an error.log.BAK file. With each successive restart, it creates an additional .BAK file,
adding a timestamp as a fourth qualifier. By default, the log-backup-number attribute specifies a
value of 10, meaning that you can have nine back up files with timestamps and the initial .BAK
file. You can reduce this number as low as 1 or increase it as high as 999.
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For a complete list of the error log attributes that you can customize, see the RICOH InfoPrint
Manager: Reference publication.

3. Once you have finished defining your options, save and close the /var/pd/sap_error.cfg file.

If you do not need the customization change to take effect immediately, you can skip the final two
steps and just wait until the next time the SAP daemon is restarted.

4. From an AIX or Linux command line, you must do one of these tasks for the SAP Callback
daemon to shut down so that these customization changes can take effect.

• For the SAP Callback daemon, type stopcbd sysname (where sysname is the three-character
SAP R/3 system name).

5. To restart the SAP Callback daemons:

From an AIX command line:

/etc/rc.iprsap

All SAP daemons restart automatically if you have followed the configuration directions in
Configuring to start callback daemons at system reboot on AIX, p. 37.

From Linux command line:

/etc/rc.iprsap

From the InfoPrint Management Interface:

1. Select the SAP Callback daemons you want to restart.

2. Right-click on it and select Start.

Customizing an SAP callback process error log on Windows

By default, the SAP process error logs start when you create them. Use this procedure to customize the
SAP error log or logs. Note that any SAP processes running on this server are changed by this
customization.

1. Find the sap_error.cfg file in the bin directory that is located under the directory where the file is
installed

2. Copy it into the workspace_path\sap directory.

The workspace_path is specified on theWorkspace path field. From the InfoPrint Manager
Management Console, select Edit→ Service Configuration to verify the setting of the
Workspace path field. For these examples, workspace_path signifies the fully qualified path
where the error log is located, such as C:\Program Files\InfoPrint Manager\var\pd\.

If you already customize your SAP error logs, remember to change the name or move the current
sap_error.cfg file in workspace_path\sap so that your customization values can be copied over
into the newer version of the file.

3. Open a copy of the sap_error.cfg file in the workspace_path\sap directory, and edit it to specify
the settings for the log attributes that you want (as shown in Figure Sample sap_error.cfg file
provided by InfoPrint Manager, p. 55). For example, you can modify the log-backup-number
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attribute, which lets you specify the number of backup logs that InfoPrint saves, including the
initial error.log.BAK file.

Sample sap_error.cfg file provided by InfoPrint Manager

#
# ErrorLog Configuration File
#
# Log size (units = KBytes)
log-size = 1024
# Wrap On?
log-wrap = true
# Severity?
log-severity = debug
# Number of backup log files
log-backup-number = 10

When you start an SAP Callback process after a shutdown of the InfoPrint Manager server, it
backs up the first error log by creating an error.log.BAK file. With each successive restart, it
creates an additional .BAK file, adding a timestamp as a fourth qualifier. By default, the log-
backup-number attribute specifies a value of 10, meaning that you can have nine back up files
with timestamps and the initial .BAK file. You can reduce this number as low as 1 or increase it as
high as 999.

For a complete list of the error log attributes that you can customize, see InfoPrint Manager:
Reference.

4. Once you have finished defining your options, save and close the file.

If you do not need the customization change to take effect immediately, you can skip the final
four steps and just wait until the next time the InfoPrint Manager server is restarted.

5. From the Management Console, you must stop all SAP processes so that these customization
changes can take effect:

1. Start the InfoPrint Manager Management Console.

2. In the Objects view in the left pane of this window, click SAP Callback Processes.

3. Stop all the SAP Callback processes that display in the main view by doing either of these
options on each icon:

• Right click and select Stop SAP Callback.

• Highlight each icon and select these from the menu bar: Actions→ Stop.

6. Once all SAP processes have been shut down, you must stop the SAP services:

1. Click Start→ Settings→ Control Panel→ Services.

2. Highlight SAP Services and click Stop.

7. To restart the SAP Services:

1. Click Start→ Settings→ Control Panel→ Services.

2. Highlight SAP Services and click Start.

8. Once the SAP Services have been restarted, you can restart the SAP Callback processes:
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1. Start the InfoPrint Manager Management Console.

2. In the Objects view in the left pane of this window, click SAP Callback Processes.

3. Restart individual SAP Callback processes that display in the main view by right-clicking on
each icon and selecting Start SAP Callback.

Shutting down the callback daemon on AIX

This procedure describes how you can shut down the SAP callback daemon. This procedure is useful if
you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP
R/3 system it supports is not going to be used for awhile.

From an AIX command line on the system where the SAP callback daemon is currently running, type:

stopcbd systemname

where systemname is your three-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAP callback daemon, remove its entry from the
/etc/rc.iprsap file. If you remove its entry from the file, you do not have to do this task.

To make sure that no SAP callback daemons are restarted automatically whenever the systems they are
running on are restarted, use the InfoPrint SMIT interface: InfoPrint Solutions→ InfoPrint Utilities→
SAP Daemons.

From the SAP Daemons panel, select the Do not start SAP daemons at reboot option.

If you are moving the SAP callback daemon to another system, remember to follow the instructions for
both Starting the SAP callback daemon or process, p. 34 and Configuring to start callback daemons at
system reboot on AIX, p. 37.

Shutting down the callback daemon on Linux

This procedure describes how you can shut down the SAP callback daemon. This procedure is useful if
you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP
R/3 system it supports is not going to be used for awhile.

From a Linux command line on the system where the SAP callback daemon is currently running, type:

stopcbd systemname

where systemname is your three-character SAP R/3 system name.

From the InfoPrint Manager Management Interface:

1. Select the SAP Callback daemon you want to stop.

2. Right-click on it and select Stop.

If you do not want a reboot of the system to restart the SAP callback daemons, remove its entry from the
/etc/rc.iprsap.daemons file. If you remove its entry from the file, you do not have to do this task.

To make sure that no SAP callback daemons are restarted automatically whenever the systems they are
running on are restarted, go to Applications→ InfoPrint Manager→Management Interface→
Options ->Configuration.
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From the Configuration panel, do not check Automatically start SAP Callback daemons during
startup option.

If you are moving the SAP callback daemon to another system, remember to follow the instructions for
both Starting the SAP callback daemon or process, p. 34 and Configuring to start callback daemons at
system reboot on Linux, p. 37.

Shutting down the callback process on Windows

This procedure describes how you can shut down the SAP callback process. This procedure is useful if
you are migrating the SAP callback daemon from one InfoPrint Manager server to another or if the SAP
R/3 system it supports is not going to be used for awhile.

To shut down the SAP callback process on an InfoPrint Manager Windows server, you must access the
SAP Callback Processes from the InfoPrint Manager Management Console.

1. From the Start menu, select Programs→ InfoPrint Manager→Management Console.

2. From the Objects view in the left pane of this window, click on SAP Callback Processes to
switch the main view to SAP Callback Processes.

3. Select the particular SAP Callback Process you want to stop from those shown in the main view.
You can do either one of these options:

• Right-click and select Stop SAP Callback.
• From the menu bar, select Actions→ Stop.

If you are moving the SAP callback process to another system, remember to follow the instructions for
Starting the SAP callback process on Windows, p. 39.

Deleting an SAP callback process on Windows

This procedure describes how you can delete an SAP callback process. This procedure is useful if you
are removing one SAP callback process and replacing it with another, or if the SAP R/3 system it
supports is not going to be used for awhile. If you accidentally created an SAP callback process for the
wrong host or instance ID and you want to remove it from the InfoPrint Manager Management Console
and the InfoPrint Manager namespace, you would use this procedure:

To delete the SAP callback process on an InfoPrint Manager Windows server, you must access the SAP
Callback Processes from the Management Console.

Before deleting a particular SAP callback process, you must first stop it as described in Shutting down
the callback process on Windows, p. 57.

1. From the Start menu, select Programs→InfoPrint Manager→Management Console path.

2. Select the SAP Callback Process object.

3. From here, you can do either one of these actions to remove the process from the system:

• Specify Edit→ Delete→ SAP Callback Process.

• Right-click on the SAP Callback Process object and select Delete.

Configuring and using the OMS
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33.. InfoPrint Manager non-OMS support

•Understanding SAP access method L support
•Installing InfoPrint SAP Client support when SAP runs on HP-UX or Sun Solaris
•Installing the SAP Client when SAP runs on AIX
•Installing the SAP Client when SAP runs on Linux
•Installing the SAP Client when SAP runs on Windows
•Configuring your SAP system to use the InfoPrint Manager Client command

UUnnddeerrssttaannddiinngg SSAAPP aacccceessss mmeetthhoodd LL ssuuppppoorrtt
If you either cannot or choose not to use SAP Output Management System (OMS) support, we
recommend using SAP's local access method L (InfoPrint Manager's ipm_print command) to send jobs to
the InfoPrint Manager server. InfoPrint Manager provides a command-line client interface for SAP to
submit jobs to InfoPrint Manager with job attribute information and to query for jobs to determine when
they have completed.

The InfoPrint Manager ipm_print command provides SAP job information to InfoPrint Manager. For
example, each SAP userid can be used to track a job through the system. The corresponding ipm_query
command allows InfoPrint Manager to provide job status to SAP. A job is not identified as complete until
it actually prints or is deleted from the print queue.

For an alternative method of submitting jobs from non-AIX SAP R/3 or non-Linux SAP R/3 application
servers that provide no feedback to the SAP servers, see Alternate access methods for submitting SAP
jobs to InfoPrint Manager, p. 100.

To use the InfoPrint Manager SAP Transform, you must install the SAP Print Feature and fonts on every
InfoPrint Manager server with actual destinations that transforms either SAP OTF or ABAP data. For
information on installing the SAP Print Feature and fonts on the InfoPrint Manager server, see Installing
the SAP Print Feature on the InfoPrint Manager server, p. 16.

Depending on the platform that your SAP system runs on, see the appropriate chapter from the list
below to install and then see Configuring your SAP system to use the InfoPrint Manager Client
command, p. 66 to configure your SAP system to use InfoPrint Manager's SAP access method L client:

• For installing InfoPrint Manager's client when SAP runs on HP-UX or Sun Solaris servers, see
Installing InfoPrint SAP Client support when SAP runs on HP-UX or Sun Solaris, p. 60.

• For installing InfoPrint Manager's client when SAP runs on AIX servers, see Installing the SAP Client
when SAP runs on AIX, p. 63.

• For installing InfoPrint Manager's client when SAP runs on Linux servers, see Installing the SAP Client
when SAP runs on Linux, p. 64.

• For installing InfoPrint Manager's client when SAP runs on Windows systems, see Installing the SAP
Client when SAP runs on Windows, p. 65.

When you have installed the InfoPrint Manager's client for the appropriate operating system, see
Configuring your SAP system to use the InfoPrint Manager Client command, p. 66 to configure your
SAP system to use the InfoPrint Manager command.

You can also use access method L to send faxes from your SAP system to InfoPrint Manager.
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IInnssttaalllliinngg IInnffooPPrriinntt SSAAPP CClliieenntt ssuuppppoorrtt wwhheenn SSAAPP rruunnss oonn HHPP--UUXX
oorr SSuunn SSoollaarriiss
SAP R/3 installations that run on HP-UX or Sun Solaris systems work with InfoPrint Manager when these
installations are configured to invoke commands remotely on the InfoPrint server.

To use the access method L support of the SAP Print feature of InfoPrint Manager with an SAP R/3
system running on a non-AIX UNIX or non-Linux system, you must do these tasks:

1. Configuring the InfoPrint Manager server, p. 60

2. Configuring the SAP system server, p. 62

Configuring the InfoPrint Manager server

Follow the appropriate procedure depending on which version of InfoPrint Manager you are using:

• Configuring the InfoPrint Manager Windows server, p. 60
• Configuring the InfoPrint Manager AIX or Linux server, p. 61

Configuring the InfoPrint Manager Windows server

The rshd and rexecd services are prerequisites for HP-UX and Sun Solaris SAP client support.

Use this procedure to configure the Windows server that has already installed InfoPrint Manager with
the SAP Print Feature:

1. Install both an rshd and rexecd service on your InfoPrint Manager Windows server.

During the installation of these services, make sure that remote users are defined users on the
InfoPrint Manager for Windows system so that it is possible to write to this server from the
Windows SAP client system.

2. From the Start menu, access the Programs→ Administrative Tools→ User Manager path.

3. Create a new user named sapuser.

This user does not have to be part of any special groups.

4. Authorize the sapuser userid to issue remote commands by adding this entry to the .rhosts or
equivalent file: +sapuser.

5. Authorize all remote servers running the SAP R/3 applications to specify remote commands on
the InfoPrint Manager Windows server by specifying:

fully_qualified_server_name +

where fully_qualified_server_name is either the IP address (in dotted decimal format) or the host
name of the server.

3 InfoPrint Manager non-OMS support
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1. If you use a host name, TCP/IP must be able to resolve that name through either the security
file or through a Domain Name Server (DNS).

2. If a DNS is not being used, but the host name is specified in the hosts file, specify the fully
qualified name in the .rhosts or equivalent file.

3. If a DNS is not being used, and the host name is not specified in the hosts file, you must
specify an IP address in the .rhosts or equivalent file (for example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create separate Windows users
for each SAP system or SAP R/3 application server. Repeat Steps 2 through 5 to create new user IDs
that you can map to each SAP application server from which you plan to use InfoPrint Manager to print.

Turning off GOCA support on a Windows server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an
AFP data architecture used to represent pictures generated by computer. If your installation uses older
printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features,
such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager Windows server, access the
ipmcfg file from the directory where you installed InfoPrint Manager. When you click this file, it displays
the IPM Server Settings dialog. From here, you can click the IPM GOCA Support check box to remove
the check.

You can also turn off this support at a later date, as described in Adding box shading values to printed
output, p. 92.

Configuring the InfoPrint Manager AIX or Linux server

Use this procedure to configure the AIX or Linux server that has already installed InfoPrint Manager with
the SAP Print Feature.

1. Add a user called sapuser. This user does not have to be part of any special groups.

2. Authorize the sapuser userid to issue remote commands by adding this entry to the /etc/hosts.
equiv file:

+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote commands on the
InfoPrint Manager AIX or InfoPrint Manager Linux server as sapuser by doing this procedure:

1. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.

2. Edit the .rhosts file and add a line for each non-AIX or non-Linux server running an SAP R/3
application with a plus (+) sign appended to it.

For added accountability among SAP systems and print jobs, you can create separate AIX or Linux
users for each SAP system or SAP R/3 application server. Follow the three steps specified in this topic to
create additional users (like sapuser) that you can map to each application server from which you will
be using InfoPrint Manager to print.

Installing InfoPrint SAP Client support when SAP runs on HP-UX or Sun Solaris
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For more information about using the rsh and rcp commands to connect to the InfoPrint Manager AIX or
InfoPrint Manager Linux server and send files between servers, see your AIX Operating System or Linux
Operating System documentation.

Turning off GOCA support on an AIX or Linux server

By default, the SAP client requests Graphics Object Content Architecture (GOCA) support. GOCA is an
AFP data architecture used to represent pictures generated by computer. If your installation uses older
printers (for example, 3900 printers as opposed to InfoPrint 4000 printers), GOCA support can cause
the printers to print at less than rated speed. If your applications do not require GOCA support features,
such as box shading, you might want to improve performance by turning off the GOCA support.

If your HP-UX or Sun Solaris client is connected to an InfoPrint Manager AIX or InfoPrint Manager Linux
server, go to the AIX or Linux server and use this procedure:

1. Access the ipm_print file that reside in the /usr/lpp/pd/bin directory.

2. Using your AIX or Linux editor of choice, comment out the othertoptions="other-transform-
options='-g'"; line by placing a hash mark (#) in front of the line.

You can also turn off this support at a later date, as described in Adding box shading values to printed
output, p. 92.

Configuring the SAP system server

To allow SAP HP-UX or Sun Solaris to issue the InfoPrint Manager commands, you must install the
InfoPrint Manager SAP Client on every SAP server where an SAP application server will issue the
commands. This includes every application server with a spool work process (SWP) managing R/3
devices that have been configured to use access method L. If you have configured your SAP R/3 system
to use alternate servers, you must repeat these installation tasks on the alternate servers as well.

Use this procedure to configure remote servers (HP-UX or Sun) running the SAP R/3 application so you
can print with InfoPrint Manager:

1. Obtain access to each HP-UX or Sun Solaris server running SAP R/3 and log on.

2. Verify that you can ping the InfoPrint Manager server by host name:

ping -c 3 hostname

where hostname is the unqualified name for the InfoPrint Manager server, such as nwser.

If the response shows that a good communication path exists, you will see this:

----tcpip_addr PING Statistics----
packets transmitted, 3 packets received, 0% packet loss
round-trip min/avg/max = 7/7/7 ms

3. Create a directory named /usr/lpp/pd/bin:

mkdir /usr/lpp/pd/bin

4. Use the FTP client of your choice to copy these files from the InfoPrint Manager server to an SAP
R/3 application server in your configuration. If you are using an InfoPrint Manager AIX or
InfoPrint Manager Linux server, these files reside in the /usr/lpp/pd/bin directory. If you are
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using an InfoPrint Manager for Windows server, these files reside in the install_path\bin
folder:

• ipm_print.sys
• ipm_query.sys

For the secondary qualifier (sys), specify the name of the system where your SAP applications are
running, hp for HP-UX or sun for Sun Solaris.

5. Make sure that each file copied in Step 5 is executable.

6. On the SAP application server in your installation, edit both files so they specify the name of the
user (sapuser) and host name where InfoPrint Manager is running. If you want the SAP Client for
HP-UX or Sun Solaris to use the secure shell (SSH) and secure copy (SCP) commands, you must
edit these files so that they specify the secure shell commands. The default behavior of the SAP
Clients is to use the remote shell commands (RSH).

To use the secure shell commands, you must change the value rsh to ssh:

# change the line below from "rsh" to "ssh" for secure shell
remote_shell="rsh"

7. Copy the edited SAP command files to any other SAP application servers in your installation that
use the InfoPrint Manager server.

Once you have completed this procedure, follow the directions for updating the SAP Profile to activate
the SAP Print command and define SAP devices that use access method L in Configuring your SAP
system to use the InfoPrint Manager Client command, p. 66.

IInnssttaalllliinngg tthhee SSAAPP CClliieenntt wwhheenn SSAAPP rruunnss oonn AAIIXX
To allow SAP to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP
client on every SAP server where an SAP application server will issue the commands. This includes every
application server with an SWP managing R/3 devices that have been configured to use access
method L for sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to use
alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the SAP client for AIX on your SAP application servers, use this procedure:

1. Log into the AIX system as root.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into the DVD-ROM reader.

3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you can open a terminal window by
clicking on the terminal icon contained in the front panel. (The front panel is the task bar that
appears at the bottom of the screen.) By default, the terminal icon is contained in a pop-up menu
above the text editor icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:

1. Type this on the command line:

smit cdrfs

2. Select Add a CDROM File System from the list of choices presented.

3. Click the List button and select your DVD-ROM device name (cd0, for example).

4. Type this in theMOUNT POINT field:

Installing the SAP Client when SAP runs on AIX
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/cdrom

5. Click OK. The running person will raise his arms to indicate success. If he instead falls down
and you see crfs: 0506-909 /cdrom file system already exists, do not interpret this
as a failure. (The existing /cdrom file system should be usable.)

6. Press the F12 key to exit SMIT.

5. Type this on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by specifying setup —x.

During the course of the install, you are prompted to specify values for both PDHOST and PD_
SOCKET.

1. The SAP Client package cannot be installed if other ipr* filesets reside on an SAP application
server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications do
not require GOCA support features, such as box shading, you might want to improve performance
by turning off the GOCA support. For instructions on turning off this support after installing the SAP
Client, see Adding box shading values to printed output, p. 92.

Once you have completed this procedure, follow the directions for updating the SAP profile to activate
the SAP Print Command and define SAP devices that use access method L in Configuring your SAP
system to use the InfoPrint Manager Client command, p. 66.

IInnssttaalllliinngg tthhee SSAAPP CClliieenntt wwhheenn SSAAPP rruunnss oonn LLiinnuuxx
To allow SAP to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP
Client on every SAP server where an SAP application server will issue the commands. This includes
every application server with an SWP managing R/3 devices that have been configured to use access
method L for sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to use
alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the SAP Client for Linux on your SAP application servers, use this procedure:

1. Log into the Linux system as root.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642, into the drive.

3. Open a terminal window.

4. The first time you run the Installer, follow this procedure:

1. If you are installing from the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642:

1) Insert the DVD-ROM into the drive.

2) Mount the file system by typing:

mount /dev/cdrom <mount_point>

3) Type:

cd <mount_point>/linux/x86_64

3 InfoPrint Manager non-OMS support
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4) Install the Linux SAP Client package (64–bit) by typing:

rpm -ivh ipr-client-sap.4.12.m-n.x86_64.rpm

where m and n represent the service update level.

5) If you are upgrading the InfoPrint Manager: Linux SAP Client from a previous version,
you need to run:

rpm -Uvh ipr-client-sap.4.12.m-n.x86_64.rpm

where m and n represent the service update level.

After the upgrade is complete, you must log off and then log in again.

6) Unmount <mount_point> file system.

7) Remove the Common Client DVD-ROM.

2. Test the system:

1) Log off and log back on to pickup the changes.

2) Issue one of the commands, followed by the -h flag to display the syntax of that
command and verify the installation.

For example:

pdls -h

1. The SAP Client package cannot be installed if other ipr-client-sap.* rpm package reside on an
SAP application server.

2. If your installation uses older printers (for example, 4000 printers instead of InfoPrint 4100 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications do
not require GOCA support features, such as box shading, you might want to improve performance
by turning off the GOCA support. For instructions on turning off this support after installing the SAP
Client, see Adding box shading values to printed output, p. 92.

Once you have completed this procedure, follow the directions for updating the SAP profile to activate
the SAP Print Command and define SAP devices that use access method L in Configuring your SAP
system to use the InfoPrint Manager Client command, p. 66.

IInnssttaalllliinngg tthhee SSAAPP CClliieenntt wwhheenn SSAAPP rruunnss oonn WWiinnddoowwss
To allow SAP to issue the InfoPrint Manager commands, you must install the InfoPrint Manager SAP
client on every SAP server where an SAP application server will issue the commands. This includes every
application server with an SWP managing R/3 devices that have been configured to use access
method L for sending jobs to InfoPrint Manager. If you have configured your SAP R/3 system to use
alternate servers, you must repeat these installation tasks on the alternate servers as well.

To install the InfoPrint Manager SAP Client for Windows on your Windows SAP system, use this
procedure:

1. Log in as the Administrator user.

2. Insert the InfoPrint Manager: Common Clients DVD-ROM, LCD4-5642 into your DVD-ROM drive.

3. From the InfoPrint Manager: Common Clients window, click Install InfoPrint Manager Products.

Installing the SAP Client when SAP runs on Windows
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4. Click on InfoPrint Manager SAP Clients.

5. Select a location for installing the clients (the default is install_path \Infoprint Manager SAP Clients\).

6. From the IPM Server Settings pop-up dialog, specify either the fully qualified host name or the IP
address of the InfoPrint Manager server to which you will be sending jobs. The IPM Hostname field
defaults to showing the loop back address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to change.

1) Do not check the IPM Debug Mode checkbox unless instructed to do so by technical support.

2) Enable the IPM LDAP Mode if you are using the InfoPrint Manager Pull Print feature with your
InfoPrint Manager server. For more information, see Enabling LDAP mode, p. 89.

3) Remove the check in the IPM GOCA Support checkbox only if you want to turn off graphics
object content architecture (GOCA support) in the SAP transform.
By default, the SAP client requests Graphics Object Content Architecture (GOCA) support.
GOCA is an AFP data architecture used to represent pictures generated by computer. If your
installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers),
the GOCA support can cause the printers to print at less than rated speed. If your applications
do not require GOCA support features, such as box shading, you might want to improve
performance by turning off the GOCA support. For instructions on turning off this support after
installing the SAP Client, see Adding box shading values to printed output, p. 92.

Once you have set the appropriate values, click OK to close this dialog.

7. When the SAP client has been installed, click Finish.

8. To exit the install process, click Back, and then the Exit button on the next screen.

9. To complete the configuration, follow the directions for updating the SAP Profile to activate the SAP
print command and define SAP devices that use access method L as described in Configuring your
SAP system to use the InfoPrint Manager Client command, p. 66.

CCoonnffiigguurriinngg yyoouurr SSAAPP ssyysstteemm ttoo uussee tthhee IInnffooPPrriinntt MMaannaaggeerr CClliieenntt
ccoommmmaanndd
SAP R/3 systems work best with InfoPrint Manager when these installations are configured to use our
ipm_print command.

The InfoPrint Manager ipm_print command provides SAP job information to InfoPrint Manager. For
example, each SAP userid can be used to track a job through the system. The corresponding ipm_query
command allows InfoPrint Manager to provide job status to SAP. A job is not identified as complete until
it actually prints or is deleted from the print queue.

Use the Modifying the print profile for SAP , p. 66 before Defining SAP devices to send jobs to InfoPrint
Manager, p. 68.

Modifying the print profile for SAP

To print with access method L from an SAP server, you must edit the print profile on your SAP
application server. From your SAP R/3 graphical user interface, use this procedure:

3 InfoPrint Manager non-OMS support
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1. Enter RZ10 in the OK-Code field to access the Edit Profiles window.

2. Select the Extended maintenance radio button and click Change to access the Maintain R/3
Profile print_profile window.

3. In the appropriate fields, specify these values, and click Check in the upper left corner to save the
values. You will return to the screen two more times to add rspo/host_spool/query, and rspo/host_
spool/answer_format values:

Parameter name:

rspo/host_spool/print

Parameter val:

ipm_print -P &P -F &F -O '&O' -o '&o' -R '&R' -C &C -Y '&Y' -T "&T" -D
"&D" -t '&t'

Parameter name:

rspo/host_spool/query

Parameter val:

rspo/host_spool/query=ipm_query -P&P

Parameter name:

rspo/host_spool/answer_format

Parameter val:

rspo/host_spool/answer_format=lpstat

For the rspo/host_spool/print values, some parameters are in single quotation marks ('&o') and
some are in double quotation marks ("&T").

4. Specify the Check icon in the upper left corner to save this data.
The SAP system responds by providing a display that demonstrates how this print profile has been
changed. Note the two highlighted sections to see the ipm_print and ipm_query SAP clients:

Active parameters list display from changed print profile

0/12/2001 Active parameters 14:33:04
Parameter name Parameter value

rspo/host_spool/query ipm_query -P &P
rspo/host_spool/print ipm_print -P &P -F &F -O "&O" -o "&o" -R "&R" -C
&C -T "&T"
eu/iwb/server_win32 hrmsds1.jones.s10.ca.us
eu/iwb/server_mac hrmsds1.jones.s10.ca.us
eu/iwb/path_mac zdummy
login/system_client 400
SAPLOCALHOST hrmssbx
eu/iwb/path_win32 saphelp\helpdata
:

5. Once you have completed steps 4 and 5 three times to enter all the appropriate values, you must
save these print profile changes. To save these print profile changes, be sure you check yes for the
dialog box about the parameter change.

Configuring your SAP system to use the InfoPrint Manager Client command
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6. Then make sure that you click yes for the dialog box about the profile change.

If you neglect to specify yes for both dialog boxes, the SAP system might not save your changes.
Once you verify these changes to the print profile, SAP R/3 might display this message, which you
can ignore:

7. Once you have notified the other SAP R/3 application users, click Save and restart (bounce) the
R/3 application servers.

Once you have completed these procedures, you can create devices to print from your SAP R/3
system, using InfoPrint Manager to drive the printers. Use the procedure for Defining SAP devices to
send jobs to InfoPrint Manager, p. 68.

Defining SAP devices to send jobs to InfoPrint Manager

This section describes how to create a new output device for printing to InfoPrint Manager. To enable
this support, an SAP R/3 administrator must do this procedure from the SAP R/3 graphical user
interface:

1. Make sure that you have a logical destination defined in InfoPrint Manager, which will send jobs
to your physical printer device.

2. From the R/3 main menu, access the Spool Administration window by clicking the Tools main
menu and then selecting the Tools→ Administration→ Spool→ Spool Administration path.
or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and click Change

4. Click Create and fill in this information about the Create Output Device window:

DDeevviicceess tthhaatt uussee tthhee IInnffooPPrriinntt MMaannaaggeerr OOMMSS

Field Explanation Example value

Output device Type the name that R/3 users
will need to access the printer.

PRT1

Device type Select the device type that has
been defined in the R/3
system for the printer model.
POSTSCPT applies to any
PostScript printer, while HPLJ4
applies to a Hewlett-Packard
LaserJet 4 printer. SAPGOF
sends both OTF and ABAP
data to be transformed into
AFP by the InfoPrint Manager
SAP Transform.

POSTSCPT

Spool server Select the name of the R/3
application server which will
be the SAP R/3 spool server

us01d2_P40_41
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Field Explanation Example value

(spool work process) that
processes requests for this
device.

Host printer Type the name of the InfoPrint
Manager logical printer.

prt1-lp

Device class Enter a space so that this field
accepts the default value of
printer, which is P.

Access method in host
spool

Select the method that the
spool work process uses to
pass data to the host spool
system.

L

5. From the menu bar, click Back and the system will prompt you to save the new output device.

If your logical destination does not receive a job sent from your SAP device, delete and recreate
the SAP callback daemon with the same settings on the InfoPrint Manager server.

Configuring your SAP system to use the InfoPrint Manager Client command
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44.. Customizing your print environment

•Print support that applies to InfoPrint Manager AIX and Windows servers
•Using bar codes with SAP R/3
•Alternate access methods for submitting SAP jobs to InfoPrint Manager

PPrriinntt ssuuppppoorrtt tthhaatt aapppplliieess ttoo IInnffooPPrriinntt MMaannaaggeerr AAIIXX aanndd
WWiinnddoowwss sseerrvveerrss
These sections describe SAP R/3 features that can be used by installations running SAP R/3 Release 4
and later with InfoPrint Manager for AIX or InfoPrint Manager for Windows. All interfaces apply to AIX
and Windows platforms unless clearly identified with a particular operating system.

Customizing print characteristics

These sections describe how you can change output appearance when printing through InfoPrint
Manager by modifying SAP devices and formats.

How InfoPrint processes code pages from ABAP and OTF jobs

Code page support for OTF jobs is more flexible than for ABAP jobs.

Because OTF jobs request a specific font, the SAP transform compares the specified font name and
point size values with the entries in the fonts.tab configuration file. If the transform finds a match, it uses
both the AFP character set and AFP code page for the print job.

ABAP jobs can use different character sets, but are confined to using the same code page. When
processing ABAP files, the SAP transform uses:

• The defcp.tab file to map single-byte ASCII code points to EBCDIC code points before calling the
uconv utility.

• The pagedef.tab file to match the Paper parameter value with the PJPAPER or PJFORM (depending
on the SAP/R3 version used) parameter value in the ABAP print job.
Once they are matched, the SAP transform uses the FontNorm and FontBold parameters on the
selected line in the pagedef.tab file to determine which character sets to use in both normal and
bold mode.

For ABAP jobs that are processed using Unicode, the FontNorm and FontBold fields are ignored,
because the Unicode fonts are mapped in the page definition.

As a result, all ABAP jobs sent to a particular InfoPrint server use the same code page, but potentially
different character sets, depending upon the PJPAPER value specified in the job.

Defining a customized device type

An SAP device type is a collection of table entries that you can access and modify online to describe the
fonts, the printer driver to use to create the data, and the formats that can be used for SAPscript printing.
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Every output device must have a device type that is used to process the output document. An actual
destination can have many output devices, with different device types for each one.

For basic printing, the SAP transform can use existing device types (such as SAPGOF) and existing
formats, such as LETTER or X_65_255. However, if you plan on customizing any of these print
characteristics, you should create a customized device type so that you will not loose data when you
upgrade your SAP R/3 system.

To create a customized device type, an SAP R/3 administrator must do this procedure from the SAP R/
3 graphical user interface:

1. From the R/3 main menu, access the Spool Administration window by selecting Tools main menu
and then selecting the Tools→ Administration→ Spool→ Spool Administration path or
typing /nSPAD in the ok-Code field.

2. From the Spool Administration window, select Utilities→ Copy device type pull-down option.

3. From the Copy Device Type window, specify the device type you want to customize (in this case,
SAPGOF) in the Copy device type field and provide a name for your customized Device Type (in
this case, ZDOCGOF) in the to device type field.

Any customized Device Type must start with the Z character or it will be overwritten when you
upgrade to a new level of SAP R/3.

4. From the menu bar, click Execute.

5. From the Create Object Catalog Entry window, decide whether you want to be able to copy this
customized device type to another SAP system. If you do, specify a Development class field
value.

If you do not need to copy this Device Type to another SAP system, click Local object:

6. Click Save.

SAP R/3 provides a screen to show the customized Device Type and the original device type from
which it was copied.

Changing document print orientation

The sap2afp transform lets you enhance the quality of your printing from an SAP R/3 enterprise through
the use of form definitions. Form definitions allow you to use electronic overlays and specify both media
orientation (how the page is printed) and bin selection. The sap2afp transform defines which form
definition should be used for printing through the use of Formats. Every spool job in R/3 requires a
Format (Paper type), whether it is ABAP data (X_65_80) or OTF data (LETTER). SAP R/3 formats are
mapped to Advanced Function Presentation (AFP) form definitions in the pagedef.tab configuration file.
You can display the Format of a spool request in the output controller (SP01).

By default, the sap2afp transform uses F1SAP form definition, p. 76, which by default defines duplex,
portrait printing. In addition, InfoPrint Manager provides an assortment of form definitions, which are
documented in RICOH InfoPrint Manager: Reference. Consult this list to find a form definition that meets
your printing needs.

This section describes how to specify landscape media orientation through a form definition for an entire
document and then connect the newly-created format to a device type. By mapping an SAP Format to a
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form definition in the pagedef.tab file, you can define the media style for the entire job. Depending
upon the type of data you wish to print, there are two separate procedures:

• Defining a customized device type for ABAP jobs, p. 73
• Defining a new OTF format, p. 73

Defining a customized device type for ABAP jobs

If you are printing Advanced Business Application Programming (ABAP) jobs, you must create a blank
ABAP Format in the SAP system by using this procedure:

1. From the R/3 main menu, access the Spool Administration window by selecting the Tools main
menu and then selecting Tools→ Administration→ Spool→ Spool Administration path, or
typing /nSPAD in the ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Formats option and click
Change.

3. From the Spool Administration: Format window, select an existing Format (in this case, X_65_255)
from which to copy.

All ABAP system formats follow the naming convention of X_number-of-rows_number-of-columns.

4. From the Spool Administration: Copy Format from X_65_255 window, specify the name of your
customized Format with the naming convention of Z_number-of-rows_number-of-columns_more-
identifying-text.

5. Click the back icon (the left-pointing arrow) and the system prompts you to save the new ABAP
format.

Once you have saved the new ABAP format, you must use Connecting a new format to a device type ,
p. 74 .

Defining a new OTF format

If you are printing Output Text Format (OTF) jobs, you must create page format with the same name as
the customized format you plan to apply:

1. From the R/3 main menu, access the Spool Administration window by selecting the Tools main
menu and then selecting the Tools→ Administration→ Spool→ Spool Administration path.
or typing the /nSPAD transaction in the ok-Code field.

2. From the Spool Administration: Initial Screen window, select the Page formats option and click
Change.

3. Select the page format that you want to copy (in this case, LETTER) and click copy from.

4. From the Spool Administration: Copy Page Format from LETTER window, specify the name of the
customized paper type that you are creating (in this case, ZLETDOC).

5. Select the back icon (the left-pointing arrow) and the system prompts you to save the new page
format.

6. Specify /nSPAD in the ok-Code field.

7. From the Spool Administration: Initial Screen window, select the Formats option and click
Change.

8. Select the Format that you wish to copy (in this case, ZLETDOC), and click Copy from
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9. From the Spool Administration: Copy Format from LETTER window, fill in the values as displayed
in Spool Administration: Copy Format from LETTER window, p. 74:

Spool Administration: Copy Format from LETTER window

10. Click the Back icon (the left-pointing arrow) and the system prompts you to save the new OTF
format.

Once you have saved the new OTF format, you must use Connecting a new format to a device type , p.
74.

Connecting a new format to a device type

To use the format you created, you must connect the format to a device type by doing these steps:

1. From the R/3 main menu, access the Spool Administration window by selecting the Tools main
menu and then selecting the Tools→ Administration→ Spool→ Spool Administration path.
or typing /nSPAD in the ok-Code field.
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2. From the Spool Administration: Initial Screen window, select the Device formats option and click
Change.

3. From the Spool Administration: Choose Format for Device Type window, specify the Device Type
(link to creating custom device types) and your customized Format name (in this case, Z_65_255_
DOC or ZLETDOC) in the appropriate fields.

All ABAP customized user Formats follow the naming convention of Z_number-of-rows_number-of-
columns_descriptive-text.

4. Click Execute.

5. From the Maintain Format for Device Type window, the blank left column indicates that the
customized format has not yet been initialized.

6. Click Copy format.

7. From the Spool Administration: Copy Format window, you can see that the system has filled in the
information from the Maintain Format for Device Type window.

8. Press the Copy from button to initialize your new Format.

9. Click the back icon (the left-pointing arrow) and the system prompts you to save the new format.

10. Access the pagedef.tab configuration file that is located in the /usr/lpp/psf/sap2afp directory
on an InfoPrint Manager AIX or InfoPrint Manager Linux server and the install_path\sap2afp
folder on an InfoPrint Manager Windows server.

11. In the pagedef.tab configuration file, create a new entry for the format that you just created. If
you are printing landscape, specify F1C10011 as the form definition value.

All fields must be specified in pagedef.tab. However, for OTF printing, only the form definition
value is used, while ABAP printing uses all values.

12. Exit and save the pagedef.tab configuration file.

Changing page print orientation

The sap2afp transform lets you enhance the quality of your printing from an SAP R/3 enterprise through
the use of form definitions. Form definitions allow you to use electronic overlays and specify both media
orientation (how the page is printed) and bin selection. A form definition can consist of multiple copy
groups, which are also known as media maps.

This procedure shows how you can define a name for each defined page in an existing Layout Set. If
you do not need to change page orientation on a page-by-page basis, see Changing document print
orientation, p. 72. Page-by-page mapping is necessary only if different pages in a document are
formatted differently. You should use a custom layout set when making these changes. If you use a
system Layout Set, your changes are overwritten each time you upgrade your SAP R/3 system.
Remember that each media map remains in effect until SAP R/3 encounters a new media map.

Every spool job in R/3 requires a format (Paper type), whether it is ABAP data (X_65_80) or OTF data
(LETTER). SAP R/3 formats are mapped to Advanced Function Presentation (AFP) form definitions in the
pagedef.tab configuration file. You can display the format of a spool request in the output controller
(SP01).
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When mapping an SAP Format to a form definition in the pagedef.tab file, the first media map in the
form definition defines the media style for the entire job. If you have a job that contains different
electronic overlays on each page, you might have to switch media styles on each page. The sap2afp
transform converts names defined in SAP Layout Sets in the paper resources for pages to AFP media
map names. For each page that defines a paper resource, the sap2afp transform uses the AFP media
map.

By default, the sap2afp transform uses F1SAP form definition, p. 76, which contains 25 separate media
maps for simplex printing, duplex printing, bin selection, and page orientation. In addition, InfoPrint
Manager provides an assortment of form definitions, which are described in RICOH InfoPrint Manager:
Reference.

Use this procedure on your SAP application server to modify the media map on any page of a job by
specifying the media map defined in the F1SAP form definition for the Resource name field:

1. From the SAP R/3 graphical user interface, access the Layout Set menu screen.

You can access this view from the SAP R/3 main menu by either specifying the SE71 transaction
code in the ok-Code field, or by selecting: Tools→Word Processing→ Layout Set

In SAP R/3 Release 4.12, the Layout Set menu is the Page menu, which contains the Resource
Name field cited in step 3.

2. From the Layout Set main menu, access the Change Pages option and select the job for which
you are changing page orientation (in this case, ZASORDER1).

3. From the first page of the job, double-click so that it is highlighted and fill in the Resource Name
field (under the Print Attributes pane).

4. Double-click the next page that you intend to modify and fill in the Resource Name field on the
second page.

5. Continue with the same procedure on any page where you want to specify a new media style.

6. Once you have finished, click Save (open folder) to save this setting.

F1SAP form definition

The form definition specified in the pagedef.tab configuration file is the default submitted with every
Advanced Function Presentation (AFP) data stream document. F1SAP is the default form definition that
each of the media maps references. Table F1SAP Form Definition Values, p. 76 briefly describes the
media maps contained in this form definition.

The print direction is across and the Page Position in inches from the edge of the paper is
0.165,0.165 for all 25 media maps.

FF11SSAAPP FFoorrmm DDeeffiinniittiioonn VVaalluueess

Media map Bin Sides Presentation mode

F1A10111 1 2 Portrait

S100000P 1 1 Portrait
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Media map Bin Sides Presentation mode

S200000P 2 1 Portrait

S300000P 3 1 Portrait

S400000P 4 1 Portrait

D100000P 1 2 Portrait

D200000P 2 2 Portrait

D300000P 3 2 Portrait

D400000P 4 2 Portrait

T100000P 1 2 (Tumble) Portrait

T200000P 2 2 (Tumble) Portrait

T300000P 3 2 (Tumble) Portrait

T400000P 4 2 (Tumble) Portrait

S100000L 1 1 Landscape

S200000L 2 1 Landscape

S300000L 3 1 Landscape

S400000L 4 1 Landscape

D100000L 1 2 Landscape

D200000L 2 2 Landscape

D300000L 3 2 Landscape

D400000L 4 2 Landscape

T100000L 1 2 (Tumble) Landscape

T200000L 2 2 (Tumble) Landscape

T300000L 3 2 (Tumble) Landscape

T400000L 4 2 (Tumble) Landscape

Enabling non-Latin character sets

The sap2afp transform supports the use of these non-Latin character sets on both the AIX, Linux, and
Windows operating systems:

• Japanese (Shift-JIS encoding)
• Korean
• Simplified Chinese
• Traditional Chinese
• Cyrillic
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All are multi-byte character sets (MBCS) except Cyrillic, which is single-byte.

The sap2afp transform supports these character sets through the use of the uconv utility. To use this
support, you must run the SAPGOF (or a compatible) device type on an SAP R/3 system at Release
4.0A or higher.

Before doing these configuration tasks on AIX, Linux, and Windows systems, you must first obtain and
install the selected AFP fonts that are required for printing.

• ABAP data requires raster fonts.

• OTF data can be printed with either raster or outline fonts.

You can obtain these resources from either of these product DVD-ROMs:

• InfoPrint Font Collection: AFP Outline Fonts, LCD4-5683-02 (DVD). This DVD includes AFP Outline
fonts, CID fonts, and Type1 fonts. For more information about purchasing this product, see either
your sales representative or access the RICOH InfoPrint Font Collection home page.

• Infoprint Font Collection: AFP Raster Fonts, LCD4-5700-02 (DVD). This DVD includes AFP Raster fonts.
This product includes outline fonts only. For more information about purchasing this product, see
either your sales representative or access the RICOH InfoPrint Font Collection home page.

When you have installed these fonts, make sure that your actual destination uses the /usr/lpp/psf/
fontlib directory as its primary search path for fonts. To modify the font search path from the InfoPrint
Manager Administration GUI:

1. From the InfoPrint Manager Administration Servers window, highlight the actual destination.

2. Right-click and select Properties from the pop-up menu.

3. From the printer properties window, select the AFP Resources tab and specify

• /usr/lpp/psf/fontlib in the Location of fonts field on InfoPrint Manager for AIX or
InfoPrint Manager for Linux

• install_path\fontlib in the Location of fonts field on InfoPrint Manager for Windows

Enabling non-Latin character sets on an InfoPrint Manager AIX or InfoPrint
Manager Linux server

To support the printing of box characters, these customized conversion files are provided with the
sap2afp transform:

• For Japanese:
IBM-939-SAP2AFP, which extends the IBM-939 conversion file

• For Simplified Chinese:
IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file

• For Traditional Chinese:
IBM-937-SAP2AFP, which extends the IBM-937 conversion file

• For Korean:
IBM-933-SAP2AFP, which extends the IBM-933 conversion file
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In addition, InfoPrint provides these Korean resources in the /usr/lpp/psf/sap2afp/koreanfonts
directory:

• C0H0GW72.240 (dpi Korean Gothic character sets)
• C0H0GW96.240 (dpi Korean Gothic character sets)
• C0H0MW72.240 (dpi Korean Myengjo character sets)
• C0H0MW96.240 (dpi Korean Myengjo character sets)
• T1H01150 (Korean code page)
With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets at either 7.2 point
size or 9.6 point size, you can print with both box characters and the check box on and off characters.

InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP, in the /usr/lpp/
psf/sap2afp/cyrillic directory. It also provides page definitions modified for Cyrillic support,
P1CYR182 and P1CYR683, in the /usr/lpp/psf/sap2afp/cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager AIX or InfoPrint Manager Linux server,
an administrator must do this procedure:

1. Obtain and install the fonts required for printing the script that you want to support.

2. Create backup copies of these current files:

Script Files
Cyrillic /usr/lpp/psf/fontlib/T1001172.CDP

/usr/lpp/psf/reslib/P1CYR182

/usr/lpp/psf/reslib/P1CYR683

3. Copy these files:

Script Source file Target file or directory

Korean All files in /sap2afp/koreanfonts /usr/lpp/psf/fontlib

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/T1001172.
CDP

/usr/lpp/psf/fontlib/
T1001172.CDP

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/P1CYR182 /usr/lpp/psf/reslib/P1CYR182

Cyrillic /usr/lpp/psf/sap2afp/cyrillic/P1CYR683 /usr/lpp/psf/reslib/P1CYR683

4. Enter the script name in the userenv file at this location /usr/lpp/psf/sap2afp/.

The possible script names are:

• japanese for Japanese

• spchinese for Korean

• tdchinese for Simplified Chinese

• korean for Traditional Chinese

• cyrillic for Cyrillic
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Each of these specified script names enable the transform to use the defcp.tab.language and
pagedef.tab.language files corresponding to that language.

When you have completed this procedure, you can modify the pagedef.tab.language or fonts.tab to
specify a different set of fonts. Both these files reside in the /usr/lpp/psf/sap2afp directory.

Enabling non-Latin character sets on an InfoPrint Manager Windows server

To support the printing of box characters, these customized conversion files are provided with the
sap2afp transform:

• For Japanese:
IBM-939-SAP2AFP, which extends the IBM-939 conversion file

• For Simplified Chinese:
IBM-1388-SAP2AFP, which extends the IBM-1388 conversion file

• For Traditional Chinese:
IBM-937-SAP2AFP, which extends the IBM-937 conversion file

• For Korean:
IBM-933-SAP2AFP, which extends the IBM-933 conversion file

In addition, InfoPrint provides these Korean resources in the install_path\sap2afp\koreanfonts directory:

• C0H0GW72.240 (dpi Korean Gothic character sets)
• C0H0GW96.240 (dpi Korean Gothic character sets)
• C0H0MW72.240 (dpi Korean Myengjo character sets)
• C0H0MW96.240 (dpi Korean Myengjo character sets)
• T1H01150 (Korean code page)
With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets at either 7.2 point
size or 9.6 point size, you can print with both box characters and the check box on and off characters.

InfoPrint provides a Cyrillic code page that includes box characters, T1001172.CDP, in the install_path
\sap2afp\cyrillic directory. It also provides page definitions modified for Cyrillic support, P1CYR182
and P1CYR683, in the install_path\sap2afp\cyrillic directory.

To enable non-Latin character support on an InfoPrint Manager Windows server, an administrator must
do this procedure:

1. Obtain and install the fonts required for printing the script that you want to support.

2. Create backup copies of these current files:

Script Files
Cyrillic /usr/lpp/psf/fontlib/T1001172.CDP

/usr/lpp/psf/reslib/P1CYR182

/usr/lpp/psf/reslib/P1CYR683

3. Copy these files:
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Script Source file Target file or directory

Korean All files in install_path\sap2afp\koreanfonts install_path\fontlib

Cyrillic install_path\sap2afp\cyrillic\T1001172.CDP install_path\fontlib\T1001172.
CDP

Cyrillic install_path\sap2afp\cyrillic\P1CYR182 install_path\reslib\P1CYR182

Cyrillic install_path\sap2afp\cyrillic\P1CYR183 install_path\reslib\P1CYR683

4. Enter the script name in the userenv file at this location install_path\sap2afp\.
The possible script names are:

• japanese for Japanese

• spchinese for Korean

• tdchinese for Simplified Chinese

• korean for Traditional Chinese

• cyrillic for Cyrillic

Each of these specified script names enable the transform to use the defcp.tab.language and
pagedef.tab.language files corresponding to that language.

When you have completed this procedure, you can modify the pagedef.tab.language or fonts.tab to
specify a different set of fonts. Both these files reside in the install_path\sap2afp directory.

Enabling Unicode support

The sap2afp transform supports SAP Unicode OTF and ABAP data on AIX, Linux, and Windows
operating systems. Also, SAP Unicode OTF and ABAP data is not supported with PSF-Other
destinations, due to PCL Secondary not supporting the AFP Unicode Migration Fonts.

Before doing these configuration tasks on AIX, Linux, and Windows systems, you must first obtain and
install the AFP Unicode Migration Fonts that are required for printing:

AIX, Linux, Windows, AS/400, AFP Unicode Font PRPQ (5799-GJJ)

For more information about purchasing this product, see your service representative.

SAP Systems recommends using SAP Unicode systems that output SAPGOFU format, not the SAPGOF
format. Excerpt from the official SAPGOF specification: ''With the development of the Unicode variant of
SAPGOF (device type SAPGOFU), the ASCII and EBCDIC variants are considered obsolete and are provided only
for the sake of compatibility. Developers of new SAPGOF converters should base their implementation on the
Unicode variant of SAPGOF.'' Consequently, we recommend using SAPGOFU input files in Unicode
environment when invoking the SAP2AFP transform.
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Enabling Unicode support an InfoPrint Manager AIX, InfoPrint Manager Linux,
and Windows server

For the OTF input files, the detection of the environment (Unicode and non-Unicode) and the detection
of the double-byte languages in non-Unicode environments is automatic. For the ABAP files, if the input
file is a Unicode-encoded (SAPGOFU) file, the environment automatically goes to Unicode.

The input file encoding is automatically detected and you do not have to edit the contents of a syscp file
to set the input encoding when both SAPGOF and SAPGOFU files are submitted in a Unicode
environment.

EEnnvviirroonnmmeenntt aauuttoommaattiicc ddeetteeccttiioonn

Type of the input file
Encoding of the input
file

Environment
detection method Additional comments

OTF UTF-16 (BE or LE) Automatic Environment is set to
Unicode.

ASCII Automatic Environment is set
based on the code
pages used (code
page commands)

ABAP UTF-16 (BE or LE) Automatic Environment is set to
Unicode.

ASCII 'userenv' config file is
used

The default value is
NORMAL, which
means non-Unicode.

Resources for supporting Unicode ABAP files

Specific coded fonts are available to reference the AFP migration fonts. These coded fonts are used for
the Unicode processing of the ABAP files. To map these coded fonts for Unicode, page definitions
were also created. The page definitions are divided into 5 pairs, which map the Courier fonts, the
Japanese fonts, the Simplified Chinese fonts, the Traditional Chinese fonts, and the Korean fonts.

The resources are not part of the AFP Font Migration collection. All these resources and their source
code are available in the unicode.rc subfolder from the sap2afp folder, where the configuration files
also reside. When the Unicode processing is required, the transform automatically searches for the
resources in that specific folder. Otherwise it continues to search in the InfoPrint Manager fontlib and
reslib folders.

The table lists the new coded fonts, page definitions and Page Printer Formatting Aid (PPFA) source files
used:
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CCooddeedd ffoonnttss,, ppaaggeess ddeeffiinniittiioonnss aanndd PPPPFFAA ssoouurrccee ffiilleess ffoorr UUnniiccooddee AABBAAPP ffiilleess

File name Type
Location (subfolder in
InfoPrint Manager) Details

XZ420U10 coded font sap2afp/unicode.rc/ Courier Normal

XZ440U10 coded font sap2afp/unicode.rc/ Courier Bold

XZJHMNU coded font sap2afp/unicode.rc/ Japanese Mincho (used for
normal text)

XZJHKGU coded font sap2afp/unicode.rc/ Japanese Gothic (used for
bold text)

XZHSM2U coded font sap2afp/unicode.rc/ Korean Myengjo (used for
normal text)

XZHKG2U coded font sap2afp/unicode.rc/ Korean Gothic (used for bold
text)

XZSSNGU coded font sap2afp/unicode.rc/ Simplified Chinese Song (used
for normal text)

XZSKAIU coded font sap2afp/unicode.rc/ Simplified Chinese Kai (used
for bold text)

XZTSNGU coded font sap2afp/unicode.rc/ Traditional Chinese Sung
(used for normal text)

XZTKAIU coded font sap2afp/unicode.rc/ Traditional Chinese Kai (used
for bold text)

P1UNI683 page definition sap2afp/unicode.rc/ maps the Courier coded fonts

P1UNI182 page definition sap2afp/unicode.rc/ maps the Courier coded fonts

P1UNIJ83 page definition sap2afp/unicode.rc/ maps the Japanese coded
fonts

P1UNIJ82 page definition sap2afp/unicode.rc/ maps the Japanese coded
fonts

P1UNIK83 page definition sap2afp/unicode.rc/ maps the Korean coded fonts

P1UNIK82 page definition sap2afp/unicode.rc/ maps the Korean coded fonts

P1UNISC3 page definition sap2afp/unicode.rc/ maps the Simplified Chinese
coded fonts

P1UNISC2 page definition sap2afp/unicode.rc/ maps the Simplified Chinese
coded fonts

P1UNITC3 page definition sap2afp/unicode.rc/ maps the Traditional Chinese
coded fonts

P1UNITC2 page definition sap2afp/unicode.rc/ maps the Traditional Chinese
coded fonts

P1UNI683.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNI683
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File name Type
Location (subfolder in
InfoPrint Manager) Details

P1UNI182.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNI182

P1UNIJ83.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIJ83

P1UNIJ82.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIJ82

P1UNIK83.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIK83

P1UNIK82.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNIK82

P1UNISC3.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNISC3

P1UNISC2.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNISC2

P1UNITC3.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNITC3

P1UNITC2.PPFA PPFA source sap2afp/unicode.rc/ source code for P1UNITC2

Using TrueType and OpenType fonts

In the Unicode environment, the sap2afp transform supports the use of TrueType and OpenType fonts
for actual destinations that support them. This support consists of one set of Unicode configuration files
and resources for the TrueType/OpenType fonts. By default, these configuration files map the
WorldType fonts, which is a set of OpenType/TrueType fonts provided by InfoPrint Manager, but you
can change them to map any OpenType/TrueType fonts that you have. For SAP OTF input files with
TrueType inline fonts, the transform will output AFP data containing the referenced TrueType fonts as
inline resources. The TrueType fonts and the resources are used only when the -truetype parameter is
passed to the sap2afp transform specifying the use the TrueType configuration files, and if present,
TrueType fonts from the OTF files. InfoPrint Manager passes this parameter to the transform, depending
on the values of the these InfoPrint Manager attributes:

• font-resolution

• default-font-resolution

• font-resolutions-supported

Unless you explicitly specify that TrueType/OpenType fonts are used, the system uses the AFP
Migration Fonts for Unicode processing.

If you do not specify any value for font-resolution or you leave its default value, InfoPrint Manager
passes the -truetype parameter to the transform only if the actual destination's default-font-resolution
attribute value is set to open-type. When a job does have a font-resolution attribute specified,
InfoPrint Manager passes the -truetype parameter to the transform only if its value is set to open-type,
regardless of the default-font-resolution value.
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Configuring TrueType and OpenType support

The TrueType and OpenType fonts that are supported must be Unicode-enabled, and they are used for
processing files in a Unicode environment. For ASCII text data (a non-Unicode environment), do not use
TrueType/OpenType fonts. Whereas FOCA fonts are referenced in AFP with coded font names, Global
Resource Identifiers (GRIDs), or code page and font character set name pairs, TrueType and OpenType
fonts are always referenced by MDR structured fields using a name that is reflected in the actual font
file: the full font name. This means that the actual font data is not needed in this referencing stage, just
the full font names. At the printing stage, the font data is needed.

PSF uses two methods to resolve the font references:

1. Inline within the resource group of the AFP file. This means the font is embedded into the AFP.

2. Through the Resource Access Table (RAT).

The Resource Access Table is created using AFP Font Installer. It maps each Full Font Name to a file name
within the current directory. When the RAT is used, each directory that contains TrueType and
OpenType fonts should contain its own RAT file.

Enabling support for TrueType/OpenType fonts when RAT is installed

If you have installed the RAT, the AFP files will only reference the fonts using MDR structured fields.
When AFP is submitted to PSF for printing, the fonts are resolved through the RAT. This situation is
supported for both OTF and ABAP types of files.

To transform and print OTF files in Unicode environment using TrueType/OpenType fonts:

1. Open the fonts.tab.unicode.truetype file using a text editor.

2. Use the FullFontName column to map the OTF fonts to the desired TrueType/OpenType fonts.

To transform and print ABAP files in Unicode environment using TrueType/OpenType fonts:

1. Open the pagedef.tab.unicode.truetype file using a text editor.

2. In the PAGEDEF fields, specify the names of the page definitions mapping the TrueType fonts.

Enabling support for TrueType/OpenType fonts when RAT is not installed

When the RAT is not installed, the names of the font files are needed for embedding them into the AFP.
When AFP is later sent to PSF for printing, the fonts are found inline, in the resource group, at the
beginning of the AFP file. This case is supported for both OTF and ABAP files.

To transform and print OTF files in a Unicode environment using TrueType/OpenType fonts:

1. Open the fonts.tab.unicode.truetype file using a text editor.

2. In the TTF_PATH field, specify the path to the fonts.

3. Use the FullFilePath column to map the OTF fonts to the desired TrueType/OpenType fonts.

To transform and print with ABAP files in Unicode environment using TrueType/OpenType fonts:

1. Open the pagedef.tab.unicode.truetype file using a text editor.

2. In the PAGEDEF fields, specify the names of the page definitions mapping the TrueType fonts.
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3. In the TTFembedNorm and TTFembedBold fields, specify the file names of the normal and bold
TrueType fonts specified in the PAGEDEF.

For more information about the configuration files and their contents, see RICOH InfoPrint Manager:
Reference.

Resources for supporting TrueType and OpenType fonts

The configuration files mapping the WorldType fonts are:

• pagedef.tab.unicode.truetype

• fonts.tab.unicode.truetype

These files are located in the /sap2afp folder, along with the other configuration files.

The page definition files mapping the WorldType fonts are available in the sap2afp\unicode.
truetype.rc folder.

CCoonnffiigguurraattiioonn ffiilleess,, rreessoouurrcceess,, aanndd PPPPFFAA ssoouurrcceess ffoorr ssuuppppoorrttiinngg TTrruueeTTyyppee aanndd
OOppeennTTyyppee ffoonnttss

File name Type Path Details

pagedef.tab.unicode.truetype config file sap2afp/ specifies pagedefs to
be used with
TrueType for ABAP

fonts.tab.unicode.truetype config file sap2afp/ specifies TrueType
fonts to be used for
OTF

P1UTT182 page definition sap2afp/unicode.
truetype.rc/

maps the WGL
WorldType fonts

P1UTT683 page definition sap2afp/unicode.
truetype.rc/

maps the WGL
WorldType fonts

P1UTTJ82 page definition sap2afp/unicode.
truetype.rc/

maps the Japanese
WorldType fonts

P1UTTJ83 page definition sap2afp/unicode.
truetype.rc/

maps the Japanese
WorldType fonts

P1UTTK82 page definition sap2afp/unicode.
truetype.rc/

maps the Korean
WorldType fonts

P1UTTK83 page definition sap2afp/unicode.
truetype.rc/

maps the Korean
WorldType fonts

P1UTTSC2 page definition sap2afp/unicode.
truetype.rc/

maps the Simplified
Chinese WorldType
fonts

P1UTTSC3 page definition sap2afp/unicode.
truetype.rc/

maps the Simplified
Chinese WorldType
fonts
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File name Type Path Details
P1UTTTC2 page definition sap2afp/unicode.

truetype.rc/
maps the Traditional
Chinese WorldType
fonts

P1UTTTC3 page definition sap2afp/unicode.
truetype.rc/

maps the Traditional
Chinese WorldType
fonts

P1UTT182.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTT182

P1UTT683.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTT683

P1UTTJ82.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTJ82

P1UTTJ83.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTJ83

P1UTTK82.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTK82

P1UTTK83.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTK83

P1UTTSC2.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTSC2

P1UTTSC3.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTSC3

P1UTTTC2.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTTC2

P1UTTTC3.PPFA PPFA source file sap2afp/unicode.
truetype.rc/

source code for
P1UTTTC3

Enabling SAPGOF_ST_CHARS support

The sap2afp transform is now able to correctly process OTF files that have been generated from SAP
Unicode Systems using the SAPGOF_ST_CHARS setting enabled. For this, the new -sapgof_st_chars
transform parameter must be passed to sap2afp transform. It can be used for transforming SAPGOF
OTF files (ASCII-encoded) and SAPGOFU OTF files (Unicode-encoded), which have been generated
using the SAPGOF_ST_CHARS. This flag informs the sap2afp transform that the OTF input file has been
generated using the SAPGOF_ST_CHARS:X entry from the SAP Unicode System, thus the sap2afp
transform detects that for Unicode codepages, the ST and BC commands counters are halved and it will
double them, internally, so that the OTF file is correctly processed.

The flag -sapgof_st_chars is ignored for files containing only non-Unicode codepages.
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To support non-Unicode printing (for example using the PCL secondary) of SAPGOF OTF files
generated from SAP Unicode Systems, the -useascii flag switches to a non-Unicode environment for
processing the input files, regardless of the codepages used by the file. The Latin-1 codepage is used
instead of the Unicode codepages, and the files are printed using non-Unicode fonts.

1. The -useascii flag is ignored for SAPGOFU files.

2. When the -useascii flag is used on an SAPGOF OTF file that uses Unicode codepages, the
Unicode characters that are not covered by the non-Unicode Latin-1 codepage will be replaced
with spaces.

The -sapgof_st_chars and -useascii flags can be used together to signal that the OTF input file has
been generated with SAPGOF_ST_CHARS and must be printed using non-Unicode fonts.

Do not specify the -sapgof_st_chars flag for files that have been generated without the SAPGOF_ST_
CHARS setting.

Because the SAPGOF_ST_CHARS option is an SAP system setting, we recommend that you set the
-sapgof_st_chars transform option on an SAP system basis, either by using a separate logical
destination or by configuring the InfoPrint Manager SAP Client.

If you are using a separate logical destination, you must add the -sapgof_st_chars parameter to the
other-transform-options attribute of the logical destination.

If you want to configure the InfoPrint Manager SAP Client to use the -sapgof_st_chars parameter for
all incoming SAP jobs, you must follow the instructions below:

On the AIX or Linux SAP system, you must update the ipm_submit script on the InfoPrint Manager
machine:

1. Search for the ipm_submit script.

2. Use a text editor to open and edit the script.

3. Search for the line containing "other-transform-options='-g'";.

4. Add -sapgof_st_chars to the transform options, if the SAPGOF_ST_CHARS system setting is
enabled.

The line must be the same as in the example:

othertoptions="other-transform-options='-g -sapgof_st_chars'";

On the Windows SAP systems:

1. Go to the folder where InfoPrint Manager SAP Client is installed. The default path is c:\Program
Files\RICOH\Infoprint Manager SAP Clients\.

2. Run the SapIPMcfg.exe configuration utility in Administrator mode. To do this, right click the
configuration file and select "Run as Administrator".

3. Check the SAPGOF ST CHARS box when the SAPGOF_ST_CHARS setting in SAP is on.
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Enabling LDAP mode

If you are using the InfoPrint Manager Pull Print feature with your InfoPrint Manager server, enable the
LDAP mode. If you enable the LDAP mode, SAP clients specify through the authenticated-login
attribute that the job is authenticated.

Enabling LDAP mode on an AIX or Linux SAP system running the SAP Client
To enable GOCA support from an AIX or Linux system, follow this procedure:

1. Access the ipm_submit file for OMS configurations or the ipm_print file for non-OMS
configurations. You can find these files in the /usr/lpp/pd/bin directory.

2. If you use AIX or Linux, remove the hash mark (#) that is placed in front of the line #LDAP_MODE_
ENABLED=‘YES’. To disable the LDAP mode, access these files again and add the hash mark
(#) in front of the line.

Enabling LDAP mode on a Windows SAP system
If you have already installed the InforPrint Manager SAP Client on a Windows system and want to
enable LDAP mode, access the SapIPMcfg.exe file from the directory where you installed the SAP
client. When you click this file, it displays the IPM Server Settings dialog. Then, select IPM LDAP
Mode and enable it. To disable the LDAP mode, access the SapIPMcfg.exe file and clear the
check box.

Enabling GOCA support on an HP-UX or Sun Solaris SAP system
To enable the LDAP mode from an HP-UX system or a Sun Solaris system running the SAP client, you
must enable the support for the InfoPrint Manager server to which the client machine is connected. If
you are connected to an InfoPrint Manager AIX or InfoPrint Manger Linux, go to the AIX or Linux
server and follow this procedure:

1. Access the ipm_submit file for OMS configurations or the ipm_print file for non-OMS
configurations. You can find these files in the /usr/lpp/pd/bin directory.

2. If you use AIX or Linux, remove the hash mark (#) that is placed in front of the line #LDAP_MODE_
ENABLED=”YES”. To disable the LDAP mode, access these files again and add the hash mark
(#) in front of the line.

If you are connected to an InfoPrint Manager Windows server, access the SapIPMcfg.exe file from
the directory where you installed InfoPrint Manager. When you click this file, it displays the IPM
Server Settings dialog. Then, select IPM LDAP Mode and enable it. To disable the LDAP mode,
access the SapIPMcfg.exe file and clear the check box.

Setting up your SAP R/3 system to support new OTF user fonts

Use this procedure when using the sap2afp transform to print with a new font that you have created for
the job:

1. From the R/3 main menu, access the Font window so you can create a font family for this new,
customized font, by selecting the Tools main menu and then selecting theWord Processing→
Font path. or typing /nSP73 in the ok-Code field.
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2. From the SAPscript Font Maintenance: Initial Screen window, select the Font families option and
click Change.

3. Click Create and fill in the font information on the Create/Change Font Family window as shown
in Figure SAPScript Font Maintenance: Create/Change Font Family window, p. 90:

SAPScript Font Maintenance: Create/Change Font Family window

4. Click Continue.

5. When the system prompts you for a Change Request Query request, click Cancel.

6. From the SAPscript Font Maintenance: Initial Screen window, select the System Fonts option and
click Create.

7. Fill in the information from the Create System... window as shown in Figure SAPScript Font
Maintenance Create System... window, p. 90:

SAPScript Font Maintenance Create System... window
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8. Click Continue.

9. When the system prompts you for a Change Request Query request, click Cancel.

10. From the SAPscript Font Maintenance: Initial Screen window, select the Printer fonts/AFM
metrics option and click Change.

11. From the Create/Change... window shown in Figure SAPScript Font Maintenance (Create/
Change) window for OTF Fonts, p. 91, select the intended device type (ZDOCOGF) and fill in the
remaining information:

SAPScript Font Maintenance (Create/Change) window for OTF Fonts

12. Click Continue.

Before you can use this new Output Text Format (OTF) font, you must define a layout set that
contains this new font to use your device type.

13. Add an entry in the fonts.tab configuration file that identifies this new OTF font and make sure that
these resources are on the InfoPrint server where your InfoPrint actual destination is located.

Printing oversize characters on a 6400 printer with SAP R/3

InfoPrint Manager gives you the ability to resize Output Text Format (OTF) fonts on a 6400 Printer. If
your printer supports the graphics object content architecture (GOCA) feature, you can use the
6400fonts.tab configuration file to alter the height and width of characters printed. The SIZE=
parameter lets you specify the height of a font (in points) and have it scaled appropriately. Since there
are 72 points in an inch, 720 indicates a height of an inch. The CPI= (characters per inch) parameter
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defines the horizontal width to which the 6400 printer-resident fonts should be scaled. The smaller the
number you specify, the wider the font you receive.

To make sure that a font prints one inch high, specify this line in the 6400fonts.tab configuration file:

FONT=TIMES SSIIZZEE==772200 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0

The 6400fonts.tab configuration file is located in the /usr/lpp/psf/sap2afp directory on an InfoPrint
Manager AIX or InfoPrint Manager Linux server and the install_path\sap2afp folder on an InfoPrint
Manager Windows server.

To make sure that a font prints one inch wide, specify this line in the 6400fonts.tab configuration file:

FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CCPPII==11

To make sure that a font prints one-half inch wide, specify this line in the 6400fonts.tab configuration
file:

FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CCPPII==22

Once you have modified the 6400fonts.tab file appropriately, access the Print Screen List window on
the SAP R/2 graphical user interface and specify 6400 in the Title field of the Spool request pane.

Adding box shading values to printed output

InfoPrint Manager supports both Output Text Format (OTF) shading values and border thickness values.
The BX OTF command lets you print boxes that are either clear, solid, or contain four different levels of
shading. The levels of shading are a percentage between 0 and 100, with 0 indicating a clear box and
100 a solid box.

The InfoPrint Manager SAP transform recognizes the BX OTF command and creates graphics object
content architecture (GOCA) output if passed the -g flag. GOCA is an AFP data architecture used to
represent pictures generated by computer. Both the ipm_submit and ipm_print commands used by the
OMS (see Installing and configuring InfoPrint Manager's OMS, p. 15) and access method L (see
InfoPrint Manager non-OMS support, p. 59) automatically pass the -g flag to the SAP transform
through the other-transform-options attribute. For more information about the other-transform-options
attribute and the sap2afp command, see RICOH InfoPrint Manager: Reference. For more information about
the BX command values required to specify box shading, see your SAP R/3 documentation.

If you use this function with an IPDS InfoPrint printer that is not enabled for GOCA, the file prints a
presentation text object content architecture (PTOCA) box or boxes without shading and this message
sequence for each box at the end of the job:

0420-535: ERROR: One or more graphics objects were encountered.
The printer does not support this type of object.
:
:
0420-879: InfoPrint continues processing the print job: The STOP
when errors found in IMAGE and GRAPHICS data field on the
InfoPrint SMIT Error Handling Options panel is set to no.

If your installation uses older printers (for example, 3900 printers instead of InfoPrint 4000 printers), the
GOCA support can cause the printers to print at less than rated speed. If your applications do not
require GOCA support features such as box shading, you might want to improve performance by
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turning off the GOCA support. For instructions on how to turn off GOCA support on the various
platforms supported, see the following sections.

Turning off GOCA support on an AIX or Linux SAP system

To turn off GOCA support from an AIX or Linux system running the SAP Client, use this procedure:

1. Access either the ipm_submit (for OMS configurations) or the ipm_print file (for non-OMS
configurations) file that reside in the /usr/lpp/pd/bin directory.

2. Using your AIX or Linux editor of choice, comment out the othertoptions="other-transform-
options='-g'"; line by placing a hash mark (#) in front of the line.

If you ever wish to reactivate GOCA support, just access these files again and remove the hash mark
(#) in front of the line.

Turning off GOCA support on an HP-UX or Sun Solaris SAP system

To turn off GOCA support from either an HP-UX system or a Sun Solaris system running the SAP Client,
you must turn the support off at the InfoPrint Manager server to which the client machine is connected. If
you are connected to an InfoPrint Manager AIX, go to the AIX server and use this procedure:

1. Access either the ipm_submit (for OMS configurations) or the ipm_print file (for non-OMS
configurations) file that reside in the /usr/lpp/pd/bin directory.

2. Using your AIX or Linux editor of choice, comment out the othertoptions="other-transform-
options='-g'"; line by placing a hash mark (#) in front of the line.

If you ever wish to reactivate GOCA support, just access these files again and remove the hash mark
(#) in front of the line.

If you are connected to an InfoPrint Manager Windows server, access the ipmcfg file from the directory
where you installed InfoPrint Manager. When you click this file, it displays the IPM Server Settings
dialog. From here, you can click IPM GOCA Support to remove the check.

If you ever wish to reactivate GOCA support, just access the ipmcfg and click the check box again.

Turning off GOCA support on a Windows SAP system

If you have already installed the InfoPrint Manager SAP Client on a Windows system and want to turn
off GOCA support, access the ipmcfg file from the directory where you installed the SAP Client. When
you click this file, it displays the IPM Server Settings dialog. From here, you can click IPM GOCA
Support to remove the check.

If you ever wish to reactivate GOCA support, just access the ipmcfg and click the check box again.
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UUssiinngg bbaarr ccooddeess wwiitthh SSAAPP RR//33
These sections describe the bar codes for printing that can be used when printing OTF and ABAP output
from InfoPrint Manager:

• Bar codes supported by the InfoPrint SAP (sap2afp) transform, p. 94
• Setting up your SAP R/3 system to support new OTF user bar codes, p. 95
• Bar codes and printing from SAP R/3 through InfoPrint Manager, p. 97
• Specifying width in SAP bar codes, p. 99.

Bar codes supported by the InfoPrint SAP (sap2afp) transform

Some SAP R/3 applications require that data is printed as a bar code. If OTF specifies bar code data,
the sap2afp transform converts it into Bar Code Object Content Architecture (BCOCA) data, which is
understood directly by the control unit of the AFP printer. This bar code data can also be converted to
the Printer Control Language (PCL) PCL4, PCL5, or PCL5c data streams. This allows InfoPrint Manager
to print to any printers that accept Printer Control Language data.

These printers support both InfoPrint Manager and BCOCA:

• 3130 Advanced Function Printer
• 3160 Advanced Function Printer
• 3900 Advanced Function Duplex Printing System, Models D01, D02
• 3900 Advanced Function Wide Duplex Printing System, Models DW1, DW2
• 3900-OW1 Advanced Function Printer
• 3900-OW3 Advanced Function Printer
• 3935 Advanced Function Printer
• 4312 Network Printer 12 (NP 12)
• 4317 Network Printer 17 (NP 17)
• 4324 Network Printer 24 (NP 24)
• 4400 Thermal Printer
• InfoPrint 20 Printer
• InfoPrint 21 Printer
• InfoPrint 32 Printer
• InfoPrint 40 Printer
• InfoPrint 45 Printer
• InfoPrint 60 Printer
• InfoPrint 62 Printer
• InfoPrint 70 Printer (InfoPrint Manager for AIX only)
• InfoPrint 70 Plus Printer (InfoPrint Manager for AIX only)
• InfoPrint 1120 Printer
• InfoPrint 1125 Printer
• InfoPrint 1130 Printer
• InfoPrint 1140 Printer
• InfoPrint 1145 Printer

4 Customizing your print environment



4

95

• InfoPrint 1226 Printer
• InfoPrint 1332 Printer
• InfoPrint 1352 Printer
• InfoPrint 1372 Printer
• InfoPrint 2060ES Printer
• InfoPrint 2075ES Printer
• InfoPrint 2085 Printer
• InfoPrint 2090ES Printer
• InfoPrint 2105 Printer
• InfoPrint 2105ES Printer
• InfoPrint 3000 Printer
• InfoPrint 4000 Printer (InfoPrint Manager for AIX only)
• InfoPrint 4100 Printer
• InfoPrint Color 100 Printer (InfoPrint Manager for AIX only)
• InfoPrint Color 130 Plus Printer (InfoPrint Manager for AIX only)
• InfoPrint Color 1220 Printer
• InfoPrint Color 1228 Printer
• InfoPrint Color 1354 Printer
• InfoPrint Color 1357 Printer
• LaserPrinter 4028 Models AS1 and NS1

Setting up your SAP R/3 system to support new OTF user bar codes

Use this procedure when using the sap2afp transform to print with a new bar code that you have
created for the job:

1. From the R/3 main menu, access the Font window by either taking theWord Processing→
Font path, or typing /nSP73 in the ok-Code field.

2. From the SAPscript Font Maintenance: Initial Screen window, select the System bar codes
option and click Change.

3. Click Create and fill in the bar code information on the Create/Change System Bar Code
window as shown in Figure SAPScript Font Maintenance (Create/Change) System Bar Code
window, p. 96:
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SAPScript Font Maintenance (Create/Change) System Bar Code window

4. Click Continue.

5. When the system prompts you for a Change Request Query request, click Cancel.

6. From the SAPscript Font Maintenance: Initial Screen window, select the Printer bar codes option
and click Change.

7. From the Create/Change... window displayed below, select the intended bar code (ZDOCGOF)
and fill in the remaining information as shown in Figure SAPScript Font Maintenance (Create/
Change) window, p. 96:

SAPScript Font Maintenance (Create/Change) window

8. Click Continue.
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Before you can use this new Output Text Format (OTF) bar code, you must define a layout set that
contains this new bar code to use your device type (in this case, ZDOCGOF).

9. Add an entry in the barcode.tab configuration file that identifies this new OTF bar code name to
an actual bar code type. The barcode.tab configuration file identifies values in this format:

BarCode=ZDOBAR Type=017 Mode=002 Flag=128

For more information about the barcode.tab configuration file and how it relates to the Bar Code Object
Content Architecture (BCOCA), see Bar codes and printing from SAP R/3 through InfoPrint Manager,
p. 97.

Bar codes and printing from SAP R/3 through InfoPrint Manager

Table Bar Code Type field values, p. 97, Bar Code Mode field values, p. 97, and Table Bar Code Flag
field values, p. 99 map the Bar Code Object Content Architecture values with the SAP R/3 system
values found in the barcode.tab configuration file, which is located in the /usr/lpp/psf/sap2afp
directory on an InfoPrint AIX or InfoPrint Linux system and the install_path\sap2afp folder on an InfoPrint
Windows system.

BBaarr CCooddee TTyyppee ffiieelldd vvaalluueess

Bar Code Type Description

X'01' Code 3 of 9

X'02' MSI

X'08' EAN-8

X'09' EAN-13

X'0C' Interleaved 2 of 5

X'11' Code 128

X'18' POSTNET

X'1E' PDF 417

X'21' Code 93

X'1C' Data Matrix

X'20' QR Code

BBaarr CCooddee MMooddee ffiieelldd vvaalluueess

Modifier Value Bar Code Type Meaning

X'01' X'01' Present the bar code without a generated check digit.

X'02' X'01' Generate a check digit and present it with the bar code.

X'01' X'02' Present the bar code without check digits generated by the
printer.
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Modifier Value Bar Code Type Meaning

X'02' X'02' Present the bar code with generated modulo-10 check digit.
This check digit is the second check digit; the first check digit
is the last byte of the BSA data.

X'03' X'02' Present the barcode with two check digits. Both check digits
are generated using the modulo-10 algorithm.

X'05' X'02' Present the barcode with two check digits. The first check
digit is generated using the modulo-11 algorithm; the
second using the modulo-10 algorithm. The first check digit
equals the remainder; exception condition EC-0E00 exists if
the first check-digit calculation results in a value of 10.

X'00' X'08' Present an EAN-8 barcode symbol. The input data consists
of seven digits: two flag digits and five article digits. All
seven digits are encoded along with a generated check
digit.

X'00' X'09' Present an EAN-13 barcode symbol. The input data consists
of twelve digits: two flag digits and ten article digits, in that
order. The first flag digit is not encoded. The second flag
digit, the article number digits, and generated check digits
are encoded. The first flag digit is presented in HRI form at
the bottom of the left quiet zone. The first flag digit governs
the A and B number-set pattern of the barcode and space
coding of the six digits to the left of the symbol center
pattern.

X'01' Present the bar code without a generated check digit. In
sequence, the input data consists of a start character, digits
to be encoded, and a stop character.

X'02' X'0C' Generate a check digit and present it with the bar code. In
sequence, the input data consists of a start character, digits
to be encoded, and a stop character.

X'02' X'11' Generate a Code 128 symbol using subset A, B, or C as
appropriate, to produce the shortest possible bar code from
the given data. The Code 128 code page is used to
interpret the bar code symbol data. Generate a check digit
and present it with the data.

X'00' X'18' Present the ZIP code as 5 digits.

X'01' X'18' Present the ZIP code as 9 digits.

X'00' X'1E' Present a full PDF417 bar code symbol.

X'01' X'1E' Present a truncated PDF417 bar code symbol, for use in a
relatively clean environment in which damage to the symbol
is unlikely. This version omits the right row indicator and
simplifies the stop pattern into a single module width bar.
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Modifier Value Bar Code Type Meaning

X'00' X'21' Present a Code 93 bar code symbol. The linear bar code
symbology is similar to Code 39, but more compact than
Code 39. Code 93 bar code symbols are made up of a
series of characters, each of which is represented by 9
modules arranged into 3 bars with their adjacent spaces.
The bars and spaces vary between 1 module wide and 4
modules wide.

X'00' X'1C' Present a Data Matrix Bar Code symbol using Error
Checking and Correcting (ECC) algorithm 200.

X'02' X'20' Present a Model 2 QR Code Bar Code symbol.

The barcode.tab configuration file can contain the FlagPDF keyword that represents byte 5 of the BSA
(Bar Code Symbol Data) from PDF417 Special-Function Parameters. This flag is only used with PDF417
bar code types, and it controls how the bar code data is processed by the BCOCA receiver. For more
information, see Bar Code Object Content Architecture Reference.

BBaarr CCooddee FFllaagg ffiieelldd vvaalluueess

Flag field values Meaning

128 Present without Human Readable Text (HRI)

0 Present with Human Readable Text

Specifying width in SAP bar codes

InfoPrint Manager lets you modify bar code width using the same command syntax provided with the
Page Printer Formatting Aid (PPFA) product. By modifying the barcode.tab configuration file to use the
ModWidth parameter, you can change the width of bar codes and the wide-to-narrow ratio.

ModWidth
Specifies the width of the smallest defined bar code element, using mils (thousandths of an inch). For
bar code types that explicitly specify the module width (for example, POSTNET and RM4SCC), this
field is ignored. The range of values allowed is 1 to 254. If ModWidth is not specified in the
barcode.tab file, the sap2afp transform uses the defaulted bar code width.

n

Specifies the width of each module, using thousandths of an inch (1/1000) as the unit of measure.

Ratio
Specifies a percent value in the form nnn. For example, 200 represents a ration of 2.5 to 1. For most
bar code symbols, the Ratio value should be between 200 and 300. For bar code types that
explicitly specify the module width (for example, POSTNET and RM4SCC), this field is ignored. If
Ratio is not specified, the default ratio for the bar code symbol is used. This value must be a three-
digit character between 100 and 500.

To shorten an existing bar code, you can specify this line in the barcode.tab file:

Using bar codes with SAP R/3
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BarCode = BC_CD39 Type = 001 Mode = 001 Ratio = 2000 ModWidth = 10

AAlltteerrnnaattee aacccceessss mmeetthhooddss ffoorr ssuubbmmiittttiinngg SSAAPP jjoobbss ttoo IInnffooPPrriinntt
MMaannaaggeerr
To use InfoPrint Manager as an SAP OMS you define your SAP devices to use access method E (see
Installing and configuring InfoPrint Manager's OMS, p. 15). If you cannot use InfoPrint Manager as an
SAP OMS, we recommend defining your SAP devices to use access method L (see InfoPrint Manager
non-OMS support, p. 59). There are other access methods that can be used for submitting print jobs
from SAP systems to InfoPrint Manager. This topic describes some of those methods. These methods do
not require an InfoPrint SAP Client to be installed on your SAP system, but do not allow SAP job
attributes to be passed with the job or provide for any status information regarding the job to be known
on the SAP system. You can install and use the SAP transform with these methods.

Defining SAP devices using access method U

From your SAP system, you can submit jobs to an InfoPrint Manager for AIX, Manager for InfoPrint
Linux, or InfoPrint Manager for Windows server using LPD by defining your SAP device to use access
method U.

This method is intended for InfoPrint Manager users whose SAP R/3 applications run on non-AIX or
non-Linux systems. This method is discouraged with SAP systems running on AIX or Linux because you
must create AIX or Linux print queues to use it. For a preferred method of submitting jobs from SAP
systems to InfoPrint Manager that provides better feedback, see either Installing and configuring
InfoPrint Manager's OMS, p. 15 or InfoPrint Manager non-OMS support, p. 59.

To use access method U to send jobs to InfoPrint Manager, you need to make sure that the LPD service
is running on the InfoPrint server. Use the procedure appropriate to your InfoPrint Manager server
operating system:

• Verifying the InfoPrint Manager for Windows LPD service is started, p. 100
• Verifying the LPD service is started on InfoPrint Manager for AIX, p. 101
• Verifying the LPD service is started on InfoPrint Manager for Linux, p. 101

Verifying the InfoPrint Manager for Windows LPD service is started

To submit jobs to InfoPrint Manager through the LPD service, the InfoPrint Manager LPD service that
comes with InfoPrint Manager for Windows must be active. Note that this service is different from the
LPD Windows service that comes with the base operating system. Use this procedure to verify that the
service is started on your InfoPrint Manager Windows server, and if necessary, to activate the InfoPrint
Manager LPD service:

1. From the Start menu, select Programs→ InfoPrint Manager→Management Console.

2. Click File→ Stop Server.

3. Access the Edit→ Service Configuration... path.

4. From the Service Configuration window, make sure that the Run InfoPrint Manager LPD
service check box has been checked. Press OK to save this change.

4 Customizing your print environment
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5. Click File→Start Server.
6. Exit the InfoPrint Manager Management Console.

Verifying the LPD service is started on InfoPrint Manager for AIX

To submit jobs to InfoPrint Manager through LPD, you must make sure that the AIX lpd daemon is active
on your InfoPrint Manager AIX server.

To either verify that the lpd daemon is active or to start it on your InfoPrint Manager AIX server:

1. From an AIX command line, use either smit or smitty to access the System Management Interface
Tool.

2. From the main menu, take the Print Spooling→Manage Print Server path.

3. From the Manage Print Server panel, scroll down and click Show Status of the Print Server
Subsystem.
If the lpd subsystem displays an inoperative status, return to the Manage Print Server panel and
click Start the Print Server Subsystem (lpd daemon).

If the lpd subsystem displays an active status and shows a PID value, you can exit the SMIT
interface and do not have to take any action.

4. From the Start the Print Server Subsystem panel, take the default values and press Enter.
The system responds with a message similar to this:

0513-059 The lpd Subsystem has been started. Subsystem PID is 25550.

which indicates that the lpd daemon is now active.

5. Exit the SMIT interface.

Verifying the LPD service is started on InfoPrint Manager for Linux

To submit jobs to InfoPrint Manager through the LPD service, the InfoPrint Manager LPD service that
comes with InfoPrint Manager for Linux must be started. Use this procedure to verify that the service is
started on your InfoPrint Manager for Linux server, and if necessary, to activate the InfoPrint Manager
LPD service:

1. Go to Applications→ InfoPrint Manager→Management Interface.

2. Expand the Objects group.

3. Left click the LPD Gateway object to see the status in the right panel.

4. Exit the InfoPrint Manager Management Interface.

Defining devices that use InfoPrint Manager for access method U

To define SAP devices to use access method U, follow this procedure:

1. Make sure that you have a logical printer defined in InfoPrint Manager, which will send jobs to
your physical printer device.

Alternate access methods for submitting SAP jobs to InfoPrint Manager
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2. From the R/3 main menu, access the Spool Administration window by clicking the Tools main
menu and then selecting the Tools→ Administration→ Spool→ Spool Administration path
or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and select the Change
button.

4. Click Create and fill in this information on the Create Output Device window:

Field Explanation Example value

Output device Type the name that R/3 users
need to access the printer.

ipm1pms

Device type Select the device type that has
been defined in the R/3
system for the printer model.
For example, POST2 applies
to any PostScript printer.

POST2

Spool server Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

hrmssbx_SBX_00

Destination hosts Type the host name for the
InfoPrint server.

nwser

Host printer Type the name of the InfoPrint
Manager logical destination.

prt1-lp

Device class Enter a space so that this field
accepts the default value of
printer, which is P, or you can
specify Standard printer.

Access method in host
spool

Select the method that the
spool work process uses to
pass data to the host spool
system.

U

5. From the menu bar, click Back and the system prompts you to save the new output device.

Once you have completed this task, you can begin submitting jobs to InfoPrint Manager.

Submitting jobs from Windows SAP systems to InfoPrint Manager Windows with
access method C

If your SAP system runs on a Windows system, you can submit jobs to a printer running on an InfoPrint
Manager Windows server through Access Method C. To configure your Windows SAP system to print
through an InfoPrint Manager Windows server, you must create a Windows gateway printer on that

4 Customizing your print environment
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InfoPrint Manager Windows server, and then define devices on your SAP system to use access method
C.

A Windows gateway printer is the combination of a printer driver and a port. You can create a
Windows printer using the Windows Add Printer wizard. You can see these printers from the Windows
Printers window, but you should never open and modify them from there.

To define SAP devices to use access method C, follow this procedure:

1. Make sure that you have a logical printer defined in InfoPrint Manager that sends jobs to your
actual destination device.

2. From the R/3 main menu, access the Spool Administration window by selecting the Tools main
menu and then selecting the Tools→ Administration→ Spool→ Spool Administration path
or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and click Change.

4. Click Create and fill in this information about the Create Output Device window:

Field Explanation Example value

Output device
Type the name that R/3 users
will need to access the printer.

prt2

Device type
Select the device type that has
been defined in the R/3
system for the printer model.
HPLJ4 applies to a Hewlett-
Packard LaserJet 4 printer.

HPLJ4

Spool server
Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

rt1_RT1_00

Host printer
Type the hostname of the
InfoPrint Manager Windows
server (ANAKE), followed by
the Windows shared printer
name (EDPTEST).

\\ANAKE\EDPTEST

Device class
Enter a space so that this field
accepts the default value of
printer, which is P.

Access method in host
spool Select the method that the

spool work process uses to
pass data to the host spool
system.

C

Alternate access methods for submitting SAP jobs to InfoPrint Manager
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5. From the menu bar, click Back and the system prompts you to save the new output device.

4 Customizing your print environment
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55.. Managing SAP printers from InfoPrint Manager

•Introducing SAP R/3 printer administration module
•Limitations and constraints
•The pdsap command

IInnttrroodduucciinngg SSAAPP RR//33 pprriinntteerr aaddmmiinniissttrraattiioonn mmoodduullee
InfoPrint Manager allows the management of the print jobs and printers from an SAP R/3 system. You
can receive a print job from an SAP R/3 system, update the status of the job, and, to a limited extent,
the status of a printer. The SAP R/3 printer administration module configures the resources on the SAP
system, namely the configuration of a ROMS and especially of its associated printers.

The following operations must be allowed:

• Create, change, or delete ROMS.

• Create, change, or delete LOMS. To use a LOMS, the user must be able to add, change, or delete
command sets for the LOMS.

• Create, change, or delete printers with access method E.

LLiimmiittaattiioonnss aanndd ccoonnssttrraaiinnttss
These limitations and constraints apply to the SAP R/3 printer administration module:

• The pdsap command supports only en_US character sets.

• The pdsap command automatically converts flags, parameters, and some values to uppercase.

• The pdsap command can only communicate with SAP systems connected to existing InfoPrint
Manager SAP callback daemons.

SAP R/3 printer administration module does not support the following:

• Administration of output devices with device classes different from Standard Printer.

• Administration of printers with access methods different from method E.

• Setting log and trace flags.

• Setting of authorization groups for printers.

• Creation of ROMS and LOMS with output type "Fax".

• Setting the option "transmit print data stream via RFC to the OMS" for an RFC-enabled LOMS.

TThhee ppddssaapp ccoommmmaanndd
Syntax

pdsap SAP_SID_NAME [list | create | modify |delete] [splserver | roms | loms | cmd |
devtype | prtoptions | printer] parameter=value parameter=value ...

Description

The pdsap command allows the management of SAP printers from the OMS.
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The pdsap command can only be run by root or ipm1 on Linux and AIX (dropping privileges to ipm1),
or an administrator on Windows.

Flags

SAP_SID_NAME
Identifies the SAP instance created using the SAP callback daemon.

list, create, modify, and delete are the operations that the pdsap command executes.

list
Lists the attributes for one or more SAP objects.

create
Creates an SAP object by using the attributes specified on the command line.

modify
Modifies several properties of an SAP object.

delete
Deletes an SAP object if there are no other SAP objects that depend on it.

splserver (Spool Server), roms (Real Output Management Systems), loms (Logical Output
Management Systems), cmd (Operating System Commands), devtype (Device Types), prtoptions
(Print Options), and printer (Output Device) are the SAP objects to which an operation applies.

All flag and attribute names are case insensitive.

The following table shows the operations that are applied to each SAP object:

Object Operation

splserver list

roms create

delete

list

modify

loms create

delete

list

modify

cmd create

delete

list

5 Managing SAP printers from InfoPrint Manager
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modify

devtype list

prtoptions list

printer create

delete

list

modify

To create a printer, follow these steps:

1. Log in as root or ipm1 on Linux and AIX or as an administrator on Windows.

2. Enter the pdsap command to list splserver and look for the SPOOLSRV attribute value.

3. InfoPrint Manager creates a default “IBM IPM” ROMS as part of the SAP client configuration. You
can use the default ROMS or create a new one.

You must always use an "IBM IPM" ROMS with InfoPrint Manager. Do not delete the “IBM IPM”
ROMS.

4. Create a LOMS by using the ROMS from step 3. Use the SPOOLSRV attribute value from step 2
for CMDSERVER and CALLBTRGT.

5. List devtype and choose the device type to use for the SAP printer.

6. Optionally, you can list prtoptions for the device from step 5.

7. Create the printer using the LOMS from step 4, the device name from step 5, and enabling or
disabling the print options listed in step 6.

The print options set when the SAP printer is created cannot be removed with this tool. You can only
set additional print options. To remove print options, use SAP NetWeaver SAPGUI.

splserver

1. lliisstt

Input Parameters:

Field name Description Type Size Mandatory

ROMS Name of ROMS Text 10 Yes

Output Parameters:

Field name Description Type Size

PAMSSERVER Spool server name Text 20

The pdsap command
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PAHOST Spool server host Text 32

TEXT Description Text 64

LOGICAL Logical server Text 1

RUNMODE Load balancing enabled Text 1

ALTSRV Alternative spool server Text 20

MAPPEDTO Assigned spool server Text 20

SPOOLSRV Real spool server for processing Text 20

roms

1. lliisstt

Input Parameters:

Field name Description Type Size Mandatory

ROMS Name of ROMS Text 10 Yes

Output Parameters:

Field name Description Type Size

NAME Name of ROMS Text 10

DESCR Description of ROMS Text 60

STARTINST Callback Target Text 40

RECONFIG Time interval for reconnecting Text (0-999) 3

CMD_INTFCE OMS tasking via command line
interface

Boolean 1

JOB_QUERY OMS job query possible Boolean 1

JOB_CANCEL OMS jobs can be deleted Boolean 1

POLL_JOBS OMS job polling possible Boolean 1

CALLB_JOBS OMS job callback possible Boolean 1

DEV_QUERY OMS queue query possible Boolean 1

2. ccrreeaattee

Input Parameters:

5 Managing SAP printers from InfoPrint Manager
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Field name Description Type Size Default Mandato-
ry

NAME Name of ROMS Text 10 None Yes

DESCR Description of ROMS Text 60 None Yes

STARTINST Callback Target Text 40 None Yes

RECONFIG Time interval for
reconnecting

Text (0-
999)

3 20 No

3. mmooddiiffyy

Input Parameters:

Field name Description Type Size Settable Mandato-
ry

ROMS Name of ROMS Text 10 No Yes

DESCR Description of ROMS Text 60 Yes No

STARTINST Callback Target Text 40 Yes No

RECONFIG Time interval for
reconnecting

Text (0-
999)

3 Yes No

4. ddeelleettee

Input Parameters:

Field name Description Type Size Mandato-
ry

ROMS Name of ROMS Text 10 Yes

loms

1. lliisstt

Input Parameters:

Field name Description Type Size Mandatory

ROMS Name of ROMS Text 10 Yes

LOMS Name of LOMS Text 6 No

• If no LOMS is specified on command line, pdsap lists all LOMS associated with the ROMS.

Output Parameters:

The pdsap command
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Field name Description Type Size

NAME Name Text 6

DESCR Description Text 60

RNAME ROMS assigned Text 10

CMDSERVER Server instance Text 40

CALLBTRGT Target for callback Text 40

OMSFLAGS OMS configuration flags Text 60

CMD_GROUP Command group (A-Z) Text 1

CMD_INTFCE OMS tasking possible using command line interface Boolean 1

DEV_QUERY OMS queue query possible Boolean 1

JOB_QUERY OMS job query possible Boolean 1

JOB_CANCEL OMS jobs can be deleted Boolean 1

USE_POPUPS Display Status dialog boxes Boolean 1

CALLB_JOBS OMS job callback Boolean 1

CLASS Event report level for OMS callbacks:
• 01: Final messages, including 'done' and error

messages: The job is not resumed or further
processed, the job is completed according to the
spool system.

• 02: Problem messages: Problems that require
user interaction.

• 03: Problem messages: Problems that the system
can solve.

• 04: Status changes: Includes internal status types
of the output management system that are not
reproduced in the SAP system; for example, the
status change from 'waiting' to 'printing'.

• 05: Information: Further information, such as
additional levels of detail, can be defined with
larger number values according to the output
management system; for example, any change in
the queue position.

Text (0 –
99)

2

JCALLBIV Job callback interval Text (0 –
999)

3

JCALLBAMNT Job callback amount Text (0 –
999)

3

RETRYIV Retry timeout Text (0 –
999)

3

5 Managing SAP printers from InfoPrint Manager
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2. ccrreeaattee

Input Parameters:

Field name Description Type Size De-
fault

Manda-
tory

NAME Name Text 6 None Yes

DESCR Description Text 60 None No

RNAME ROMS assigned Text 10 None Yes

CMDSERVER Server instance Text 40 None Yes

CALLBTRGT Target for callback Text 40 None Yes

CMD_GROUP Command group (A-Z) Text
(A-Z)

1 None No

CLASS Event report level for OMS callbacks:
• 01: Final messages, including 'done' and

error messages: The job is not resumed or
further processed, the job is completed
according to the spool system.

• 02: Problem messages: Problems that
require user interaction.

• 03: Problem messages: Problems that the
system can solve.

• 04: Status changes: Includes internal
status types of the output management
system that are not reproduced in the SAP
system; for example, the status change
from 'waiting' to 'printing'.

• 05: Information: Further information, such
as additional levels of detail, can be
defined with larger number values
according to the output management.

Text
(0 –
99)

2 None Yes

JCALLBIV Job callback interval Text
(0 –
999)

3 20 No

JCALLBAMNT Job callback amount Text
(0 –
999)

3 100 No

RETRYIV Retry timeout Text
(0 –
999)

3 300 No

3. mmooddiiffyy

Input Parameters:
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Field name Description Type Size Setta-
ble

Manda-
tory

LOMS Name of LOMS Text 6 No Yes

ROMS Name of ROMS Text 10 No Yes

DESCR Description of ROMS Text 60 Yes No

RNAME New name of assigned ROMS Text 10 Yes No

CMDSERVER Server instance Text 40 Yes No

CALLBTRGT Target for callback Text 40 Yes No

CMD_GROUP Command group (A-Z) Text
(A-Z)

1 Yes No

CLASS Event report level for OMS callbacks:
• 01: Final messages, including 'done' and

error messages: The job is not resumed or
further processed, the job is completed
according to the spool system.

• 02: Problem messages: Problems that
require user interaction.

• 03: Problem messages: Problems that the
system can solve.

• 04: Status changes: Includes internal
status types of the output management
system that are not reproduced in the
SAP system; for example, the status
change from 'waiting' to 'printing'.

• 05: Information: Further information, such
as additional levels of detail, can be
defined with larger number values
according to the output management
system; for example, any change in the
queue position.

Text (0
– 99)

2 Yes No

JCALLBIV Job callback interval Text (0
–
999)

3 Yes No

JCALLBAMNT Job callback amount Text (0
–
999)

3 Yes No

RETRYIV Retry timeout Text (0
–
999)

3 Yes No

4. ddeelleettee

Input Parameters:
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Field name Description Type Size Manda-
tory

LOMS Name Text 6 Yes

ROMS ROMS assigned Text 10 Yes

cmd

1. lliisstt

Input Parameters:

Field name Description Type Size Man-
dato-
ry

LOMS Name of LOMS Text 6 Yes

OPSYS OS name (HP-UX, Linux, OSF1, SINIX, Windows NT,
SunOS, AIX, etc.)

Text 10 Yes

Output Parameters:

Field name Description Type Size

OPSYS Name of the OS of the SAP NW application server instance where
the command is executed (HP-UX, Linux, OSF1, SINIX, Windows
NT, SunOS, AIX, etc.).

Text 10

LCMD Logical command.
• CCAANNCCEELL: The associated real command is executed from the

specified application server in case of job cancellation.
• DDQQUUEERRYY: The associated real command is executed from the

specified application server in case of device query.
• JJQQUUEERRYY: The associated real command is executed from the

specified application server in case of job query.
• PPAATTHH: The associated real command string is placed in front of

the command string of a CCAANNCCEELL, DDQQUUEERRYY, JJQQUUEERRYY or
SSUUBBMMIITT command.

• SSUUBBMMIITT: The associated real command is executed from the
specified application server in case of a print job submission to
the OMS.

Text 6

CMD The real command executed from the associated SAP NW
application server instance.

Text 132

2. ccrreeaattee

Input Parameters:
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Field name Description Typ-
e

Size De-
fault

Manda-
tory

OPSYS Name of the OS of the SAP NW application
server instance where the command is executed
(HP-UX, Linux, OSF1, SINIX, Windows NT,
SunOS, AIX, etc.).

Text 10 None Yes

LCMD Logical command.
• CCAANNCCEELL: The associated real command is

executed from the specified application server
in case of job cancellation.

• DDQQUUEERRYY: The associated real command is
executed from the specified application server
in case of device query.

• JJQQUUEERRYY: The associated real command is
executed from the specified application server
in case of job query.

• PPAATTHH: The associated real command string is
placed in front of the command string of a
CCAANNCCEELL, DDQQUUEERRYY, JJQQUUEERRYY or SSUUBBMMIITT
command.

• SSUUBBMMIITT: The associated real command is
executed from the specified application server
in case of a print job submission to the OMS.

Text 6 None Yes

CMD The real command executed from the associated
SAP NW application server instance.

Text 132 None Yes

3. mmooddiiffyy

Input Parameters:

Field name Description Typ-
e

Size Setta-
ble

Manda-
tory

LOMS Name of LOMS Text 6 No Yes

OPSYS Name of the OS of the SAP NW application
server instance where the command is executed
(HP-UX, Linux, OSF1, SINIX, Windows NT,
SunOS, AIX, etc.).

Text 10 Yes No

LCMD CCAANNCCEELL, DDQQUUEERRYY, JJQQUUEERRYY, SSUUBBMMIITT, PPAATTHH Text 6 Yes No

CMD The real command executed from the associated
SAP NW application server instance.

Text 132 Yes No

4. ddeelleettee

Input Parameters:
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Field
name

Description Type Size Manda-
tory

LOMS LOMS name Text 6 Yes

OPSYS OS name (HP-UX, Linux, OSF1, SINIX, Windows NT,
SunOS, AIX, etc.)

Text 10 Yes

LCMD Logical command.
• CCAANNCCEELL: The associated real command is executed from

the specified application server in case of job
cancellation.

• DDQQUUEERRYY: The associated real command is executed from
the specified application server in case of device query.

• JJQQUUEERRYY: The associated real command is executed from
the specified application server in case of job query.

• PPAATTHH: The associated real command string is placed in
front of the command string of a CCAANNCCEELL, DDQQUUEERRYY,
JJQQUUEERRYY or SSUUBBMMIITT command.

• SSUUBBMMIITT: The associated real command is executed from
the specified application server in case of a print job
submission to the OMS.

Text 6 Yes

Usage notes:

The CMD field describes a template for a command line to call an OMS command. The command line
can be structured as required.

• Make sure to place the entry in front of the command template, if the entry is used in the path.
Otherwise, the template can contain several commands, depending on the shell possibilities of the
operating system where the command is executed.

Other SAP-specific replacement characters can also be used. The notation begins with a & character. If
the command already contains a & character, then it needs to be written as &&. The following
replacement parameters are defined:

&C Number of copies

&D Department of the recipient

&E Name of file with the print date (including path)

&F Name of file without path

&H / <x> / <y> <x> if host spool cover space required, <y> otherwise

&I Job name with DB ID

&J Job name without DB ID

&L Format type

&M Client of spool request owner

&m Client of spool request owner

The pdsap command
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&O (SAP)Name of spool request owner

&o (SAP)Name of print request owner

&P Name of external printer

&p Path name of output file

&R Name of recipient

&S Name of SAP printer

&T Title

&t Fax number

&U Host spool cover page required (X=yes, N=no)

&Y SAP priority (1-99). 1 is the highest priority

&N Spool request number

&n Output request number

Other parameters that are also available for the OMS command template:

&EI SAP spool ID

&EG Confirmation group

&ES SAP instance name for callback (if required, otherwise "-")

&ET Maximum buffer time for callback events

&EA Maximum number of buffered events

&EP Fax recipient (future addition). No native Fax support in SAP spool system.

&E1 SAP flag of LOMS

&E2 OMS flag of LOMS

&E3 SAP flag of ROMS

&E4 OMS flag of ROMS

An operating system-specific masking of special characters is necessary for the correct handling of
command arguments:

5 Managing SAP printers from InfoPrint Manager
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UNIX
The characters \, ', " and $ are masked by \.

A separate \ is represented by \\.

Parameters should be bracketed with " characters, so that the special characters
(including blank characters) are correctly transmitted. For example, '&T'.

Windows
The character " is masked by \.

All \ characters used before the " character are masked.

The character % is replaced by #.

devtype

1. list

Input Parameters:

Field name Description Type Size Man-
datory

ROMS Name of ROMS Text 10 Yes

SHOW_URDT List of available Unicode reference device
types

Boolean 1 No

Output Parameters:

Field name Description Type Size

One or more PATYPE / PNAME pairs

PATYPE Name of device type Text 8

PNAME Short description of device type Text 30

URDT info (when SHOW_URDT is set to TRUE )

URDT Name of URDT Text 8

URDT_DESC Description of URDT Text 30

URDT_LANG List of supported languages Text table of 2
characters

prtoptions

1. lliisstt

Input Parameters:
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Field name Description Type Size De-
fault

Manda-
tory

ROMS Name of ROMS Text 10 None Yes

PATYPE Name of device type Text 8 None Yes

Output Parameters:

Field name Description Type Size

POPTION Print option ID Text 1

OPTNAME Name of the print option (in logon language) Text 60

IS_VENDORDEF If set, this print option is defined by a printer vendor,
instead of the SAP system.

Text 1

OPTTYPE Type of print options:
• L: List
• C: Checkbox
• U: User string

Text 1

disabled Print option is disabled Boo-
lean

1

Print sub-options

POPTION dependent (zero, one, or more pair entries)

OPTVAL Integer value of a print option Text 1

VALUETEXT_EN English description of print option value Text 60

disabled Print sub-option is disabled Boo-
lean

1

pre-selected Print sub-option is pre-selected Boo-
lean

1

printer

1. lliisstt

Input parameters:

Field name Description Type Size Mandato-
ry

ROMS LOMS name Text 10 Yes

DEVICE Printer name Text 30 Yes

Output Parameters:
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Field name Description Type Size

ROMS ROMS name Text 10

NAME Printer long name Text 30

PADEST Printer short name Text 4

PAMSSERVER Spool server name Text 20

PALOMS Associated LOMS name Text 6

PATYPE Device type of associated printer Text 8

PAMODEL Printer model name Text 20

PASTANDORT Printer location Text 64

PAMSG Status message or copy of location Text 64

PADEVGRP Authorization group for printers Text 30

PADISABLED Printer disabled Boolean 1

PAPROSNAME Printer long name for host spooler.

Printer name is in the host system.

Text 50

PADFLTSTTL Print SAP cover page Boolean 1

COVER_PAGE_LNG Language to be used for cover page: EN, DE, FR,
etc.

Text 2

PADFLTUTTL Print default host spool cover page.
• <blank>: Does not print host spooler cover

page.
• D: Prints host spooler cover page as set at

printer.
• X: Always prints host spooler cover page.

Text 1

PAMONI Monitor using monitoring infrastructure Boolean 1

PASYNC Synchronization of printer requests Boolean 1

PADUPCOPY Create a print request for each copy
• <blank>: Copies counter to host spool system.
• X: Passes copies as separate Output Request in

SAP system.
• N: Passes only one copy to host spool system.

Text 1

COLORPRT Whether or not printer supports color printing Boolean 1

PRINTMODE Controls duplex printing
• <blank>: uses printer defaults (default)
• S: Simplex
• D: Duplex
• T: Tumble duplex

Text 1

INPUTTRAY Paper tray to use
• <blank>: Default tray.
• 1: Paper tray 1.

Text 3
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• 2: Paper tray 2.
• 3: Paper tray 3.
• 4: Paper tray 4.
• 5: Paper tray 5.
• 6: Paper tray 6.
• 7: Paper tray 7.
• 8: Paper tray 8.
• 9: Paper tray 9.
• 10: Paper tray 10.
• ENV: Paper tray for envelopes.

TRAY1 Page format for printer tray 1 Text 8

TRAY2 Page format for printer tray 2 Text 8

TRAY3 Page format for printer tray 3 Text 8

TRAY4 Page format for printer tray 4 Text 8

TRAY5 Page format for printer tray 5 Text 8

TRAY6 Page format for printer tray 6 Text 8

TRAY7 Page format for printer tray 7 Text 8

TRAY8 Page format for printer tray 8 Text 8

TRAY9 Page format for printer tray 9 Text 8

TRAY10 Page format for printer tray 10 Text 8

TRAYMANU Page format for manual feed printer tray Text 8

TRAYENV Page format for envelope printer tray Text 8

TRAYMANENV Page format for manual feed envelope printer tray Text 8

FTRY1 Paper format of tray 1 enabled Boolean 1

FTRY2 Paper format of tray 2 enabled Boolean 1

FTRY3 Paper format of tray 3 enabled Boolean 1

FTRY4 Paper format of tray 4 enabled Boolean 1

FTRY5 Paper format of tray 5 enabled Boolean 1

FTRY6 Paper format of tray 6 enabled Boolean 1

FTRY7 Paper format of tray 7 enabled Boolean 1

FTRY8 Paper format of tray 8 enabled Boolean 1

FTRY9 Paper format of tray 9 enabled Boolean 1

FTRY10 Paper format of tray 10 enabled Boolean 1

FRTYM Paper format of the manual feed tray enabled Boolean 1

FTRYENV Paper format of the envelope tray enabled Boolean 1
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FTRYMENV Paper format of the envelope tray enabled Boolean 1

Extended attributes

URDT Name of Unicode reference device type (URDT) Text 200

NO_UPE_FOR_ALI No UPE mechanism for ABAP lists ('X' or <blank>) Text 1

USE_ONLY_TTF Always embed fonts ('X' or <blank>) Text 1

UPE_PCL_T15 Use type-15 font header ('X' or <blank>) Text 1

PAXSHIFT Shift output horizontally (4-byte integer) Text 10

PAYSHIFT Shift output vertically (4-byte integer) Text 10

PAXSHUNIT Unit for horizontal shift (CH, MM, IN, CM, or PT) Text 2

PAYSHUNIT Unit for vertical shift (CH, MM, IN, CM, or PT) Text 2

S_PRINTTICKET Name of print ticket Text 200

S_PRINTTICKETDEF Marks as default print ticket ('X' or <blank>) Text 1

S_CPC_CS_PRG Name of PAL printer group Text 200

S_CPC_PRINTER Marks printer as central printer ('X' or <blank>) Text 1

Print options (disabled, pre-selected)

PATYPE dependent (zero, one, or more pair entries)

POPTION ID of the print option Text (0-9) 1

OPTNAME Name of the print option (in logon language) Text 60

IS_VENDORDEF If set, this print option is defined by a printer
vendor, instead of the SAP system.

Text 1

OPTTYPE Type of the print option
• L: List
• C: Checkbox
• U: User string

Text 1

Print sub-options

POPTION dependent (zero, one, or more pair entries)

OPTVAL Integer value of a print option. In case of disabled
options, when set to 0, all sub-options are disabled.

Text (0-9) 1

VALUETEXT_EN English description of print option value. Text 60

• Print options, such as field name and values, are device dependent. Most devices do not have any
print options.

Available paper types for TRAY1, TRAY2, etc.: ANY, DINA3, DINA4, DINA5, EXECUTIV, FORMDISP,
INCH11, INCH12, INCH2, INCH4, INCH4C, INCH5, INCH6, INCH7, INCH8, JPHAGAKI,
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JPLEGAL1, JPLEGAL2, LEGAL, LETTER, LINE_21, LINE_22, MX-IMSS1, MX-IMSS2, MX-SHCP,
ONHELP, ONLINE. Some options may not be available.

$ pdsap NPL list printer roms=dummy device="DUMMY Printer DL2130"
NAME: DUMMY Printer DL2130

PADEST: 2130
PAMSSERVER: lord10_NPL_00

PALOMS: DUMMY
PATYPE: DL2130

PAMODEL: Latest model
PASTANDORT: Right here, right now!

PAMSG: A message here.
PADEVGRP: Z

PADISABLED:
PAPROSNAME: dummy.location
PADFLTSTTL: X

COVER_PAGE_LNG: EN
PADFLTUTTL: D

PAMONI: X
PASYNC: X

PADUPCOPY: N
COLORPRT: X
PRINTMODE: T
INPUTTRAY: 1

TRAY1: LETTER
FTRY1: X
TRAY2:
FTRY2: s
TRAY3:
FTRY3:
TRAY4:
FTRY4:
TRAY5:
FTRY5:
TRAY6:
FTRY6:
TRAY7:
FTRY7:
TRAY8:
FTRY8:
TRAY9:
FTRY9:
TRAY10:
FTRY10:

TRAYMANU: INCH2
FRTYM: X

TRAYENV: INCH4
FRTYM: X

TRAYMANENV: INCH5
FTRYMENV: X

|| PARAM: PAXSHUNIT
|| VALUE: MM
|
|| PARAM: PAYSHUNIT
|| VALUE: MM
|
|| PARAM: S_CPC_OMS_MAN
|| VALUE: DUMMY

|| POPTION: 1
|| OPTNAME: Input Tray
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|| IS_VENDORDEF:
|| OPTTYPE: L
|||| OPTVAL : 1
|||| VALUETEXT_EN: SSF (Single-Sheet Feeder)
|||
|||| OPTVAL : 2
|||| VALUETEXT_EN: Tray 1
|||| disabled : X
|||
|||| OPTVAL : 3
|||| VALUETEXT_EN: Tray 2
|||| pre-selected: X
|
|| POPTION: 3
|| OPTNAME: Print in Color
|| IS_VENDORDEF:
|| OPTTYPE: L
|| disabled: X
|||| OPTVAL : 1
|||| VALUETEXT_EN: Print in Color
|||
|||| OPTVAL : 2
|||| VALUETEXT_EN: Print in Grayscale
|
|| POPTION: 4
|| OPTNAME: Double-sided Printing
|| IS_VENDORDEF:
|| OPTTYPE: L
|||| OPTVAL : 1
|||| VALUETEXT_EN: Duplex Long Edge Binding
|||| disabled : X
|||
|||| OPTVAL : 2
|||| VALUETEXT_EN: Duplex Short Edge Binding
|||| pre-selected: X
|||
|||| OPTVAL : 3
|||| VALUETEXT_EN: Simplex
|||| disabled : X

2. ccrreeaattee

Input parameters:

Field name Description Type Size Man-
datory

ROMS Name of ROMS Text 10 Yes

NAME Printer long name Text 30 Yes

PADEST Printer short name Text 4 Yes

PAMSSERVER Spool server name Text 20 Yes

PALOMS Associated LOMS name Text 6 Yes

PATYPE Device type of associated printer Text 8 No

PAMODEL Printer model name Text 20 No

PASTANDORT Printer location Text 64 No
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PAMSG Status message Text 64 No

PADEVGRP Authorization group for printers Text 30 No

PADISABLED Printer disabled Boo-
lean

1 No

PAPROSNAME Printer long name for host spooler.

Printer name is in the host system.

Text 50 Yes

PADFLTSTTL Print SAP cover page Boo-
lean

1 No

COVER_PAGE_LNG Language to be used for cover page (EN, DE,
FR, etc.)

Text 2 No

PADFLTUTTL Print default host spool cover page.
• <blank>: Does not print host spooler cover

page.
• D: Prints host spooler cover page as set at

printer.
• X: Always prints host spooler cover page.

Text 1 No

PAMONI Monitor using monitoring infrastructure Boo-
lean

1 No

PASYNC Synchronization of requests of a printer Boo-
lean

1 No

PADUPCOPY Create a print request for each copy:
• <blank>: Copy counter to host spool

system
• X: Pass copies as separate Output Request

in SAP system
• N: Only pass one copy to host spool

system

Text 1 No

COLORPRT Whether or not printer supports color printing Boo-
lean

1 No

PRINTMODE Controls duplex printing:
• <blank>: use printer defaults (default)
• S: Simplex
• D: Duplex
• T: Tumble duplex

Text 1 No

INPUTTRAY Paper tray:
• <blank>: Default tray.
• 1: Paper tray 1.
• 2: Paper tray 2.
• 3: Paper tray 3.
• 4: Paper tray 4.
• 5: Paper tray 5.
• 6: Paper tray 6.
• 7: Paper tray 7.
• 8: Paper tray 8.

Text 3 No
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• 9: Paper tray 9.
• 10: Paper tray 10.
• ENV: Paper tray for envelopes.

TRAY1 Page format for printer tray 1 Text 8 No

TRAY2 Page format for printer tray 2 Text 8 No

TRAY3 Page format for printer tray 3 Text 8 No

TRAY4 Page format for printer tray 4 Text 8 No

TRAY5 Page format for printer tray 5 Text 8 No

TRAY6 Page format for printer tray 6 Text 8 No

TRAY7 Page format for printer tray 7 Text 8 No

TRAY8 Page format for printer tray 8 Text 8 No

TRAY9 Page format for printer tray 9 Text 8 No

TRAY10 Page format for printer tray 10 Text 8 No

TRAYMANU Page format for manual feed printer tray Text 8 No

TRAYENV Page format for envelope printer tray Text 8 No

TRAYMANENV Page format for manual feed envelope printer
tray

Text 8 No

FTRY1 Paper format of tray 1 enabled Boo-
lean

1 No

FTRY2 Paper format of tray 2 enabled Boo-
lean

1 No

FTRY3 Paper format of tray 3 enabled Boo-
lean

1 No

FTRY4 Paper format of tray 4 enabled Boo-
lean

1 No

FTRY5 Paper format of tray 5 enabled Boo-
lean

1 No

FTRY6 Paper format of tray 6 enabled Boo-
lean

1 No

FTRY7 Paper format of tray 7 enabled Boo-
lean

1 No

FTRY8 Paper format of tray 8 enabled Boo-
lean

1 No

FTRY9 Paper format of tray 9 enabled Boo-
lean

1 No

FTRY10 Paper format of tray 10 enabled Boo-
lean

1 No

FRTYM Paper format of the manual feed tray enabled Boo-
lean

1 No
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FTRYENV Paper format of the envelope tray enabled Boo-
lean

1 No

FTRYMENV Paper format of the envelope tray enabled Boo-
lean

1 No

Extended attributes

URDT Name of Unicode reference device type
(URDT)

Text 200 No

NO_UPE_FOR_ALI No UPE mechanism for ABAP lists ('X' or
<blank>)

Text 1 No

USE_ONLY_TTF Always embed fonts ('X' or <blank>) Text 1 No

UPE_PCL_T15 Use type-15 font header ('X' or <blank>) Text 1 No

PAXSHIFT Shift output horizontally (4-byte integer) Text 10 No

PAYSHIFT Shift output vertically (4-byte integer) Text 10 No

PAXSHUNIT Unit for horizontal shift (CH, MM, IN, CM, or
PT)

Text 2 No

PAYSHUNIT Unit for vertical shift (CH, MM, IN, CM, or PT) Text 2 No

S_PRINTTICKET Name of print ticket Text 200 No

S_PRINTTICKETDEF Marks as default print ticket ('X' or <blank>) Text 1 No

S_CPC_CS_PRG Name of PAL printer group Text 200 No

S_CPC_PRINTER Marks printer as central printer ('X' or <blank>) Text 1 No

Print options (disabled, pre-selected)

PATYPE dependent

ADD_S_POPTION Add pre-selected print option in format
POPTION:OPTVAL [(0-9):(0-9)]. The option
can be added multiple times.

Text 3 No

ADD_D_POPTION Add disabled print option in format
POPTION:0 or POPTION:OPTVAL [(0-9):(0-
9)]. The option can be added multiple times.

Text 3 No

• The only wildcard character supported is % and you can specify it as a placeholder in PADEST field
value. Wildcard character _, underscore character, is not supported in PADEST field value.
When the printer short name is already used, the pdsap command return the following error:

ERROR: Short printer name 'PRT2' is in use. Enter a different short printer name
or use one of the following: PRTA, PRTB, PRTC.

Available paper types for TRAY1, TRAY2, etc.: ANY, DINA3, DINA4, DINA5, EXECUTIV, FORMDISP,
INCH11, INCH12, INCH2, INCH4, INCH4C, INCH5, INCH6, INCH7, INCH8, JPHAGAKI,
JPLEGAL1, JPLEGAL2, LEGAL, LETTER, LINE_21, LINE_22, MX-IMSS1, MX-IMSS2, MX-SHCP,
ONHELP, ONLINE. Some may not be available.
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3. mmooddiiffyy

Input parameters:

Field name Description Type Size Setta-
ble

Manda-
tory

ROMS ROMS name Text 10 No Yes

NAME Printer long name Text 30 No Yes

PAMSSERVER Spool server name Text 20 Yes No

PALOMS Associated LOMS name Text 6 Yes No

PATYPE Device type of associated printer Text 8 Yes No

PAMODEL Printer model name Text 20 Yes No

PASTANDORT Printer location Text 64 Yes No

PAMSG Status message Text 64 Yes No

PADEVGRP Authorization group for printers Text 30 Yes No

PADISABLED Printer disabled Boo-
lean

1 Yes No

PAPROSNAME Printer long name for host spooler.

Printer name is in the host system.

Text 50 Yes Yes

PADFLTSTTL Print SAP cover page Boo-
lean

1 Yes No

COVER_PAGE_LNG Language to be used for cover page
(EN, DE, FR, etc.)

Text 2 Yes No

PADFLTUTTL Print default host spool cover page
• <blank>: Does not print host

spooler cover page.
• D: Prints host spooler cover page

as set at printer.
• X: Always prints host spooler cover

page.

Text 1 Yes No

PAMONI Monitor using monitoring infrastructure Boo-
lean

1 Yes No

PASYNC Synchronization of requests of a printer Boo-
lean

1 Yes No

PADUPCOPY Create a print request for each copy
• <blank>: Copies counter to host

spool system.
• X: Passes copies as separate

Output Request in SAP system.
• N: Passes only one copy to host

spool system.

Text 1 Yes No
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COLORPRT Whether or not printer supports color
printing

Boo-
lean

1 Yes No

PRINTMODE Controls duplex printing
• <blank>: use printer defaults

(default)
• S: Simplex
• D: Duplex
• T: Tumble duplex

Text 1 Yes No

INPUTTRAY Paper tray to use
• <blank>: Default tray.
• 1: Paper tray 1.
• 2: Paper tray 2.
• 3: Paper tray 3.
• 4: Paper tray 4.
• 5: Paper tray 5.
• 6: Paper tray 6.
• 7: Paper tray 7.
• 8: Paper tray 8.
• 9: Paper tray 9.
• 10: Paper tray 10.
• ENV: Paper tray for envelopes.

Text 3 Yes No

TRAY1 Page format for printer tray 1 Text 8 Yes No

TRAY2 Page format for printer tray 2 Text 8 Yes No

TRAY3 Page format for printer tray 3 Text 8 Yes No

TRAY4 Page format for printer tray 4 Text 8 Yes No

TRAY5 Page format for printer tray 5 Text 8 Yes No

TRAY6 Page format for printer tray 6 Text 8 Yes No

TRAY7 Page format for printer tray 7 Text 8 Yes No

TRAY8 Page format for printer tray 8 Text 8 Yes No

TRAY9 Page format for printer tray 9 Text 8 Yes No

TRAY10 Page format for printer tray 10 Text 8 Yes No

TRAYMANU Page format for manual feed printer
tray

Text 8 Yes No

TRAYENV Page format for envelope printer tray Text 8 Yes No

TRAYMANENV Page format for manual feed envelope
printer tray

Text 8 Yes No

FTRY1 Paper format of tray 1 enabled Boo-
lean

1 Yes No

FTRY2 Paper format of tray 2 enabled Boo-
lean

1 Yes No
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FTRY3 Paper format of tray 3 enabled Boo-
lean

1 Yes No

FTRY4 Paper format of tray 4 enabled Boo-
lean

1 Yes No

FTRY5 Paper format of tray 5 enabled Boo-
lean

1 Yes No

FTRY6 Paper format of tray 6 enabled Boo-
lean

1 Yes No

FTRY7 Paper format of tray 7 enabled Boo-
lean

1 Yes No

FTRY8 Paper format of tray 8 enabled Boo-
lean

1 Yes No

FTRY9 Paper format of tray 9 enabled Boo-
lean

1 Yes No

FTRY10 Paper format of tray 10 enabled Boo-
lean

1 Yes No

FRTYM Paper format of the manual feed tray
enabled

Boo-
lean

1 Yes No

FTRYENV Paper format of the envelope tray
enabled

Boo-
lean

1 Yes No

FTRYMENV Paper format of the envelope tray
enabled

Boo-
lean

1 Yes No

URDT Name of Unicode reference device
type (URDT)

Text 200 Yes No

NO_UPE_FOR_ALI No UPE mechanism for ABAP lists ('X'
or <blank>)

Text 1 Yes No

USE_ONLY_TTF Always embed fonts ('X' or <blank>) Text 1 Yes No

UPE_PCL_T15 Use type-15 font header ('X' or
<blank>)

Text 1 Yes No

PAXSHIFT Shift output horizontally (4-byte
integer)

Text 10 Yes No

PAYSHIFT Shift output vertically (4-byte integer) Text 10 Yes No

PAXSHUNIT Unit for horizontal shift (CH, MM, IN,
CM, or PT)

Text 2 Yes No

PAYSHUNIT Unit for vertical shift (CH, MM, IN,
CM, or PT)

Text 2 Yes No

S_PRINTTICKET Name of print ticket Text 200 Yes No

S_PRINTTICKETDEF Marks as default print ticket ('X' or
<blank>)

Text 1 Yes No

S_CPC_CS_PRG Name of PAL printer group Text 200 Yes No
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S_CPC_PRINTER Marks printer as central printer ('X' or
<blank>)

Text 1 Yes No

ADD_S_POPTION Add pre-selected print option in format
POPTION:OPTVAL [(0-9):(0-9)]. The
option can be added multiple times.

Text 3 Yes No

DEL_S_POPTION Remove pre-selected print option in
format POPTION:OPTVAL [(0-9):(0-
9)]. The option can be added multiple
times.

Because of limitations, the print options
set when the SAP printer was created
cannot be removed with this tool. You
can only set additional print options. To
remove print options use SAP
NetWeaver SAPGUI.

Text 3 Yes No

ADD_D_POPTION Add disabled print option in format
POPTION:0 or POPTION:OPTVAL [(0-
9):(0-9)]. The option can be added
multiple times.

Text 3 Yes No

DEL_D_POPTION Remove disabled print option in format
POPTION:0 or POPTION:OPTVAL [(0-
9):(0-9)]. The option can be added
multiple times.

Because of limitations, the print options
set when the SAP printer was created
cannot be removed with this tool. You
can only set additional print options. To
remove print options use SAP
NetWeaver SAPGUI.

Text 3 Yes No

Available paper types for TRAY1, TRAY2, etc.: ANY, DINA3, DINA4, DINA5, EXECUTIV, FORMDISP,
INCH11, INCH12, INCH2, INCH4, INCH4C, INCH5, INCH6, INCH7, INCH8, JPHAGAKI,
JPLEGAL1, JPLEGAL2, LEGAL, LETTER, LINE_21, LINE_22, MX-IMSS1, MX-IMSS2, MX-SHCP,
ONHELP, ONLINE. Some options may not be available.

4. ddeelleettee

Input parameters:

Field name Description Type Size Mandato-
ry

ROMS ROMS name Text 10 Yes

NAME Printer long name Text 30 Yes

PADEST Printer short name Text 4 Yes
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• In SAP, boolean values for various field are: True for a value that is not empty, while False for an
empty value.

• When modifying an SAP object (ROMS, LOMS, etc.), any value not set by user on command line is
retained as it is. To erase a value for a specific field, set its value to empty.

Examples

pdsap NPL list splserver roms="IBM IPM"
pdsap NPL list roms roms="IBM IPM"
pdsap NPL list loms roms="IBM IPM"loms=DUMMY
pdsap NPL list cmd loms=DUMMY
pdsap NPL list devtype ROMS="IBM IPM"
pdsap NPL list devtype ROMS="IBM IPM"SHOW_URDT=X
pdsap NPL list prtoptions roms="IBM IPM" patype=DL2130
pdsap NPL list printer roms="IBM IPM"
pdsap NPL list printer roms="IBM IPM" DEVICE="DUMMY Printer DL2130"

pdsap NPL create roms NAME=lin STARTINST=lord10_NPL_00
pdsap NPL create loms NAME=lin RNAME="IBM IPM" CMDSERVER=sapsrv_NPL_00 \

CALLBTRGT=sapsrv_NPL_00 CLASS=5
pdsap NPL create cmd loms=lin opsys=Linux lcmd=PATH cmd="path here"
pdsap NPL create printer roms="IBM IPM" name=p1 PADEST=p001 \

PAMSSERVER=sapsrv_NPL_00 PALOMS=lin PATYPE=XRW001U PAPROSNAME=host

pdsap NPL modify roms roms=lin DESCR="linux test"
pdsap NPL modify loms loms=lin roms="IBM IPM" DESCR="linux test"
pdsap NPL modify cmd loms=lin opsys=Linux lcmd=PATH cmd="changed path here"
pdsap NPL modify printer roms="IBM IPM" name=p1 PADISABLED=1

pdsap NPL delete roms roms=lin
pdsap NPL delete loms roms="IBM IPM" LOMS=lin
pdsap NPL delete cmd loms=lin opsys=Linux LCMD=PATH
pdsap NPL delete printer roms="IBM IPM" name=p1 PADEST=p001
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GGlloossssaarryy
This glossary defines technical terms and abbreviations used in InfoPrint Manager.

Special Characters

.Guidefaults file
A file created by InfoPrint in the home directory of a person using the InfoPrint GUI. InfoPrint uses
this file to save and reference information about the servers you are monitoring and the windows
you are working in.

A

Access Control List (ACL)
In computer security, a collection of all access rights for one object.

ACL
Access Control List.

acl editor
A command line interface that lets you view, add, update, and delete access authorization records
in an ACL.

action
In the InfoPrint GUI, an icon that represents an operation that you can perform on an InfoPrint
object. You drag and drop the action onto an object to initiate the operation for that object. For
example, using the Enable action to enable a disabled actual destination.

actual destination
In InfoPrint, an object that represents the output device that performs the printing or transmission
function. See email destination; see also physical printer, printer device; contrast with logical destination.

additive color system
A system that reproduces an image by mixing (adding) appropriate quantities of red, green, and
blue light (the additive primary colors) to create all other colors of light, either direct or transmitted.
When the additive primaries are superimposed on one another, they create white light. Contrast
with subtractive color system.

administrator
In InfoPrint, the person who creates and manages one or more components of a printing system,
such as servers and actual destinations. By default, InfoPrint gives administrators authorization to
perform some InfoPrint operations and to access certain information that is not available to the
operators or job submitters.

Adobe Acrobat
An Adobe software program that provides instant access to documents in their original format,
independent of computer platform. With the Adobe Reader, you can view, navigate, print, and
present any Portable Document Format (.pdf) file.

Adobe PageMaker
A desktop publishing program that produces PostScript documents.



Adobe PostScript Raster to Image Transform (RIP)
See raster image processor (RIP).

ADSM/6000
Advanced Distributed Storage Manager.

Advanced Distributed Storage Manager (ADSM/6000)
A program that provides storage management for archived files.

Advanced Function Common Control Unit (AFCCU)
A RISC-based control unit with code common to all printers that use the AFCCU.

Advanced Function Presentation (AFP)
A set of licensed programs, together with user applications, that use the all-points-addressable
concept to print data on a wide variety of printers or to display data on a wide variety of display
devices. AFP includes creating, formatting, archiving, retrieving, viewing, distributing, and printing
information.

Advanced Function Presentation data stream (AFP data stream)
The printer data stream used for printing AFP data. The AFP data stream includes composed text,
page segments, electronic overlays, form definitions, and fonts downloaded from the operating
system to the printer.

A presentation data stream that is processed in AFP environments. The AFP data stream includes
MO:DCA-P-based data streams.

Advanced Interactive Executive (AIX)
An operating system used with pSeries computers. The AIX operating system is IBM's implementation
of the UNIX operating system.

AFCCU
Advanced Function Common Control Unit.

AFP
Advanced Function Presentation.

AFP data stream
Advanced Function Presentation data stream.

ainbe
The printer input/output backend program used by the PSF DSS to send jobs to printer devices.
Depending on the incoming data stream of the job, the PSF DSS might have transformed the data
stream of the job before the backend program sending it to the printer device.

AIX
Advanced Interactive Executive.

AIX-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port that receives jobs from an AIX print queue.
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In InfoPrint, a PSF physical printer that represents an AIX-attached printer device. See also direct-
attached printer, TCP/IP-attached printer, upload-TCP/IP-attached printer.

AIX destination support system
In InfoPrint, the destination support system that communicates with the standard AIX print backend
(piobe), or with certain variations of the rembak print backend, to print jobs.

AIX physical printer
In InfoPrint, the object representing a printer device that uses the AIX destination support system.

aliasing
In a digitized image, the creation of diagonal lines by combining short horizontal and vertical line
segments that approximate the path of the desired line.

all-points-addressability (APA)
The capability to address, reference, and position text, overlays, and images at any defined point of
the printable area of the paper or display medium.

alphameric
Synonym for alphanumeric.

alphanumeric
Pertaining to a character set containing letters, digits, and other symbols such as punctuation marks.
Synonymous with alphameric.

AMPV
Average monthly print volume.

analog
Pertaining to a continuous variable sampling of information between two points that achieves an
even, smooth transition of photographic material.

analog color proof
An off-press color proof made from separation films.

anti-aliasing
The rendering of hard-edged objects so that they blend smoothly into the background. PhotoShop
offers anti-aliasing when rasterizing an EPS file.

Removing the jagged “stairstep” quality in diagonal lines produced on a computer screen by
aliasing. This removal is effected by creating less densely shaded fields parallel to the diagonal line.

APA
All-points-addressability.

API
Application Program Interface.

Application Program Interface (API)
The call interface between a client program and the procedures that implement the printing system,
as defined by the specification. Clients use the API to access servers. (P)
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architecture
The set of rules and conventions that govern the creation and control of data types such as text,
image, graphics, font, color, audio, bar code, and multimedia.

archiving
The transfer of digital information from an online system onto floppy disk, compact disc, or other
media for offline storage. The original copy is deleted from the online system. See also retrieval.

array inkjet
An ordered collection of multiple print heads used in an inkjet printer.

ASCII
American National Standard Code for Information Exchange. The standard code, using a coded
character set consisting of 7–bit coded characters (8 bits including a parity check). The ASCII code
is used for information exchange among data processing systems, data communications systems,
and associated equipment. The ASCII character set includes control characters and graphic
characters.

asynchronous
Pertaining to two or more processes that do not depend upon the occurrence of specific events,
such as common timing signals. (T)

In InfoPrint, occurring without a regular or predictable time relationship to a specified action.
Contrast with synchronous.

attachment type
Defines the method by which a printer device is attached to the AIX system from which it receives
data. See AIX-attached printer, direct-attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached
printer.

attribute
A defined characteristic of an object, such as the number of copies required of a job, or the
document formats accepted by an actual destination.

attribute name
A string that identifies an attribute. Typically, in InfoPrint attribute names consist of two or more
words separated by hyphens.

attribute value
The element of an attribute that specifies the characteristics relating to the attribute.

authorization
In computer security, verification of the eligibility of a user to access an object.

authorized user
A person with the appropriate permissions to access an object or to issue a command.

automatic recovery
A function of printer logic that permits the printer to reprint a job if the job is misprinted or damaged
or if a component has failed.
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auxiliary sheet
In InfoPrint, an object that represents a particular sheet of paper, blank or otherwise, that can
precede a job, separate documents in a job, or follow a job.

auxiliary-sheet selections
A particular combination of start, separator, and end sheets that print with jobs on a particular
printer device.

B

backend
In AIX or Linux, the program that is invoked by the qdaemon process (AIX) or CUPS printing system
( Linux) to run a print or batch job. Synonymous with backend program.

backend program
Synonym for backend.

backlog
In InfoPrint, the amount of time calculated by InfoPrint that is required to print all of the jobs currently
in a queue.

backspace
In InfoPrint, the action used to back up and reprint pages in a job.

bar code
A code representing characters by sets of parallel bars of varying thickness and separation that are
read optically by transverse scanning.

An array of parallel rectangular bars and spaces that together represent data elements or
characters in a particular symbology. The bars and spaces are arranged in a predetermined pattern
following unambiguous rules defined by the symbology.

BCOCA
Bar Code Object Content Architecture.

Bezier curves
A method of defining curves using anchor points, control handles, and tangent lines. The PostScript
path passes through anchor points. Its approach direction is along the tangent lines that are
controlled by the control handles. Many personal computer programs use this drawing method.
Type 1 PostScript fonts are defined using Bezier curves.

binding
The cover and materials that hold a book together. See edition binding, perfect binding, spiral binding,
wire-o binding.

The process of applying the binding to a book.

In InfoPrint, assigning a job to an actual destination. See early binding, late binding.

bitmapped
Pertaining to an image formed by a rectangular grid of pixels. Each pixel is assigned a value to
denote its color. One-bit images are black and white; 8–bit images have 256 colors (or grays);
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24–bit images have full color. CMYK images have 32–bits per pixel to encode 256 levels in each
of four channels. Bitmapped images are also called raster images.

bleed
An extra amount of printed image that extends beyond the trim edge of the sheet. Bleed ensures that
no white gap appears at the edge of the sheet.

boot
To prepare a computer for operating by loading an operating system.

BSD
Berkeley Software Distribution.

BSD destination support system
In InfoPrint, the destination support system that generates a print command string that the shell runs
to print jobs.

BSD physical printer
In InfoPrint, the object representing a printer device that uses the BSD destination support system.

burn
In platemaking, an exposure. Burn is named because of the extremely bright ultraviolet lamps used
to transfer images from film to plate.

In photography, to lengthen the final exposure time to increase the final density of print.

C

CDE
Common Desktop Environment.

child
See parent/child relationship.

choke
In color printing, an area whose dimensions have been reduced to avoid overlapping another
color. Contrast with spread.

class
Synonym for object class.

clean
In InfoPrint, an action used to remove all the jobs from specified servers, actual destinations, or
queues, or to remove all the jobs submitted to specified logical destinations.

CLI
Command Line Interface.

client
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In InfoPrint, the component of the print system that assembles a print request and submits the request
to a server. The client generates the local ID numbers for each job, submits the jobs to the servers,
and keeps track of where each user's jobs have been submitted.

CMR
Color Management Resource.

CMY
Cyan, magenta, yellow.

CMYK
Cyan, magenta, yellow, black.

collator
In some printers a special-purpose hard drive disk array used to store RIPped files and later transfer
them to the LED print heads for imaging.

color balance
The relative levels of cyan, magenta, and yellow channels in an image to produce accurate color
rendition of an original image.

color correction
The adjustment of the color balance in an image to produce accurate color rendition of an original
image. Color correction is used for two- or three-spot-color jobs.

color key
A color proof similar to Cromalin, but typically not laminated and not necessarily accurate in color.
Color keys are used to verify that breaks or color assignments and traps have been made
accurately.

Color management resource
Color management resource (CMR) is an architected resource that is used to carry all of the color
management information required to render a print file, document, group of pages or sheets, page,
or data object with color fidelity.

Command Line Interface (CLI)
A type of user interface where commands are specified on the command line. Contrast with
Graphical User Interface.

Common Desktop Environment (CDE)
A graphical user interface running on a UNIX operating system.

complex attribute
In InfoPrint, an attribute that can have multiple values with each value containing multiple
components.

constant data
Data that does not change between copies of a document and that is merged with variable data to
produce personalized documents. For example, a form letter (constant data) can be merged with a
customer's name and address (variable data).

139



contextual help
A type of online help that provides specific information about each selectable object, menu choice,
notebook tab, field, control, and pushbutton in a window.

control strip
A strip of information that can be attached to a print job and used to measure registration and
density.

Cromalin
The Dupont color proofing system. Four layers (CMYK) of light-sensitive material are exposed
through final halftone negative films, then laminated together on an opaque backing to produce a
color- and trap-accurate final proof showing actual halftone dot structure. Cromalin is sometimes
called an analog proof.

crop
To remove unwanted areas of an image, usually indicated by crop marks on the original.

CTS
Cutter-trimmer-stacker.

CUPS
Common Unix Printing System is a modular printing system for Unix-like computer operating systems
which allows a computer to act as a print server. A computer running CUPS is a host that can accept
print jobs from client computers, process them, and send them to the appropriate printer.

CUPS destination support system
In InfoPrint, the destination support system that communicates with the standard LINUX print system
(CUPS) and that uses InfoPrint Manager pioinfo backend, InfoPrint Manager piorpdm backend
for Ricoh printers or other print backends to print jobs.

cutter-trimmer-stacker (CTS)
A post-processing device attached to a printer device and used for paper handling.

cyan, magenta, yellow (CMY)
The subtractive primary colors.

cyan, magenta, yellow, black (CMYK)
The four basic colors used in offset printing, as opposed to the three basic colors of light: red, green,
and blue. Magenta, yellow, and cyan are the subtractive primaries. Black is added to provide
better density and to produce a true black.

D

daemon
A program that runs unattended to perform a standard service. Some daemons are triggered
automatically to perform their tasks; others operate periodically. Daemon processes generally
provide a service that must be available at all times to more than one task or user, such as sending
data to a printer.

data stream
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All information (data and control commands) sent over a data link.

A continuous stream of data that has a defined format.

In InfoPrint, pertaining to the incoming format of the job and the output format required by the
printer device. InfoPrint transforms the incoming format into the output format, as required. See also
document format.

DB2*/6000
DataBase 2/6000.

deadline
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one whose deadline is closest. Contrast with FIFO (first-in-first-out), job-priority, longest-job-first, and
shortest-job-first.

default document
In InfoPrint, an object that represents default attribute values for a document in a job. Synonymous
with initial value document.

default job
In InfoPrint, an object that represents default attribute values for a job. Synonymous with initial value
job.

default object
In InfoPrint, a general term that refers either to a default document or a default job. Synonymous with
initial value object.

default value
A value stored in the system that is used when no other value is specified.

delete
In InfoPrint, an action used to delete default objects, jobs, logical destinations, actual destinations,
or queues from the server.

desktop publishing
Performing print-related activities on a personal computer, including but not limited to layout,
design, photo manipulation, creating fonts, editing text, color separation, scanning, and animation.

destination
See actual destination, logical destination.

destination support system (DSS)
In InfoPrint, the programs that an actual destination uses to communicate with the output device.
Synonymous with device support system. See AIX destination support system, BSD destination support
system, email destination support system, and PSF destination support system.

device
An individual piece of equipment (hardware) that attaches to a computer, such as a printer device.

device address
The identification of an input or output device by its channel and unit number.
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device driver
A file that communicates with a specific device such as a printer, disk drive, or display. An
application that sends output to a device controls the actions of the device through the device driver.
See printer driver.

device support system (DSS)
Synonym for destination support system.

DFS
Distributed File Service.

digital
Pertaining to data represented by digits, sometimes with special characters and the space character.

digital color proof
An off-press color proof made from a color printer attached to a computer.

digital printing
A filmless and plateless printing process in which digital data for each page is transferred directly to
a light-sensitive drum and then to paper for a final image.

direct-attached printer
A printer device, attached to an pSeries computer through the network or through a serial or
parallel port.

In InfoPrint, a PSF physical printer that represents a direct-attached printer device. See also AIX-
attached printer, TCP/IP-attached printer, and upload-TCP/IP-attached printer.

disable
In InfoPrint, an action used to stop the acceptance of jobs on destinations, queues, or servers, or to
stop writing information to logs.

distributed print system
A computer system with the ability to interchange print data and controls among different computing
environments with the intent of printing the data on a different system from the one where the print
request was generated. For example, in host-to-LAN distributed printing, data that is located on the
host is printed on printers attached to a local area network.

dithering
A technique of filling the gap between two pixels with another pixel having an average value of the
two to minimize the difference or to add detail to smooth the result.

document
In InfoPrint, an object representing a grouping of data in a job. A job can contain one or more
documents. The documents in a job can differ from each other in some ways. For example, they can
contain different data and can have different document formats. A document in a job can contain
printable data or a resource that is not printable by itself. See file-reference document, printable
document, and resource document.

document element
A portion of a document at least a single page in size.
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document format
In InfoPrint, a document format describes the type of the data and control characters in the
document, such as line data or PostScript. The format of the data determines which printer devices
are capable of printing the document and whether InfoPrint must transform the format.

document identifier
A string that identifies a document in a job. It consists of a job ID followed by a period (.) and a
document sequence number. For example, 12.2. Document sequence numbers are integers starting
at 1.

Document Printing Application (DPA)
An ISO/IEC 10175 standard that addresses those aspects of document processing that enable
users in a distributed open systems environment to send electronic documents to shared, possibly
geographically-dispersed printers. InfoPrint supports the DPA standard.

document transfer method
In InfoPrint, the transfer method describes how documents are transferred to, or acquired by,
servers. See pipe-pull and with-request.

document type
In InfoPrint, the document type describes the kind of data in the document. A printable document can
only contain printable data. A resource document can only contain data such as fonts or form
definitions that are not printable. A file reference document can only contain names of files entered on
separate lines.

dot
The individual elements of a halftone.

dot gain
An increase in the size of a halftone dot during printing, caused by ink spreading. Generally, this
value is known precisely, and the scanning and filming production process is calibrated to
compensate for it. The Cromalin proofing system simulates this effect.

dots per inch (dpi)
A measure of data density per unit distance. Typical values for desktop publishing range from 200
to 300 dpi.

DPA
Document Printing Application.

DPF
Distributed Print Facility.

dpi
Dots per inch.

drag and drop
In graphical user interfaces, a procedure by which you perform actions and tasks. Using the mouse,
you drag (move) an action or object icon to a new position where you want the action or task to
occur.
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DSS
Destination support system.

dummy
A rough paste-up or hand-drawn representation of the anticipated finished product. A dummy is
used for basic design and pagination.

duplex printing
Printing on both sides of the paper. Contrast with simplex printing (1).

Printing on both sides of the paper, placing output images on the media in a head-to-head format,
so that the top of one image is at the same edge as the top of the next image. Contrast with tumble
duplex printing; see also simplex printing (2).

E

early binding
In InfoPrint, assigning a job to an actual destination as soon as it is accepted. Early binding permits
InfoPrint to estimate the time when the job will be completed. Contrast with late binding.

edition binding
A type of book binding in which printed sheets are folded into 16- or 32-page signatures. Four-
page endleaves are pasted on the outside of the first and last signature. The signatures are then
collated by machine and sewn together using special sewing machines. Contrast with perfect
binding, spiral binding, and wire-o binding.

electronic document
A document stored in a computer instead of printed on paper.

electronic mail
Correspondence in the form of messages sent between workstations over a network. Synonymous
with email.

electrophotographic
Pertaining to a type of printer technology that creates an image on paper by uniformly charging the
photoconductor, creating an electrostatic image on the photoconductor, attracting negatively
charged toner to the discharged areas of the photoconductor, and transferring and fusing the toner
to paper.

em
In composition, a unit of measurement exactly as wide and as high as the point size of the font
being set. The name is derived from the fact that the letter M in early typefaces was usually cast on
a square body.

email
Electronic mail.

email destination
In InfoPrint, an actual destination representing an electronic mailing system.

email destination support system
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In InfoPrint, the destination support system that supports email destinations.

embellishments
Variable data added to all copies of assembled pages to make the unit appear like a whole; for
example, headers, footers, a table of contents, and chapter separations.

en
In composition, exactly one-half an em.

enable
In InfoPrint, the action that makes a destination, queue, or server able to accept jobs, or a log able
to accept information.

end sheet
The sheet of paper, blank or otherwise, that can follow a job. See also auxiliary sheet.

Enhanced X-Windows
A tool designed to permit multiple application processes to operate in multiple windows displayed
on a virtual terminal. See X-Windows.

environment variable
Any one of a number of variables that describe the way an operating system runs and the devices it
recognizes.

error log
A data set or file in a product or system where error information is stored for later access.

estimate
The professional cost analysis made by a print shop in response to a customer's request for a price
quotation on a print job.

event
In InfoPrint, an occurrence in the printing system during an operation; for example, the completion
of a command.

event log
In InfoPrint, a collection of messages about events that have occurred.

event notification
The notification that is sent by InfoPrint for an event.

F

FIFO (first-in-first-out)
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
job that has been in the queue for the longest time. InfoPrint processes jobs in the order in which
they are received. Contrast with deadline, job-priority, longest-job-first, and shortest-job-first.

file-reference document
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In InfoPrint, a file containing the names of other files, each entered on a separate line. Job submitters
can specify this file for printing when they specify a document type of file-reference;
InfoPrint prints each file listed in the reference document.

File Transfer Protocol (FTP)
In TCP/IP, the application protocol that makes it possible to transfer data to and from host
computers and to use foreign hosts indirectly.

finisher
A hardware device attached to a printer that performs such operations as folding or stapling the
printed pages.

finishing
In a print shop, the final operations on a printed product, such as stapling, trimming, drilling,
folding, embossing, varnishing, gluing, shrink wrapping, perforating, laminating, collating, and so
on.

flag
A modifier of a command that specifies the action of the command. A dash usually precedes a flag.
Synonymous with option. See also keyword.

FOCA
Font object content architecture.

folder
In the InfoPrint GUI, an object that represents a container for a collection of similar objects. For
example, the Retained Jobs folder contains retained jobs.

font
A family of characters of a given size and style; for example, 9-point Helvetica.

One size and one typeface in a particular type family, including letters, numerals, punctuation
marks, special characters, and ligatures.

A paired character set and code page that can be used together for printing a string of text
characters. A double-byte font can consist of multiple pairs of character sets and code pages.

form definition
A resource object used by InfoPrint that defines the characteristics of the form or printed media,
which include: overlays to be used, the paper source (for cut-sheet printers), duplex printing, text
suppression, and the position of composed-text data on the form.

forward space
In InfoPrint, the action used to move ahead and skip the printing of a specified number of pages in a
job.

FPO
Low-quality (sometimes photographic) images placed in a dummy to represent final images.
Desktop publishing software produces images as display-screen resolution FPOs.

front panel
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In the CDE, a workspace area containing controls that represent various tasks you can perform and
workspace switches.

FST
Files and Sockets Transport is the local security implementation for InfoPrint Manager. It uses the
local namespace for user credentials, and it is a lightweight security protocol.

FTP
File Transfer Protocol.

G

GCR
Gray component replacement.

GIF
Graphics Interchange Format.

global change
In the InfoPrint GUI, an action used to make changes to one or more attributes of several objects at
once. You can also perform the same action on several objects of the same object class at the same
time; for example, disabling two or more actual destinations at the same time.

global character
A character or set of characters used to specify an unknown number or set of characters in a search
string. In InfoPrint, a global character is represented by an asterisk (*).

global ID
Global job identifier.

global job identifier
An unambiguous job identifier. In InfoPrint, it is represented as the name of the server managing the
job followed by a colon (:) and a generated integer. This ID uniquely identifies the job in the
InfoPrint server.

glyph
An image, usually of a character, in a font.

GOCA
Graphics object content architecture.

graphic character
A visual representation of a character, other than a control character, that is normally produced by
writing, printing, or displaying.

Graphical User Interface (GUI)
A type of user interface that takes advantage of a high-resolution monitor and includes a
combination of graphics to implement an object-action paradigm, the use of pointing devices, menu
bars, overlapping windows, and icons. Contrast with Command Line Interface.

Graphics Interchange Format (GIF)
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A compressed graphics format widely used on the Internet.

gray component replacement (GCR)
Synonym for under color removal (UCR).

gray scale
A strip of standard gray tones, ranging from white to black, placed at the side of the original copy
during photography to measure the tonal range and contrast obtained.

GUI
Graphical User Interface.

gutter
The blank area or inner margin from the printing area to the binding.

H

halftone
A printing method that simulates continuous-tone shading using dots of varying sizes laid out on a
rectangular grid. Larger dots simulate darker tones and smaller dots simulate lighter tones. Typical
grid spacings are 85 lines per inch (lpi) (newspaper), 133 lpi (low end), 150 lpi (midrange), and
175+ lpi (high quality).

help
In the InfoPrint GUI, an action used to display the online help for a specific template, object, action,
button, control, or area in an application window.

The name of a button used to access the online help.

hold
An indication determined by the job-hold attribute that is used to keep a job in the queue and
prevent InfoPrint from scheduling it.

hostname
The name given to an AIX system.

hot folder
A workstation directory where users copy jobs to submit them to print.

hypertext
A way of presenting information online with connections between one piece of information and
another. These connections are called hypertext links. See also hypertext link.

hypertext link
A connection between one piece of information and another. Selecting a link displays the target
piece of information.

I

icon
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A graphic symbol displayed on a screen that a user can click to invoke a function or software
application.

image
Toned and untoned pels arranged in a pattern.

image data
Rectangular arrays of raster information that define an image.

imagesetter
A high resolution (1270–3600+ dpi) printer that uses an Argon (green) laser to write to film using
digital input. Imagesetting is the step before Cromalin proofing and platemaking.

imposition
The process of arranging pages on a press sheet to ensure the correct order during final cutting,
folding, and binding. Electronic imposition builds press sheets automatically during the RIP and
outputs film formatted for immediate use in platemaking.

InfoPrint
A solution of software and hardware products that can supplement or replace the offset presses and
copiers in print shops with high-quality, non-impact, black and white or process color printers.
InfoPrint takes documents from creation to the published, kitted, and shipped product.

In InfoPrint software publications, InfoPrint Manager for AIX or any of its components.

InfoPrint Manager for AIX
The software component of InfoPrint. InfoPrint Manager for AIX handles the scheduling, archiving,
retrieving, and assembly of a print job and its related resource files. It also tracks the finishing and
packaging of the printed product.

InfoPrint Manager for AIX is based on Palladium technology developed at MIT/Project Athena. It
conforms to the ISO DPA and POSIX standards.

InfoPrint Network
The local area network running TCP/IP protocol that InfoPrint uses to communicate among servers,
clients, and output devices.

InfoPrint Select
The component of InfoPrint Manager for AIX that lets you submit jobs from a Windows workstation.

InfoPrint Submit Express
The component of InfoPrint Manager that lets you submit jobs with a job ticket from a Windows or
Macintosh workstation.

InfoPrint 20
A black and white, large-format, cut-sheet, workgroup laser printer with optional duplexing and
600-dpi resolution.

InfoPrint 60
A duplex, black and white, cut-sheet printer with 600-dpi resolution.

InfoPrint 62
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A non-impact, continuous-forms printer that runs at a maximum of 62 impressions-per-minute
(depending on forms size), and is factory set to run at either 240 or 300 dpi on a maximum paper
size of 370.8 mm (14.6 in.).

InfoPrint 4000
A duplex, black and white, continuous-forms printer with 600-dpi resolution.

initial value document
Synonym for default document.

initial value job
Synonym for default job.

initial value object
Synonym for default object.

initially settable attribute
An attribute whose value can be established when an object is created but cannot be subsequently
set or modified. See also resettable attribute; contrast with non-settable attribute.

input focus
The area of a window where user interaction is possible from either the keyboard or the mouse.

input tray
For a printer device, the container that holds the medium upon which the printer prints its output.

Intelligent Printer Data Stream (IPDS)
An all-points-addressable data stream that enables users to position text, images, and graphics at
any defined point on a printed page.

Information that the host sends to IPDS printers. This information generally contains basic formatting,
error recovery, and character data and enables the printers to make decisions.

An architected host-to-printer data stream that contains both data (text, image, graphics, and bar
codes) and controls defining how the data is to be presented. IPDS provides a device-independent
interface for controlling and managing all-points-addressable (APA) printers.

International Organization for Standardization (ISO)
An organization of national standards bodies from various countries established to promote
development standards to facilitate international exchange of goods and services, and develop
cooperation in intellectual, scientific, technological, and economic activity.

Internet
A wide area network connecting thousands of disparate networks in industry, education,
government, and research. The Internet network uses TCP/IP as the protocol for sending
information.

Internet Protocol
The set of rules that determines how to route data from its source to its destination in an internet
environment.

intervening jobs
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In InfoPrint, the number of jobs in a queue that are scheduled to print before the job in question.

IOCA
Image object content architecture.

IP address
The IPv4 or IPv6 address.

IPDS
Intelligent Printer Data Stream.

ISO
International Organization for Standardization.

J

job
In InfoPrint, an object that represents a request to print or send one or more documents together in a
single session. A job includes the data to be printed or sent and resources such as fonts, images,
and overlays. Depending on how it was submitted, it can also include a job ticket. Synonymous with
job bundle and print job.

job bundle
Synonym for job.

job data
The page descriptions, merge data, and embellishments that compose a document in a job, either
directly or by reference.

job ID
A local or a global identifier that identifies a job to a job submitter, administrator, operator, or
InfoPrint. See local job identifier, global job identifier.

job-priority
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
one with the highest priority. Contrast with deadline, FIFO (first-in-first-out), longest-job-first, and
shortest-job-first.

job submitter
In InfoPrint, the person who submits jobs for printing. Often, this person is an application
programmer who maintains applications that generate data to be printed.

job ticket
The customer's hardcopy or electronic instructions listing all the variables describing a print job,
either directly or by reference. The print shop can add specifications to the job ticket and can print
the job ticket.

Joint Photographic Experts Group (JPEG)
A compressed graphics format widely used on the Internet.

JPEG
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Joint Photographic Experts Group.

K

kerning
In typesetting, adjusting the relative spacing of two characters to improve their appearance and
readability. Kerning pairs are specific sets of characters with built-in relative spacing. Some
typefaces have as many as 100 kerning pairs.

keyword
A name or symbol that identifies a parameter.

Part of a command operand that consists of a specific character string, such as DSNAME=.

kitting
In a print shop, packaging the completed published work with attendant binders, tabs, diskettes,
and other equipment or information, before shipping the finished product.

L

LAN
Local Area Network.

laser (light amplification by stimulated emission of radiation)
In InfoPrint printers, a device that emits a beam of coherent light that forms the image on the
photoconductor that is subsequently transferred to the paper.

late binding
In InfoPrint, waiting to assign a job to an actual destination until it is about to be processed. Late
binding permits InfoPrint to route a job to the first suitable actual destination that becomes available.
Contrast with early binding.

LDAP
Lightweight Directory Access Protocol is the network security implementation for InfoPrint Manager.
It uses an LDAP or Active Directory server for user credentials, and it offers a unified security
implementation in a customer environment.

LED
Light-emitting diode.

light-emitting diode (LED)
The imaging device element for electrophotographic print units.

lines per inch (lpi)
A measure of the density of the grid used to space halftone dots. Typical grid spacings are 85 lpi
(newspaper), 133 lpi (low end), 150 lpi (midrange), and 175+ lpi (high quality).

Linux
Linux is an open-source operating system modeled on UNIX. There are multiple distributions
available, InfoPrint Manager is only supported on Red Hat Enterprise Linux (RHEL) and SUSE Linux
Enterprise Server (SLES).
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Local Area Network (LAN)
A computer network at one location that consisting of devices connected to one another and
communicating. This network can also be connected to a larger network.

local ID
Local job identifier.

local job identifier
In InfoPrint, a job identifier automatically generated by the server, identifying the job to the person
who submitted it. InfoPrint maps a local job ID to a global job ID.

locale
The human language and character set of information presented to a user.

In InfoPrint, the language InfoPrint uses when sending notification and error messages or displaying
the InfoPrint graphical user interfaces.

log
A collection of messages or message segments added to a file for accounting or data collection
purposes.

To record messages in a file.

logical destination
In InfoPrint, an object to which users submit their jobs. The logical destination routes jobs to one or
more actual destinations representing output devices such as printers, or electronic mail systems. See
also logical printer; contrast with actual destination.

logical printer
In InfoPrint, a type of logical destination. The logical printer routes jobs to one or more physical
printers representing printing devices.

logical unit (LU)
A type of network accessible unit that enables end users to gain access to network resources and
communicate with each other.

logical unit (LU) 6.2
A type of logical unit that supports general communication between programs in a distributed
processing environment. LU 6.2 is characterized by (a) a peer relationship between session
partners, (b) efficient utilization of a session for multiple transactions, (c) comprehensive end-to-end
error processing, and (d) a generic application program interface (API) consisting of structured
verbs that are mapped into a product implementation.

longest-job-first
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
longest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and shortest-job-first.

lpi
Lines per inch.

LU
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Logical unit.

M

magnetic ink character recognition (MICR)
Identification of characters printed with ink that contains particles of magnetic material.

mainframe processor
A functional unit that interprets and executes instructions in a large computer to which other
computers are connected so that they can share the facilities the mainframe provides.

makeready
All the setup work involved in preparing a press for a print run.

manage
In the InfoPrint GUI, the action used to put an object into a mode where its icon reflects changes of
status.

mechanical
A camera-ready layout. The mechanical can consist of multiple sheets or overlays for each spot or
process color used. Final images, if not stripped in later, should be at final size, cropped and
screened to the correct line frequency.

medium
In InfoPrint, an object representing the physical material upon which a job is printed.

merge data
Data that is unique to each copy of a document and that customizes the document; for example,
serial numbers or mailing information. Merge data is typically a small percentage of the total data
in the document.

message catalog
A file of all the possible messages than can display during the processing of an application.

MICR
Magnetic ink character recognition.

Mixed Object Document Content Architecture (MO:DCA)
An architected, device-independent data stream for interchanging documents.

MO:DCA-P
Mixed Object Document Content Architecture Presentation.

modify
In InfoPrint, an action used to modify the values of attributes in the object attributes notebook.

moire
Undesirable interference patterns caused by two overprinting halftone screens with incorrect
halftone dot angles.

monospaced
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In typesetting, pertaining to a typeface in which all the characters have equal widths. Monospaced
typefaces are useful for tabulating figures.

Multiple Virtual Storage (MVS)
An operating system developed by IBM. The design of MVS incorporates an addressing
architecture that provides a unique address space to each job in the system.

MVS
Multiple Virtual Storage.

N

N_UP
Pertaining to the number of forms placed together in a layout. Typical layouts are 2_UP, 4_UP, 8_
UP, 16_UP, and so on. N_UP printing is done to use the maximum area of the print sheet.

namespace
A global name repository available to all utilities and API procedures. The namespace contains
mappings of object names to other related objects. For example, the namespace provides the
mapping of a logical destination to the server in which it is located.

Network File System (NFS)
A protocol developed by Sun Microsystems that uses Internet Protocol to allow a set of cooperating
computers to access each other's file systems as if they were local.

newline options
The different ways in which the printer determines how lines are delimited in a document data
stream.

NFS
Network File System.

non-process-runout (NPRO)
A printer function that moves the last printed sheet to the stacker of the printer device.

non-settable attribute
An attribute that is neither initially settable nor resettable. The values for these attributes are
controlled by InfoPrint. Contrast with initially settable attribute and resettable attribute.

notification
The act of reporting the occurrence of events.

In InfoPrint, notification of events appears as messages in event logs or messages sent to
administrators, operators, and job submitters. In the InfoPrint GUI, notification of events also
appears as changes to the appearance of icons.

notification-profile
In InfoPrint, an attribute associated with an object that contains information designating the people
to whom InfoPrint sends notification about events for that object, which event information it sends,
and how it sends the information.

NPRO
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Non-process-runout.

O

object
A collection of attributes that represent a physical or logical entity in the print system. For example, a
specific printer device is represented by an actual destination (physical printer) object. An object is
identified by its object name. Objects are grouped into classes. See also object class.

object class
A group of objects that share a common definition and therefore share common properties,
operations, and behavior as defined by their attributes. For example, all InfoPrint queue objects are
in the same object class and each queue has the same set of queue attributes. However, the values
for those attributes can differ for each queue in the queue object class.

Object Identifier (OID)
In architecture, a notation that assigns a globally unambiguous identifier to an object or a document
component. The notation is defined in international standard ISO.IEC 8824(E).

object name
The alphanumeric term that identifies an object.

object state
The state of an object indicates its availability and readiness for performing its functions. An object
can be in one of a number of states such as ready, busy, or unknown.

OCR
Optical character recognition.

octet
A byte that consists of eight binary digits (bits).

offset stacking
In certain printer devices, a function that allows the printer to offset the printed output pages for easy
separation of the jobs.

OID
Object Identifier.

open destinations window
In the InfoPrint GUI, the action used to open a new application window displaying the logical and
actual destinations associated with a queue.

Open Prepress Interface (OPI)
An industry standard for replacing low-resolution images in review documents with high-resolution
images needed for high-quality final output.

Open Software Foundation (OSF)
A nonprofit research and development organization created by a consortium of companies that
work together to develop software in the open systems market.
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OpenType font (OTF)
An extension of the TrueType font format that adds:

• Support for PostScript outlines

• Better support for international character sets

• Broader support for advanced typographic control

open window
In the InfoPrint GUI, the action used to open a new application window representing one or more
objects displayed in the currently open application window.

operation
An action performed on one or more data items.

operator
In InfoPrint, the person responsible for printer devices. Also, this person performs a subset of tasks
for InfoPrint queues and actual destinations and performs some job-related tasks.

OPI
Open Prepress Interface.

optical character recognition (OCR)
Conversion of scanned text to editable ASCII characters.

option
A modifier of a command that specifies the action of the command. A dash usually precedes an
option. Synonymous with flag. See also keyword.

orphan logical destination
In the InfoPrint GUI, an object that represents a logical destination that is not associated with an
existing queue.

orphan logical printer
In the InfoPrint GUI, an object that represents a logical printer that is not associated with an existing
queue.

OSF
Open Software Foundation.

overlay
A collection of constant data, such as lines, shading, text, boxes, or logos, that is electronically
composed in the host processor and stored in a library, and that can be merged with variable data
during printing.

OTF
OpenType font.

P

PAC
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Privilege Attribute Certificate.

page definition
A resource that contains the formatting controls for line data.

In InfoPrint, a resource that defines the rules of transforming line data into composed pages and text
controls.

page segment
A resource that contains composed text and images, which are prepared before formatting and
included during printing.

Palladium
A distributed print system developed at MIT/Project Athena with participation from Digital
Equipment Corporation (DEC), International Business Machines (IBM), and Hewlett-Packard (HP). It
is a reference implementation for the OSI Document Printing Architecture (DPA) standard, ISO/IEC
10175.

pane
In the Work Area of the InfoPrint Manager Administration GUI, an area containing a group of
objects of a specific type, such as an actual destinations pane.

parent/child relationship
In InfoPrint, servers, queues, and destinations are related to one another in a parent/child
relationship. For example, a server is the parent of all the queues that reside in that server, and these
queues are its children.

pass through
In InfoPrint, referring to options submitted with a job that are used by the device driver, but not
InfoPrint. InfoPrint does not process or validate this information; it passes it along to the device
driver. See printer driver.

path
The route used to locate files; the storage location of a file. A fully qualified path lists the drive
identifier (if any), directory name, subdirectory name (if any), and file name with the associated
extension.

pause
In InfoPrint, the action used to temporarily halt the printing or transmission of jobs on actual
destinations or the distribution of jobs from servers or queues.

pdcreate
In InfoPrint, the command used to create a new object and set its attributes to specified values.

PDF
Portable Document Format.

Printer description file.

pdmsg
In InfoPrint, a utility used to display information about a message.
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pdpr
In InfoPrint, the command used to create and submit a job, consisting of one or more documents, to
a server for printing or transmission.

perfect binding
A type of book binding in which the pages are held together with flexible adhesive. Contrast with
edition binding, spiral binding, and wire-o binding.

permissions
In AIX, codes that determine who can access a file and what operations they can perform on the
file.

physical printer
In InfoPrint, a type of actual destination that represents a printer device. See also printer device.

piobe
The standard printer input/output backend program used by AIX for printing. See also ainbe.

pipe-pull
In InfoPrint, a document transfer method where InfoPrint saves the documents in a file and transfers
the address of the file to the server. InfoPrint transfers the file to the server upon the request from the
server. This is an efficient transfer method for large jobs and is the default transfer method at job
submission. Contrast with with-request.

plex
A document or actual destination attribute used to define the placement of output images on the
page. See the plex values simplex and tumble.

Portable Document Format (PDF)
An Adobe PostScript data format that can be viewed or printed.

Portable Operating System Interface for Computer Environments (POSIX)
An Institute of Electrical and Electronics Engineers (IEEE) standard for computer operating systems.

POSIX
Portable Operating System Interface for Computer Environments.

PostScript
Adobe's page description language. PostScript has become a standard for graphic design and
layout software. PostScript files can contain both vector and raster data. Fonts are described using
PostScript coding. Many desktop publishing systems produce PostScript data as their output data
stream.

PostScript printer description (PPD)
A file that contains options for printing PostScript data on various printer devices.

PPD
PostScript printer description.

Prefix lengths
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Identify a range of IPv6 addresses that are on the same network.

preflight
To assess all resources for a job before the actual print run.

prepress
Work done in the print shop before printing a job, such as preparing data and art, page imposition,
color retouching, electronic editing, and page layout.

print database
The set of files on disk that provide a permanent repository for the attributes of all print objects, such
as logical destinations, queues, and actual destinations.

print job
Synonym for job.

Print Quality Enhancement (PQE)
A printer facility that provides edge smoothing along diagonal lines, fine fidelity protection, and
independent boldness control.

Print Services Facility (PSF)
Any of several programs, including PSF for AIX, PSF/MVS, PSF/VM, and PSF/VSE, that produce
printer commands from the data sent to them.

print system
A group of one or more print servers and one or more printing devices, which might or might not be
located in the same geographical area. The components of a print system are assumed to be
interconnected in some manner, providing at least one network interface to print clients, and acting
synergistically to supply the defined document print service. (D)

printable document
In InfoPrint, an object that represents text or data to be printed by a job. Contrast with resource
document.

printer description file (PDF)
A file that contains options for printing PostScript data on a specific printer device.

printer device
The physical output device that performs the printing function. See also physical printer.

printer driver
A file that describes the physical characteristics of a printer or other peripheral device. This file is
used to convert graphics and text into device-specific data at the time of printing or plotting.
Synonymous with device driver.

priority
In InfoPrint, a number assigned to a job that determines its precedence in being printed. Jobs with
higher priority numbers are handled before jobs with lower priority numbers.

process color
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Color made up of CMYK links simulating a specified color. This is the traditional method of
reproducing continuous tone color images (color separations). Because of the nature of color inks,
certain inks do not reproduce well.

processor
In a computer, a functional unit that interprets and executes instructions. A processor consists of at
least an instruction control unit and an arithmetic and logic unit. (T)

promote
In InfoPrint, the action used to move a job to the beginning of the queue so that it will print on the
next available printer that can handle that job.

protocol
A set of semantic and syntactic rules that determines the behavior of functional units in achieving
communication.

pSeries
A family of workstations and servers based on IBM's POWER architecture. They are primarily
designed for running multi-user numerical computing applications that use the AIX operating system.

PSF
Print Services Facility.

PSF destination support system
In InfoPrint, the destination support system that communicates with PSF for AIX to print jobs.

PSF physical printer
In InfoPrint, the object representing a printer device that uses the PSF destination support system.

Q

QuarkXpress
A desktop publishing system produced by Quark, Incorporated.

queue
In InfoPrint, an object that manages a collection of jobs that are waiting to print. A queue receives
jobs from one or more logical destinations and sends jobs to one or more actual destinations.

A line or list formed by items waiting for processing.

R

raster
A pattern of dots defined at varying data depths. Black and white images are one-bit (on/off);
grayscale images are 8-bit (256 levels); RGB images are 24-bit; CMYK images are 32-bit.

raster image processor (RIP)
A processor in which a PostScript data stream is converted into dot patterns that are transferred to
the final print medium. InfoPrint uses an Adobe RIP to convert PostScript to IPDS for such printers as
the InfoPrint 4000 and InfoPrint 60.
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rc.pd
In InfoPrint, a utility used to start the InfoPrint servers listed in the /etc/pd.servers file.

read-only
In InfoPrint, describes an attribute value that cannot be set by the user but can change based on
other activity.

ready
A state in which an object is ready and able to perform tasks.

An available resource, such as a value of the media-ready attribute. Contrast with supported.

red, green, blue (RGB)
The colors of CRT display phosphors. RGB images are for screen display only. They must be
converted to CMYK images before printing.

registration
The accuracy of printing on paper relative to the edges of the paper.

The accuracy of printing a single color (cyan, magenta, or yellow) relative to black.

The accuracy of printing on one side of a page relative to printing on the reverse side of the page.

reprographics
The process of copying or duplicating documents or information.

requested
In InfoPrint, pertaining to the specific values of attributes requested by a job when it is submitted. The
requested attribute values of a job are validated against supported attribute values for an actual
destination to determine if the printer can handle that job. Contrast with supported.

resettable attribute
An attribute whose value can be set or modified after an object has been created, assuming the
object is in an appropriate state to be modified. See also initially settable attribute; contrast with non-
settable attribute.

resource
In AFP, a file containing a collection of printing instructions used when printing a job. Resources
include fonts, overlays, form definitions, page definitions, and page segments.

resource context
In InfoPrint, an object that contains directory path information that helps the print system locate
resources needed for printing a job. The resources include fonts, overlays, form definitions, page
definitions, and page segments.

resource document
In InfoPrint, an object that represents a resource, such as graphics or fonts, used by a job to print a
printable document. Contrast with printable document.

resubmit
In InfoPrint, an action used to reroute pending or retained jobs to a different logical destination than
the one through which the job was originally submitted.
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resume
In InfoPrint, the action used to resume the printing of paused jobs or resume the distribution of jobs
from paused servers or queues.

retained job
In InfoPrint, an object that represents a job that is being stored in the print system for a specified
amount of time, normally after the completion of printing the job. A retained job does not reside in a
queue.

retention
The process of storing data after completion of a process for a certain length of time.

retrieval
The process of bringing digital archived data out of storage and into online memory for reuse. See
also archiving.

RGB
Red, green, blue.

RIP
Raster image processor.

To convert data to dot patterns using a raster image processor.

root user
In the AIX environment, the system user with the most authority who can log in and execute restricted
commands, shut down the system, and edit or delete protected files. Synonymous with superuser.

RPC
Remote Procedure Call.

RPM
Red Hat Package Management is the baseline package format of the Linux Standard Base
distribution.

S

scanner
A device that converts hardcopy source data into digital format (halftone dots) to avoid retyping the
data.

scheduler
In InfoPrint, the scheduling method that the queue uses when assigning a job to an actual
destination.

separator sheet
The sheet of paper, blank or otherwise, that separates documents in a job. See also auxiliary sheet.

server
In InfoPrint, the object that accepts configuration, management, and printing requests, performs the
requested operations, and sends responses back as a result of the operation.
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settable attribute
See initially settable attribute, resettable attribute.

severity
An indication of how serious an error condition is.

shell
In the AIX operating system, a command interpreter that acts as an interface between the user and
the operating system. In InfoPrint documentation, all shell examples use the Korn shell.

shift-out, shift-in code
Control characters used to indicate the beginning and end of a string of double-byte, ideographic
characters.

shortest-job-first
In InfoPrint, a queuing technique where the next job assigned to the first position in the queue is the
shortest job in the queue. Contrast with deadline, FIFO (first-in-first-out), job-priority, and longest-job-first.

shut down
In InfoPrint, the action used to halt all server or actual destination processes without deleting the
server or actual destination.

signature
A group of pages that are printed, folded, cut, and bound together. Manual placement of pages in
the signature is determined using a folding dummy.

simplex
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-head format, so that the top of one image is at the
same edge as the top of the next image. Depending on the value of the document or actual
destination sides attribute, the document can be printed on one or both sides of the paper.
Contrast with tumble; see also simplex printing and duplex printing.

simplex printing
Printing on only one side of the paper. Contrast with duplex printing (1).

Printing on one or both sides of the paper, placing output images on the media in a head-to-head
format, so that the top of one image is at the same edge as the top of the next image. Contrast with
tumble duplex printing; see also duplex printing (2).

SMIT
System Management Interface Tool.

SNA
Systems Network Architecture.

spiral binding
A type of book binding in which wire or plastic coils are threaded through a series of holes or slots
in the binding edge. Contrast with edition binding, perfect binding, and wire-o binding.

spot color
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Individual colored inks formulated to exactly match a specified color. Spot color is used when
CMYK process color cannot produce a reasonable facsimile of the color or when vivid color is
needed. Spot color is also used when fluorescent or metallic colors are needed.

spread
In color printing, an area whose dimensions have been enlarged to eliminate white space between
it and another color. Contrast with choke.

start sheet
The sheet of paper, blank or otherwise, that can precede a job. See also auxiliary sheet.

state
Synonym for object state.

stripping
The process of mechanically assembling film into plate layouts. Page imposition takes place during
stripping.

subnet mask
Identify a range of IPv4 addresses that are on the same network.

subnetwork
Any group of nodes that have a set of common characteristics, such as the same network ID.

In the AIX operating system, one of a group of multiple logical divisions of another network, such as
can be created by TCP/IP.

subtractive color system
A system that reproduces an image by mixing (adding) appropriate quantities of cyan, magenta,
and yellow paints on white paper. These paints reflect certain colors and absorb—or subtract—
others. Contrast with additive color system.

superuser
Synonym for root user.

supported
In InfoPrint, pertaining to the specific job attribute values that the actual destination can accept
during job validation. InfoPrint validates the requested attribute values of the job against the
supported attribute values of the actual destination to determine whether the actual destination can
handle that job. Contrast with requested.

synchronous
Occurring with a regular or predictable time relationship to a specified action. Contrast with
asynchronous.

system administrator
Synonym for administrator.

System Management Interface Tool (SMIT)
In the AIX operating system, an interface tool for installation, maintenance, configuration, and
diagnostic tasks. SMIT lets you perform tasks without entering any commands.

165



Systems Network Architecture (SNA)
The description of IBM's logical structure, formats, protocols, and operational sequences for sending
units through, and controlling the configuration and operation of, networks.

T

table reference character (TRC)
An optional control character in a print data set. The TRC identifies the font used to print the record
and can be used to select a font during printing.

Tagged Image File Format (TIFF)
A digital format for storing scanned images. TIFF files are also referred to as raster format files (as
opposed to vector format files). When used in desktop publishing, TIFF files produce only a low-
resolution FPO image; the high-resolution data remains on the hard disk.

task help
A type of online help that provides a list of tasks that can be completed with a selected object.
When you select a task, the help provides step-by-step information about how to complete the task.

TCP/IP
Transmission Control Protocol/Internet Protocol.

TCP/IP-attached printer
A printer device attached to an pSeries computer through telecommunication lines using the TCP/IP
protocol.

In InfoPrint, a PSF physical printer that represents a TCP/IP-attached printer device. See also AIX-
attached printer, direct-attached printer, and upload-TCP/IP-attached printer.

template
In the InfoPrint Manager Administration GUI, an object that represents a set of default attribute
values that has been defined for creating a particular type of object, such as an actual destination.

ticket
See job ticket.

TIFF
Tagged Image File Format.

Transmission Control Protocol/Internet Protocol (TCP/IP)
A set of communication rules used in the Internet and in any network that follows the U.S.
Department of Defense standards for inter-network protocol. TCP provides a reliable host-to-host
protocol between hosts in packet-switched communications networks and in interconnected systems
of such networks. It assumes that the Internet Protocol (IP) is the underlying protocol. See also Internet
Protocol.

trapping
In desktop publishing, the amount of overlap in overprinting colors. Trapping prevents white paper
showing through gaps caused by normal errors in registration. On sheet-fed presses, trapping is
usually 0.25 point. See also choke and spread.

TRC
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Table Reference Character.

TrueType font (TTF)
A font format based on scalable outline technology with flexible hinting. Glyph shapes are based
on quadratic curves. The font is described with a set of tables contained in a TrueType Font File.

TTF
TrueType font.

tumble
In InfoPrint, the value of the document or actual destination plex attribute indicating that output
images are placed on the media in a head-to-toe format, so that the top of one image is at the same
edge as the bottom of the next image. The document must be printed on both sides of the paper.
Contrast with simplex.

tumble duplex printing
Printing on both sides of the paper, placing output images on the media in a head-to-toe format, so
that the top of one image is at the same edge as the bottom of the next image. Contrast with simplex
printing (2), duplex printing (2).

U

UCR
Under color removal.

under color removal (UCR)
Conversion of neutral color areas to black ink that reduces use of CMY inks, improves trapping, and
reduces setup time. Generally, UCR is performed during image scanning, but some RIPs perform it
during processing. Synonymous with gray component replacement (GCR).

unmanage
In the InfoPrint Manager Administration GUI, the action used to put an object into a mode where its
icon does not reflect the changes of status for the object.

upload printer
See upload-TCP/IP-attached printer.

upload-TCP/IP-attached printer
In InfoPrint, a PSF physical printer that represents a printer device attached through an MVS system
and managed by PSF/MVS. InfoPrint communicates with the MVS system through the TCP/IP
network. See also AIX-attached printer, direct-attached printer, and TCP/IP-attached printer.

V

validate
In InfoPrint, to compare the attribute values requested by a job with the supported attribute values of
the actual destinations in the system and to determine whether there is an actual destination capable
of printing or sending the job.

value
A specific characteristic of an attribute.
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variable
A name used to represent a data item whose value can change while the program is running.

variable data
Data that can be changed between copies of a document. For example, a form letter (constant
data) can be merged with variable data, such as a customer's name and address to produce
personalized documents.

varnish
A protective layer applied to a finished sheet, usually for photos, but sometimes used as a design
element because of its reflective qualities. Varnishes can be tinted.

vector
An absolute coordinate point and line in space. PostScript files can contain vector artwork. Vector
files are converted to rasters during the RIP process.

velox
A black and white photographic print made from a halftone negative, to be used as a proof copy.

vignette
An image with soft, fade-away edges.

Virtual Machine (VM)
An IBM licensed product that manages the resources of a single computer so that multiple
computing systems appear to exist.

A virtual data processing system that appears to be at the exclusive disposal of a particular user, but
whose functions are accomplished by sharing the resources of a real data processing system. (T)

Virtual Storage Extended (VSE)
An IBM licensed program whose full name is the Virtual Storage Extended/Advanced Function. It is
a software operating system controlling the execution of programs.

Visual Systems Management (VSM)
In AIX, a type of graphical user interface that allows system management through the direct
manipulation of objects.

VM
Virtual Machine.

VSE
Virtual Storage Extended.

VSM
Visual Systems Management.

W

web
A roll of paper used in web or rotary printing.
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well
In the InfoPrint Manager Administration GUI, an area in a pane that contains a group of objects
related to the objects in the pane; for example, a queues well in a servers pane.

what you see is what you get (WYSIWYG)
Refers to the fact that the composite image displayed on the screen at a computer workstation has
the appearance of the final printed image.

window
A rectangular area of the screen that you can move about, place on top of, or pull under other
windows, or reduce to an icon.

wire-o binding
A continuous double series of wire loops run through punched slots along the binding side of a
booklet. Contrast with edition binding, perfect binding, and spiral binding.

with-request
In InfoPrint, a document transfer method where the client transfers the documents directly to the
server. Contrast with pipe-pull.

workstation
A terminal or microcomputer, usually one that is connected to a mainframe or to a network, at
which a user can use applications.

write access
A level of authorization that grants the ability to modify data.

WYSIWYG
What you see is what you get.

X

X-Windows
A network-transparent windowing system developed by MIT. It is the basis for Enhanced X-
Windows, which runs on the AIX Operating System.

xerography
A dry printing process using corona-charged photoconductive surfaces to hold latent images that
are developed with a dry toner and then transferred to paper and fused with heat.

Xstation
A terminal that is connected through a network to an pSeries computer, from which a user can
perform command-line functions and run X-Windows based applications.
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